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1. Purpose of the document
This manual contains information on the implementation of the data collection phase
for aerial triangulation workflow.

Aerial triangulation includes the following steps:

• Interior orientation of block images;

• Measurement of tie points coordinates on images, relative orientation of block images;

• Preliminary exterior orientation of block images:

○ [optional] Input of ground control points (GCP) coordinates to catalogue and
measurement of these points coordinates images;

○ [optional] Import and usage of preliminary exterior orientation data, obtained with
input images.

The detailed aerial triangulation workflow is described in Section 1.1.2. After data col-
lection to form a block for aerial triangulation the block adjustment is performed (see
the “Block adjustment” User Manual).

The ultimate goal of work on aerial triangulation and block adjustment is defining of
exterior orientation parameters, that allow to proceed to block processing step, which
includes stereo vectorization, creation of DEM, orthomosaic and 3D models (see the
“Vectorization” User Manual).

When accurate enough exterior orientation parameters of block images are available,
it is possible to skip steps of GCP and tie coordinates measurement, as well as block
adjustment step from the workflow and proceed right away to steps of stereovectorization,
DEM and orthomosaic generation (see how to estimate accuracy of imported exterior
orientation parameters in Section 7.5.4). Otherwise, if there are inaccurate exterior ori-
entation parameters of block images, imported exterior orientation parameters are used
to block scheme refinement (see above).

Exterior orientation parameters of image are geometric parameters of image, that specify its
position and orientation in relation to object of photogrammetric survey in a moment of the survey.
There are linear and angular exterior orientation parameters of image.

Linear exterior orientation parameters of image – coordinates of center of optical image projection
in coordinate system of photogrammetric survey object.

Angular exterior orientation parameters of image – parameters that define image angular orient-
ation in coordinate system of photogrammetric survey object, slope and rotation angles of image.
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1.1. Aerial triangulation data

1.1.1. Source data

In order to create and adjust photogrammetric network the following source data is
used:

• data acquired on step of network creation - aerial triangulation:

○ parameters of interior orientation – data that specify position and orientation of
coordinate system of each block image in relation to coordinate system of digital
image; set of surveying camera parameters, that includes coordinates of image
principal point, camera focal length and objective distortion, defined during camera
calibration and used for interior orientation. Interior orientation parameters of images
allow to find out a position of projection center in relation to image, in other words
to restore set of projecting beams (using method of pyramid), existed in a moment
of photographing.

It is necessary to perform interior orientation for central projection images acquired by film
or digital camera. Interior orientation of scanner images – space borne images or ADS
40/80/100 data – are not available in the system, since those images are delivered along
with metadata files which contain interior orientation parameters (see information about
types of data/projects in the “Project creation” User Manual).

○ parameters of relative orientation – data of relative orientation acquired after
measurement of in-strip and inter-strip tie points coordinates on block images;

○ results of measurements of ground control points (GCP) coordinates on block im-
ages (see the Section 5.3).

• data of interior and/or exterior orientation obtained from the data provider;

Delivery set of central projection images may include exterior orientation parameters, calcu-
lated by on-board GPS/IMU systems, or metadata with exterior orientation parameters for
UltraCam camera. For space borne scanner images – metadata with interior/exterior orient-
ation parameters or RPC-coefficients. For ADS 40/80/100 images – also metadata with interi-
or/exterior orientation parameters.

If high precision exterior orientation parameters are available for central projection images it
is possible to exclude steps of measurement of tie and GCP coordinates, as well as block
adjustment step and to proceed to project processing right away (see the “Vectorization” and
“DEM” User Manuals). In this case on a step of data collection for aerial triangulation it is
necessary to perform exterior orientation parameters import, and then perform adjustment
using imported data (see the Section 7.5).

• auxiliary data: overlap size of block images, quick ties data, ground sample distance
(GSD) or data about elevation difference on terrain.
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Main and additional data for aerial triangulation is used to create block layout, that is
used for visual control of block scheme during the data collection. Created block layout
may be considered for initial adjustment (see the “Block adjustment User Manual).

Block layout – approximate scheme of terrain, obtained using projecting of matched images of
a block on specified surface (Earth surface) considering images overlaps, relative position, ro-
tation by angles in a space.

1.1.2. Aerial triangulation workflow

This chapter contains recommended aerial triangulation workflow, depending on available
source data.

During all steps of aerial triangulation procedure it is recommended to perform data
accuracy control (see the Section 1.1.3).
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Fig. 1. Aerial triangulation workflow
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1.1.3. Data quality control

The system provides the following tools to perform quality control of collected data for
aerial triangulation operation:

1. Project state report allows to estimate current state of the project in whole.

Choose Project › Project state or click the button of the main toolbar. The
Project state window opens, which displays what kind of works was performed
and contains a toolbar which allows to perform/adjust results of each processing
step.

Buttons of the Project state window toolbar are the same as buttons of the AT additional
toolbar and some of them duplicate items of the Orientation menu.

Completed aerial triangulation is marked by the symbol, partly performed – ,
not performed – .

Fig. 2. Project state report

The Project state window shows a project state on the following processing steps:

• block forming – number of strips and images (see the “Project creation” User
Manual);

• interior orientation;

• relative orientation;

• exterior orientation (see the “Block adjustment” User Manual).

For refreshing data about project state after changes the Refresh button is used.

2. Interior orientation report.

3. Relative orientation report.
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4. Block layout allows to perform visual control using block scheme, created considering
source or collected data for aerial triangulation: overlap areas size, quick ties data,
results of ties/GCP measurement, interior orientation data, etc.

1.2. The “Orientation” menu

To perform work on data collection for aerial triangulation serves theOrientationmenu,
and also buttons of the main toolbar and of the AT additional toolbar.

Table 1. Brief description of the “Orientation” menu

FunctionsButtons
to input/edit parameters of project cameras, and
also to assign cameras to project images (see the
Section 3.3)

Manage cameras (Ctrl+Alt+I)

contains menu items used to perform interior orient-
ation of central projection images (see the Sec-
tion 3.1)

Interior orientation

contains menu items used to perform quick ties in
order to use the data for block layout creation (see
the Section 2.2.2)

Quick Ties

to open catalogue of all tie points with their meas-
urements (see the Section 4.3)

Tie points list (Ctrl+Alt+T)

to open catalogue of all ground control points, includ-
ing non-measured on block images (see the Sec-
tion 5.2)

GCP list (Ctrl+Alt+G)

to choose types of triangulation points to be deleted
and delete them

Delete point measurements

to remove the whole list of triangulation points (GCP,
check, tie) from triangulation points catalogue

Clear point catalogue

to measure tie points coordinates in automatic mode
(see the Section 4.5)

Automatic tie points measurements
(Ctrl+Alt+A)

to measure GC points if supplement ground control
data are available, i.e. an orthoimage and DEM,

Automatic GCPs measurements...

coverage of those considerable coincide with the
terrain showed in the imagery of the project under
processing (see the Section 5.4)
to open the report with results of images relative
orientation in order to perform analysis and removal

Report on relative orientation (Ctrl+Alt+R)

of errors in tie points measurements (see the Sec-
tion 4.8)
to load measured coordinates of triangulation points
to 2D-window with possibility to setup of display of
certain type of points (see the Section 6.4)

Load triangulation points

to delete points out of useful areas (with specified
background color) (used mainly during automatic
points measurements on spaceborne images)

Delete points outside useful areas
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FunctionsButtons
to delete points of selected types from near-bound-
ary areas of project images marked in the list

Delete border points

to delete tie points duplicatesDelete duplicated points
to open the Points measurementmodule used to
measure points coordinates in manual mode on
images selectedin 2D-window

Open selected images for measurements

to open the Points measurement module used
to measure points coordinates in manual mode on
images, that contain marker position in 2D-window

Open images containing marker (Ctrl+Alt+K)

to open the Points measurementmodule used to
measure points coordinates in manual mode on
selected in-strip stereopair in 2D-window

Open in-strip stereopair

to open the Points measurement module used
to measure points coordinates in manual mode on
selected in 2D-window inter-strip stereopair

Open inter-strip stereopair

to open the Exterior orientation data listExterior orientation data list
to load projection centers data as vector point ob-
jects and to open them in 2D-window to perform

Load projection centers as vectors

analysis, at that an image name is saved to the Name
point attribute
to select part of block images to perform adjustmentSelect subblock
to show the Adjustment toolbar, which is used to
perform adjustment, to view its results and errors
correction (see the “Block adjustment” User Manual)

Block adjustment (Ctrl+Alt+S)

to specify adjustment parameters and to perform
block adjustment without using the theAdjustment
toolbar (see the “Block adjustment” User Manual)

Adjustment in batch mode

allows to perform adjustment using imported exterior
orientation parameters

Direct georeferecing

to open the Block processing reportProcessing report
to export refined RPC-coefficients after adjusting a
scanner project

Export images orientation to RPC

to delete adjustment data (see the “Block adjust-
ment” User Manual)

Delete adjustment results

to perform the subblock analysis by triangulation
points

Subblock analysis

to perform import of exterior orientation resultsImport exterior orientation
to perform import of exterior and interior orientation
data from a separate file with *.eo extension (for
UltraCam Osprey projects)

Import UltraCam Osprey orientation

to perform export of list of source exterior orientation
parameters and adjustment results to PAT-B and
CSV formats

Export of exterior orientation parameters

to perform import of exterior orientation from
metadata

Import orientation from metadata
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FunctionsButtons
to perform export of georeference data after prelim-
inary block exterior orientation and adjustment (to
files of ArcInfoWorld File andMapInfo TAB formats)

Create images georeferencing files

contains menu items used to import of triangulation
points measurements from files of PAT-B, X-Points

Import

formats from PHOTOMOD 4.x (XPT) projects, as
well as data import from flight path file
contains menu items used to export of triangulation
points measurements to files of PAT-B and X-Points

Export

formats, and for export of ties or GCP for further
use them in Geomosaic module

2. Block layout

2.1. Data for block layout creation

Block layout – approximate terrain scheme (further on – block scheme), obtained by
coinciding images on adjacent overlapping areas.

Depending on data set block layout is divided into primary, rough and final. With the
accumulation of information block scheme contains more accurate data than the initial
scheme. As a result, after a correctly performed adjustment block layout represents the
final form of block scheme.

Block layout is used for visual estimation of images position. Moreover, primary block
layout is an obligatory condition for automatic measurement of tie points coordinates.

For block layout creation it is necessary to have the following data available (the data
are listed in increasing order of block layout accuracy):

• size of images overlap areas in strip and between strips – this value is known or is
estimated using quick ties of the same points on terrain on block images. Size of
images overlap areas are used to create primary block layout;

• quick ties data, that are obtained using approximately specified points of terrain on
adjacent images of block scheme in 2D-window. Quick ties data is used to create
primary block layout and significantly refine block scheme created “by overlaps”;

• tie points coordinates are obtained using measurement of coordinates of the same
points on terrain on images with specified accuracy manually or in automatic mode;

Block layout accuracy depends on measurements accuracy and tie points number. For ex-
ample, for primary block layout it is enough to measure coordinates of coordinates of a small
number of tie points between images and use this data instead of quick ties data. With the
accumulation of “qualitatively measured” tie points coordinates a block layout accuracy in-
creases (see the Section 4.5, Section 4.4).
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• GCP coordinates (if any) – are used to create block layout. As a result, block layout
created by GCP shows a block scheme in real coordinate system;

• exterior orientation results (if any) – are imported to a project and are used for block
layout creation;

block layout, created by exterior orientation parameters is a projection of images considering
real coordinates of projection centers and images rotation by interior orientation angles (see
the Section 7.5).

• adjustment results – are used as imported adjustment results or after performing of
block adjustment (if there are adjustment data enough). Block layout, created by ad-
justment results is a final kind of a block scheme (see the “Block adjustment” User
Manual);

• ground sample distance (GSD) (if any) – are specified manually or calculated auto-
matically using digital elevation model (DEM) data.

GSD parameter influences on a size of images during block layout creation (see the Sec-
tion 2.2.1).

2.2. Block layout creation

To create block layout perform the following actions:

1. Collect data for block layout creation.

If exterior orientation parameters are available it is recommended to use first of all imported
data to create block layout. Creating block layout considering exterior orientation parameters
significantly reduces processing time during aerial triangulation step, and if the parameters
are quite accurate it is possible even to skip the step.

It is recommended to create block layout once more after adding new images to a project.

2. Choose Window › Block layout (Ctrl+Alt+L) or click the button of the main
toolbar. The Block layout window opens.
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Fig. 3. Parameters of block layout creation

3. In the Mode section select one of three modes of block layout creation or choose
to skip block layout creation step:

• By ties – used to create block layout by tie point coordinates or by other data,
selected by checkboxes in the Block layout window;

• W/o layout – used to cancel block layout creation, returns a block scheme to its
initial state after images loading;

• By EO – used to create block layout by imported exterior orientation parameters
only, other data is out of scope.

This mode allows just images scaling and DEM considering.

• By centers – used to create block layout by coordinates of images projection
centers and is intended for creation of UAS images block scheme.

This mode allows just images scaling and DEM considering.
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As other data is accumulated and becomes available, a block layout, created by projection
centers coordinates is automatically adjusting using theBlock › Block layout › Refresh
menu item.

4. [optional] To create block layout by part of images block, set the Use subblock
checkbox on and click the Select subblock button. Choose images to define con-
tains of a subblock with standard images selection tools and click OK.

5. Setup parameters of selected mode.

In the By ties mode set the following checkboxes:

• Initial approximation: overlap – allows to specify size of overlap area between
interstrip in strip images (in percent), if size of the overlaps are constant within a
block. This data is necessary for creation of primary block layout. In other case,
for layout creation different data is used – quick ties, for instance;

• QuickTies – allows to use manual linking lines between the same points of terrain
roughly specified on adjacent images (with accuracy of several hundreds of
pixels). It is recommended to set at least two “links” for each stereopair and two
“links” between strips of a block;

The Edit button allows to proceed to create/edit data mode on the QuickTies layer.

• Tie points – allows to use tie points coordinates measured in manual or automatic
modes;

For primary block layout it is possible to measure a small amount of tie points on in-strip
and inter-strip images instead of quick ties, that provides more accurate “ties” between
images on a block scheme.

• GC points – allows to use coordinates of measured GCP;

Block layout created by GCP displays block scheme in real coordinate system.

• Imported exterior orientation – allows to use preliminary imported exterior ori-
entation parameters. Select theProjection centers and angles or theProjection
centers only option. Block layout, created by projection centers coordinates and
exterior orientation angles, is projection of images considering real coordinates
of projection centers and rotation angles;

This parameter allows to consider exterior orientation data for creation of block layout
along with other data, in contrast to the By EO mode, which considers only exterior ori-
entation parameters.
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• Adjustment results – allows to use adjustment results that were imported or
obtained during block adjustment. Block layout, created by adjustment results is
a final version of a block scheme.

For block layout creation it is more preferable to use adjustment results in contrast to
other data. It means that if there are no adjustment results available for block images,
so during block layout creation for these images the system considers other data specified
in the Block layout window. Otherwise, just adjustment results are considered.

The button allows to clear all selected checkboxes.

In the By ties, By EO, By centers modes setup the following parameters:

• the Image scaling slider allows to display images zoom in 2D-window (for ex-
ample, X4.00 – leads to zoom in an image 4 times); it is used for visual control
of images position without overlaps;

• the Account for DEM button allows to use ground sample distance (GSD),
specified manually or calculated automatically by DEM data during block layout
creation (see Section 2.2.1);

In order to use GSD value during block layout creation it is necessary to have interior
and exterior orientation parameters (projection centers coordinates, at least).

When using tie and GCP coordinates or adjustment results (appropriate options should
be selected in the Block layout window) GSD value is not considered during block
layout creation.

• if image GSD is unavailable, relief elevation data specified in project properties
is considered for block layout creation (see the “Project creation” User Manual).

Relief elevation is considered during block layout creation only if GSD data is unavailable.

6. [optional] In order to resolve specific problems caused by incorrect data input click
the More button. The Block layout (additional) window opens.
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Fig. 4. The Block layout (additional) window

Setup the following parameters:

• Scale difference – parameter proportional to scale difference between adjacent
images in a strip;

• Curving – parameter proportional to rotation angle between adjacent images in
a strip;

• Images deformation – parameter proportional to difference of images boundaries
shapes on a block scheme;

• Point rejection percent – percent of tie points which coordinates are not con-
sidered during block layout creation;

• Rotate all block by – angle of a block scheme rotation in degrees.

7. Click the Apply button. As a result, the block scheme in 2D-window is rebuild con-
sidering specified parameters (the Block layout window is opened meanwhile).

If the Use subblock checkbox is set on and images contain subblock are chosen,
the block scheme in 2D-window is rebuild considering parameters of chosen images.
All images are not included in the subblock is no longer displayed.

In order to create a block layout without parameters setup, double click the name of block layout
mode in the Mode section of the Block layout window.

The system provides possibility to create a block scheme by UAS images if angular
exterior orientation parameters of block images are specified with low accuracy or are
unavailable. For this operation it is necessary to use the button on the Exterior
orientation parameters window toolbox. For each highlighted image the system cal-
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culates the direction from previous to next center in a strip (for utmost images of a strip –
from adjacent image to the current one) and kappa angle is setup from this direction.

If the survey time is available the correct images order is checked, otherwise images in strips
should be located in chronological order only.

For quick access to functions of block layout creation it is used the additional Block
layout toolbox which buttons partly duplicate the Block › Block layoutmenu. To open
the Block layout toolbox selectWindow › Toolbars › Block layout.

The Block layoutmenu contains menu items used to perform the following operations:

• Refresh – allows to rebuild a block layout after some changes (equivalent to the
action of the Apply button in the Block layout window);

Block layout mode is not change when the Refresh button or menu item is used.

• W/o layout – allows to cancel block layout creation, and reverts a block scheme
to its initial state after images load (equivalent to theW/o layout mode in the Block
layout window);

• By exterior orientation – allows to create a block layout using only imported ex-
terior orientation parameters (equivalent to the By EO mode in the Block layout
window);

• Load... – allows to load previously saved block layout from file with *.x-ini extension
from active profile resources;

• Save... – allows to save current block layout to file with *.x-ini extension in active
profile resources;

• Delete auto block layout results – allows to delete results of block layout created
by UAS images in automatic mode, including theImageTransforms.x-ini file with
matching results.

2.2.1. DEM use for block layout creation

During block layout creation the system allows to consider GSD value, specified
manually or calculated automatically by DEM. GSD value is influenced on a size of
block image.

In order to use GSD value during block layout creation it is necessary to have interior and exter-
ior orientation parameters (projection centers coordinates, at least).

When using tie and GCP coordinates or adjustment results (appropriate options should be se-
lected in the Block layout window) GSD value is not considered during block layout creation.
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To create block layout considering GSD value perform the following actions:

1. Choose Window › Block layout (Ctrl+Alt+L) or click the button of the main
toolbar. The Block layout window opens.

2. Click the Account for DEM button. The Ground sample distance (GSD) window
opens.

Fig. 5. Specifying of GSD by DEM or manually

3. Choose block images in the table in order to setup GSD value for them.

There is a possibility to specify GSD value of project images in advance – on step of block
forming using the Block › Set GSD menu item (see the “Project creation” User Manual).

4. Choose one of the following ways of GSD value defining:

• to specify image GSD value manually input this value to the GSD field in the Set
GSD value section and click the Set button. Specified GSD value will be shown
in the table;

• to calculate image GSD value using calculator perform the following actions:

1. In the Image pixel size, um field input a pixel size in micrometers or click
the From project button for automatic detecting of pixel size.

2. In the Survey scale field specify a survey scale.

3. Click the Set button. Calculated GSD value will be shown in the table.

• to calculate image GSD value using DEM data perform the following actions:
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To calculate imageGSD value using DEM data during block layout creation it is necessary
to have interior and exterior orientation parameters (projection centers coordinates, at
least).

1. In theCompute by DEM section in theDEM filed click the button, specify
file name and its location in active profile resources.

2. [optional] To fill in blank cells of DEM by specified elevation values, set the
Use Z-value for NULL DEM cells checkbox and specify Z coordinate value.

3. Click the Compute button. Calculated GSD value is displayed in the table.

5. [optional] To cancel input or calculated GSD values, select images in the table and
click the Unset GSD button. As a result in the GSD, m column of the table for se-
lected image the sign is displayed for selected images.

6. To save input or calculated GSD values, click the Apply button.

7. To create block layout considering GSD values, click OK in the Ground sample
distance (GSD) window then click the Apply button in the Block layout window.
If during block layout creation tie or GCP coordinates are not used, a block scheme
is rebuild considering input or calculated GSD values.

2.2.2. Manual images linking (quick ties)

Quick ties between images are used to create primary block layout. Quick ties include
setting of “links” between images using approximately specified (up to several hundred
pixels) same points of terrain on adjacent images in 2D-window.

It is necessary to consider the following recommendations for manual images linking:

1. It is recommended to link together all the images in strips first, and then to link the
strips.

2. It is recommended to set at least two “links” for each stereopair and two “links”
between adjacent strips.

3. A pair of identical terrain points should be selected in different parts of the strip
images.

At sufficiently precise and stable overlaps size within the entire block it is necessary to have a
bit of quick ties data to improve a block scheme. Thus, if the size of in-strip overlap (between
stereo pairs) in all strips is fixed, then link only strips.

20

Aerial triangulation (Windows x64)PHOTOMOD 8.0



Fig. 6. Manual images linking (quick ties)

To create quick ties between images perform the following actions:

1. ChooseOrientation › QuickTies › Edit or click the Edit button in the Block layout
window. The Quickties active layer is created in the Manager.

2. Draw/edit quick tie lines between block images in the following way:

• to add a link place marker to selected terrain point on one image and press the
Insert key, then place marker to corresponding terrain point on another image
(appeared rubber line is stick to the first selected point) and press the Insert key.
Set “links” are displayed in 2D-window by turquoise lines;

• to cancel link line when the first point is already specified, press the Esc key and
the rubber line will disappear;

• to delete link line select it by double click or place marker in the neighborhood of
the link line and press the S key (link line becomes yellow) and press the Delete
key. To delete multiple link lines press and hold the Shift key, while dragging a
rectangular by mouse over the area where lines are located (rectangular selection
mode should be on (more details see in the Vector objects selection chapter in
the “Vectorization” User Manual));
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• to delete all quick ties choose Orientation › QuickTies › Clear.

3. Choose Orientation › QuickTies › Save to save quick ties data.

Quick ties data are saved automatically during block layout creation and during completing
of work session in the system.

3. Images interior orientation

3.1. The “Interior orientation” menu

To determine project cameras and to perform interior orientation of central projection
images the system provides the following interface elements:

• theOrientation › Manage camerasmenu item allows to create cameras of a project;

• theOrientation › Interior orientationmenu items allow to perform interior orientation
and accuracy control;

• buttons of additional AT toolbar duplicate menu items and are used for quick access
to the items. In order to open the AT toolbar, chooseWindow › Toolbars › AT.

Table 2. Brief description of the “Interior orientation” menu

FunctionsButtons
to open a report about interior orientation results
(see the Section 3.4.6)

Report on interior orientation

[only for film camera images] to measure manually
coordinates of fiducial marks on images

Manual interior orientation

[only for film camera images] to perform semiauto-
matic interior orientation, which is to use image-

Semiautomatic interior orientation

standard with template of fiducial marks position
used to search the same fiducial marks on other
project images
[only for film camera images] to perform automatic
interior orientation, which is the automatic recogni-

Automatic interior orientation

tion of fiducial marks by their type, peculiar to certain
analog camera images
to re-calculate interior orientation parametersCalculate interior orientation
to open the Select images window that is used to
delete results of fiducial marks measurements on
selected images

Delete interior orientation data

3.2. Interior orientation workflow

Interior orientation is performed to calculate parameters which define a position and
orientation of film image coordinate system relatively to coordinate system of digital
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image. Besides, interior orientation allows to define parameters describing a systematic
film image distortion can be found.

Result of interior orientation operation is obtaining of interior orientation parameters
used to transform measurement results from the digital image coordinate system to the
film image coordinate system.

Three types of transformation from the digital image coordinate system to the film image
coordinate system are implemented in the system (according to camera passport data):
affine, projective and rotation-scale-shift. Affine and projective transformations are
usually performed if during calibration fiducial marks coordinates were specified in
surveying camera coordinate system. These transformations are executed while exclud-
ing systematic distortion on images.

To define parameters of affine transformation it is necessary to measure coordinates
of at least three fiducial marks, and to define projective transformation parameters – at
least four fiducial marks. Otherwise it is necessary to apply simple rotation-scale-shift
transformation.

Interior orientation is performed for central projection images acquired by film or digital camera.
Interior orientation of scanner images – space borne images or ADS 40/80/100 data – is not
available in the system, since metadata files containing interior orientation parameters are de-
livered along with images from RS data provider (information about types of data and projects
see in the “Project creation” User Manual).

To perform interior orientation of central projection images the system provides the
following workflow:

1. Defining project cameras that includes the following steps:

• input of camera passport data;

• assign cameras to project images;

• define directions of camera axes for project images.

2. Perform interior orientation for the following types of images:

• images acquired by film camera;

• images acquired by digital camera.

3. Accuracy control of obtained interior orientation results (see the Section 3.4.6).

When deleting images from a project it is strongly recommended to synchronize the data in the
project to remove redundant orientation results. To do this choose Project › Synchronize.

23

Aerial triangulation (Windows x64)PHOTOMOD 8.0

project.pdf


3.3. Project cameras management

3.3.1. Images selection and highlighting

The system provides a set of standard tools and ways of selection and highlighting of
project images in lists and tables of the system’s dialogue windows.

Fig. 7. Standard ways of images selection in lists/tables

To select/highlight images in a table or list there are the following tools:

• selection of images/strips using checkboxes near the image or strip name;

• highlighting of images/strips by mouse click on the image or strip name;

In order to highlight multiple images or strips, press and hold the Ctrl or Shift key while
clicking mouse.

• selection of images using standard toolbox, which contains the following buttons:

○ – allows to select all images;

○ – allows to unselect all images;

○ – allows to inverts images selection;

○ – allows to select highlighted images;
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○ – allows to unselect highlighted images;

○ – allows to select in a table or list those images which are highlighted on a block
scheme in 2D-window;

○ – allows to highlight on a block scheme in 2D-window those images which are
selected in a table or list.

3.3.2. Project cameras management

Prior to executing interior orientation it is necessary to define parameters of cameras
which were used to acquire project images.

In order to define project cameras, input their parameters from passport data, assign
cameras to project images and define directions of cameras axes for specific project
images the Manage cameras window is used.

In order to open theManage cameraswindow chooseOrientation › Manage cameras
or click the button of the AT additional toolbar.

Fig. 8. The Manage cameras window

the Manage cameras window contains the following sections:

25

Aerial triangulation (Windows x64)PHOTOMOD 8.0



• the Project images section is used to select project images and to view statistics for
each image: assigned camera, camera axes orientation and current step of interior
orientation; the section also includes a table of all project strips/images, their para-
meters and standard toolbox for images selection;

• the Project cameras section is used to define project cameras: to form a list of
cameras of current project, to input/edit camera parameters, to import, export, remov-
ing and renaming of cameras. The section contains a list of project cameras with
data about number of assigned images, as well as a toolbox used for camera man-
agement;

• the Change camera for selected images section allows to assign selected camera
to selected project images, and to specify orientation of camera axes on project im-
ages;

• the image preview section is used to display highlighted image in a table. The section
includes image name, preview window of highlighted image with display of camera
axes and toolbox used to perform interior orientation and view its results in report,
as well as image size in pixels.

Table 3. Toolbox for camera management

FunctionButtons
to input a new project camera
to import a camera from another project to current one
to edit parameters of a camera selected in a list
to copy selected in a list camera with all its parameters
to rename selected in a list camera
to remove selected in a list camera
to unassign a camera selected in a list from project images. After that in the Project
cameras list in the Num. of images column the “0” value is displayed
to select all images, for which the selected camera was assigned

To input a new project camera perform the following actions:

1. In the Manage cameras window click the button. The Camera window opens.
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Fig. 9. Film camera parameters

2. Input a camera name and specify camera parameters according to its passport
(see the Section 3.3.3 and Section 3.3.4) or import camera parameters (see the
Section 3.3.5).

3. Click OK. A name of new camera is shown in a list of the Project cameras section,
and in active profile resources in the current project folder the Cameras folder is
created. It contains file with the camera description Camera_name.x-cam.
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The button allows to edit all camera parameters, except for its name, specified in the
Camera field. To rename camera selected in a list use the button.

4. [optional] Repeat steps 1–3 to define other cameras in a project if project images
are acquired using different cameras.

In order to assign camera to selected images perform the following actions:

1. In the Manage cameras window select a camera in the Project cameras list.

2. Select images in the Project images table.

3. Set theAssign selected camera to selected images checkbox to assign selected
camera to images.

To recalculate interior orientation without assigning new camera, clear theAssign selected
camera to selected images checkbox and click the Execute button.

4. Set the Set camera rotation for selected images checkbox and select rotation
angle – 0º, 90º, 180º or 270º.

5. Click the Execute button. Selected camera will be assigned to selected project
images.

3.3.3. Parameters of film camera

To input parameters of film camera perform the following actions:

1. Choose Orientation › Manage cameras or click the button on the AT toolbar. The
Manage cameras window opens.

2. Click the button to specify a new project camera. The Camera window opens.

Use the button to edit parameters of existing camera.
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Fig. 10. Parameters of film camera

3. In the Camera type section set the Film option.

4. Specify a camera name in the Camera input field.

5. Input focal length (in mm) in the Focal length input field.

6. [optional] Set the Calibration date checkbox and select calibration date.
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7. Input principal point coordinates (in mm) in the Principal point fields.

8. [optional] Input theDescription – arbitrary text used for example, for easy identific-
ation of the camera and projects where it is used.

9. In the Fiducial marks list choose one of the following data types according to the
camera calibration data (if any):

• Principal point only – principal point coordinates Xo and Yo (in mm). If calibration
data is unavailable and there are no fiducial marks, interior orientation is performed
only using principal point coordinates;

• Fiducial marks – this option is used if there are no reference values of distances
between fiducial marks and fiducial coordinates values, but there is a possibility
to calculate principal point coordinates in a crossover point of lines connecting
fiducials;

• Calibrated distances – allows to set reference values of distances between fi-
ducial marks (in mm) by XY axes: Lx and Ly;

• Fiducial coordinates – allows to set coordinates of fiducial marks X,Y, if they
are available in the camera passport (see also Section 3.4.2).

10. [optional] In the Fiducial marks template list select appropriate camera-template,
which type of fiducial marks corresponds to current camera. Selected type of fiducial
marks contains all necessary information about fiducials: their numbering, template
and search area. Using camera-template allows to perform automatic interior ori-
entation.

A list of camera-templates is available only if in the Fiducial marks list the Calibrated
distances or Fiducial coordinates option is selected.

11. In theDistortion list select one of the following distortion types according to passport
data of survey camera distortion:

• None – no passport data;

• Formula (physical) – to input distortion coefficients of Brown-Conrady model;

In order to consider distortion using formula, it is necessary to input coordinates
of symmetry points, coefficients of radial and tangential distortion, and coefficients
of image deformation.
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Fig. 11. Formula and distortion parameters

Only distortion coefficients b1 and b2 relatively to Х-axis are used for camera self-calib-
ration.

The button is used to transform distortion calculated by formula to a radial
one.

Fig. 12. Parameters of distortion transformation

• Formula (Mixed) – to input distortion coefficients of mixed model;

In order to consider distortion using formula, it is necessary to input coordinates
of symmetry points, coefficients of radial and tangential distortion, and coefficients
of image deformation.
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Fig. 13. Formula and distortion parameters

• Radial – to input table values of radial distortion by radius-vector distance;

• 4 directions + – to input table values of distortion by directions of image coordin-
ate axes;

• 4 directions “Х” – to input table values of distortion by diagonal directions;

• 8 directions – to input table values of distortion by directions of image coordinate
axes and by diagonals.

During input of distortion data the point of symmetry coordinates are specified –
zero distortion (in mm) and table values of distortion (in microns) or distortion
coefficients (formulas). To use principal point coordinates as point of symmetry
coordinates click the To principal point button.
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Fig. 14. A table of distortion values by diagonal directions

The figure above shows a table of distortion values by diagonal directions. Directions
orientation is shown on a scheme right of the table. Each row of the table allows to
input the following values: distance from point of symmetry (radius) in the first
column, and distortion values in the columns corresponding to the numbers of dir-
ections.

The following buttons are used to add, delete lines and edit values in the table:

• – allows to add a new line (Ctrl+Ins);

• – allows to delete selected line (Ctrl+Del);

• – allows to revert a distortion sign;

• – allows to multiply distortion values by 1 000, to convert them into microns;

• – allows to divide distortion values by 1 000, to convert them into microns.

Positive values of distortion coefficients mean “shift” of image away from the center, and
negative – towards the center.

12. Click OK to complete input of camera parameters.

3.3.4. Digital camera parameters

Perform the following actions to input digital camera parameters:

1. Choose Orientation › Manage cameras or click the button of the AT additional
toolbar. The Manage cameras window opens.
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2. Click the button to specify a new project camera. The Camera window opens.

Use the button to edit parameters of existing camera.

Fig. 15. Parameters of digital camera by the example of DSS camera

3. In the Camera type section set the Digital option.

When entering characteristics of a digital camera, principal point coordinates, focal length
and point symmetry (zero distortion) are defined inmm, and pixel size and value of distortion
coefficient – in microns.

4. [optional] In order to change units of digital camera parameters, in the Show digital
camera parameters in section choose millimeters or pixels.
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It is not recommended to change units of digital camera parameters repeatedly, since it
may cause insignificant loss of accuracy. Recalculation is made by using the Pixel size
parameter.

During save of camera parameters the data is saved in the system in millimeters regardless
of the selected units. When the window opens the default data is also displayed in milli-
meters.

5. In the Point of origin section specify pixel position, with respect to which shift of
principal point and symmetry point is specified to consider distortion from camera
passport: In image center or In lower left corner.

Scheme of coordinate system is shown to the right from the Point of origin section.

If the Sensor size is specified, the button allows to recalculate a position of principal
point and point of symmetry when coordinates origin is changed.

6. Input the Pixel size value to Х and Y input fields in microns.

Regardless of the units of digital camera parameters, the Pixel size is specified inmicrons,
and the Sensor size – in pixels.

The Pixel size parameter should be specified to display camera parameters in pixels.

7. [optional] In order to define the Sensor size, enter its size by Х and Y in pixels.

The button allows to swap sensor size values by X and Y to fix errors of data input.

The Sensor size value could be imported frommetadata or from a file with *.cal extension.
This parameter is used to control camera axes orientation during import.

8. Input the Focal length value in mm.

9. Input X,Y-coordinates of principal point with regard to image center (in mm) to the
Principal point input fields.
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Fig. 16. Dependence between image and monitor coordinate systems

Here:

• Xi and Yi – axes of image coordinate system – Right;

• Xp and Yp – axes of Pixel/Monitor coordinate system– Left;

• xpp and ypp – principal point coordinates, measured from upper left corner of the
image (from origin of Pixel/Monitor coordinate system);

• xipp and y
i
pp– principal point coordinates, measured from central pixel of the image

(from the image coordinates origin).

Image coordinates origin may differ from origin of Pixel/Monitor coordinate system. In this
case it is necessary to recalculate principal points coordinates, specified in the camera
passport, considering used coordinate system.

10. [optional] Input theDescription – arbitrary text used for example, for easy identific-
ation of the camera and projects where it is used.

11. In theDistortion list select one of the following distortion types according to passport
data of survey camera distortion:

• None – no passport data;
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• Formula (Physical) – to input distortion coefficients of Brown-Conrady model;

In order to consider distortion using formula, it is necessary to input coordinates
of symmetry points, coefficients of radial and tangential distortion, and coefficients
of image deformation.

Fig. 17. Formula and distortion parameters

Only distortion coefficients b1 and b2 relatively to Х-axis are used for camera self-calib-
ration.

The button is used to transform distortion calculated by formula to a radial
one.

Fig. 18. Parameters of distortion transformation

• Formula (Mixed) – to input distortion coefficients of mixed model;
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In order to consider distortion using formula, it is necessary to input coordinates
of symmetry points, coefficients of radial and tangential distortion, and coefficients
of image deformation.

Fig. 19. Formula and distortion parameters

• Radial – to input table values of radial distortion by radius-vector distance;

• 4 directions + – to input table values of distortion by directions of image coordin-
ate axes;

• 4 directions “Х” – to input table values of distortion by diagonal directions;

• 8 directions – to input table values of distortion by directions of image coordinate
axes and by diagonals.

During input of distortion data the point of symmetry coordinates are specified –
zero distortion (in mm) and table values of distortion (in microns) or distortion
coefficients (formulas). To use principal point coordinates as point of symmetry
coordinates click the To principal point button.
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Fig. 20. A table of distortion values by diagonal directions

The figure above shows a table of distortion values by diagonal directions. Directions
orientation is shown on a scheme right of the table. Each row of the table allows to
input the following values: distance from point of symmetry (radius) in the first
column, and distortion values in the columns corresponding to the numbers of dir-
ections.

The following buttons are used to add, delete lines and edit values in the table:

• – allows to add a new line (Ctrl+Ins);

• – allows to delete selected line (Ctrl+Del);

• – allows to revert a distortion sign;

• – allows to multiply distortion values by 1 000, to convert them into microns;

• – allows to divide distortion values by 1 000, to convert them into microns.

Positive values of distortion coefficients mean “shift” of image awayfrom the center, and
negative – towards the center.

12. Click OK to complete input of camera parameters.

3.3.5. Import and export of camera parameters

TheCamerawindow provides opportunities of import and export of camera parameters,
as well as possibility to use features of standard cameras.

The Camera window opens using the and buttons in the Manage cameras window.
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To import of camera parameters perform one of the following actions in the Camera
window:

• choose Import › From file to import camera parameters from file, located in folder
of Windows file system. The Load camera window opens. Select file with camera
parameters and click OK. Camera’s parameters will be loaded to appropriate fields
of the Camera window. The available camera parameters file formats:

○ *.x-cam – file with the camera description, used by PHOTOMOD system;

○ *.txt – file with the camera description, used by 3DM CalibCam;

○ *.txt – file with the camera description, used by Australis;

○ *.txt – file with the camera description, used by Australis v7;

○ *.cal – file with the camera description, used by CalCam;

○ *.ini – file with the camera description, used by PhotoModeler;

○ *.cam – file with the camera description, used by Pix4D;

○ *.txt – file with the camera description, used by SimActive;

○ *.cal – file with the camera description, used by TerraPhoto;

○ *.txt – file with the camera description, used by USGS.

• choose Import › From resource to import camera parameters from *.x-cam file,
located in folder of active profile resources.

TheOpen window opens, that displays a tree of active profile resources. In the folder
of active profile resources select file with camera parameters *.x-cam and click OK.
All parameters of camera from selected file will be loaded to appropriate fields of the
Camera window;

By default the Cameras folder is used to store *.x-cam files with camera parameters in the
profile resources of each project.

• choose Import › Import from CAL-file (EnsoMOSAIC) to import digital camera
parameters from the *.cal file of theEnsoMOSAIC system.

To import of camera parameters from another project to a current one perform the fol-
lowing actions:

1. In the Manage cameras window click the button. The Open window opens.
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Fig. 21. Camera selection in resources of another project

2. Select the camera file *.x-cam in the Cameras folder of another project in active
profile resources.

3. Click Open. As a result, the camera name appears in the camera list.

To export of camera parameters to *.x-cam file the Export › To file or Export › To re-
source in the Camera window are used.

For automatic input of standard cameras data to input fields of the Camera window the
Standard camerasmenu is intended. The menu is used, if the camera parameters are
fully or partly coincide with parameters of standard camera, that allows to significantly
reduce time of manual input of new camera parameters.

Camera description in the *.x-cam file includes the followingmain lines, which correspond
to parameters shown in the Camera window:

• name – camera name;

• calibration_date – calibration date;
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• description – camera description;

• focus – focal length;

• principal_point – principal point coordinates.

Fig. 22. Camera parameters in the file of *.x-cam format

3.4. Interior orientation of film camera images

3.4.1. Interior orientation modes

In order to perform interior orientation of images acquired by film camera the system
provides the following modes:

• interior orientation in manual mode using measurement of coordinates of fiducial
marks on all project images (see the Section 3.4.2);
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• interior orientation in semi-automatic mode using image template, with already
measured coordinates of fiducial marks and available interior orientation (see the
Section 3.4.4);

• interior orientation in automatic mode using camera template with defined type of fi-
ducial marks (see the Section 3.4.5).

3.4.2. Manual measurement of fiducial marks coordinates

To perform Interior orientation of image the Interior orientation window is used.

Fig. 23. Manual measuring of fiducial marks

The window includes the following parts and contains the following interface elements:

• toolbar with buttons used to perform the following operations:

○ , , , – allows to pass to adjacent image of a block located left, top, bottom
or right side, respectively;

○ , – allows to pass to previous or to next unprocessed image (with unmeasured
fiducials);

○ – allows to open the Manage cameras window;

○ – allows to open the Semi-automatic interior orientation window;

○ – allows to open the Automatic interior orientation window;
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○ – allows to open the Report on interior orientation window;

○ – allows to remove all fiducial marks measurements on a current image;

○ – allows to open theMarker settings window used to setup marker shape, size
and color.

• the Image information and Camera information sections are used to display gen-
eral information about selected image and about camera parameters;

• the main window of image view is used to fiducial marks search and the additional
lens-window is used for precision marker position in fiducial center. Image manage-
ment in windows is performed using the standard buttons;

TheCtrl+F8 shortcut allow to show/hide scroll bars in themain window and in the lens-window.

• the table of fiducial marks in the Measurements section is used to display fiducials
coordinates from camera passport, in mm, (see Section 3.3.3), measured coordinates
acquired after measuring of fiducial coordinates, and values of their discrepancies
after interior orientation operation;

• marker coordinates (in pixels and mm), buttons used to measure and delete fiducial
coordinates, a list used to choose a transform type;

• the status bar used to display image zoom ratio in the main window and the lens-
window, and marker coordinates (in pixels). After measuring of two fiducial marks,
the status bar shows also marker coordinates on image (in mm)/marker coordinates
on image considering distortion (in mm) and pixel size (in mm);

• the Apply button allows to perform image interior orientation after measuring of its
fiducial marks.

In order to performmanual measurement of fiducial marks coordinates on project images
perform the following actions:

1. Highlight a block in 2D-window anв choose Orientation › Interior orientation ›
Manual interior orientation or click the button of the AT additional toolbar. The
Interior orientation window opens.
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Fig. 24. Manual measuring of fiducial marks

2. Choose a fiducial mark which coordinates to be measured in the Measurements
table of fiducial marks coordinates, which displays XY-coordinats of the mark (in
mm) from camera passport. Find on image and show by marker the mark in the
view window. In the right lens-window selected fiducial mark is displayed.

3. Perform precision positioning of marker on chosen fiducial mark in the lens-window
using mouse cursor and arrow keys. Marker position coordinates (in pixels and
mm) are displayed in theMarker coordinates (pix) andMarker coordinates (mm)
input fields.

4. Click the Measure mark button to fix measured fiducial coordinates. After fiducial
coordinates measurement the fiducial table shows the measurement result – co-
ordinates of measured fiducial Xр and Yр (in pixels).

5. Repeat pp. 2-4 to measure coordinates of the second mark. After measurement of
two fiducial marks a status bar will display information about pixel size, marker co-
ordinates on image (in pixels and mm), and marker coordinates, calculated consid-
ering distortion (in mm).
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6. Repeat pp. 3-4 for the rest of fiducials. After measurement of first two fiducial marks
a marker will be automatically positioned to vicinity of the next fiducial mark on image
in image view window and in the lens-window.

7. After measurement of all fiducials coordinates choose one of the following trans-
formation type: Rotation, Scale, Shift; Affine; Projective in the Transform type
list.

8. Click the Apply button to perform interior orientation. After that the fiducials table
will display the Ex and Ey values of discrepancies (in mm) between fiducial marks
specified in camera passport and measured on image.

Maximal error should not exceed the size of the pixel. To perform accuracy control of interior
orientation results using report click the button.

9. [optional] After measuring fiducial marks coordinates at least on one block image
click the button to try to perform interior orientation of the rest block images in
semi-automatic mode.

10. ChooseOrientation › Interior orientation › Report on interior orientation or click
the button of the AT additional toolbar to control results and fix errors of interior
orientation (see the Section 3.4.6).

3.4.3. Image management

This chapter contains a description of standard image managing options in image view
window. A toolbox of image view window contains the following buttons used to manage
an image:

• – allows to zoom in an image by one step (*);

• – allows to zoom out an image by one step (/);

• – allows to fit to page data of opened layers (Alt+Enter);

• – allows to display data in 1:1 scale, when one pixel of the image corresponds to
one pixel on the screen;

• – allows to center image by marker in working area of 2D-window.

To turn on panning mode that allows to move an image using mouse in a view window –
press and hold the Alt key while moving mouse.
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Fig. 25. Standard toolbar of the Interior orientation window

3.4.4. Semi-automatic interior orientation

Principle of operation of semi-automatic mode is the automatic search andmeasurement
of fiducial marks coordinates on all project images in accordance with selected template-
image and further interior orientation for all block images. As a template-image one of
project images is used. For this image fiducial mark template is defined and interior
orientation is performed. Thus, semi-automatic interior orientation of the entire images
block requires interior orientation results of at least one image of a project, obtained
after manual measurement of fiducial marks coordinates.

To execute semi-automatic interior orientation perform the following actions:

1. Choose Orientation › Interior orientation › Semi-automatic interior orientation
or click the button of the AT additional toolbar. The Semi-automatic interior
orientation window opens.
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Fig. 26. Defining of fiducials search area and reference mark

2. In the Project images table select a template-image, which will be used for search
andmeasurement of fiducial marks coordinates on other project images. To choose
a template-image select the image in the table and click the button. Left of the
image name the Template label is displayed.

Any image of the project with performed interior orientation could be used as template-image.

3. Use sliders in theMarks search parameters section to define the following search
parameters:

• Mark area size is used to define fiducial template. Setup the fiducial area size
in such way that fiducial image is fully located in search area;

• Search area size is used to define fiducial location. If images are sliced unevenly
and fiducial marks are located at different distances from image edge on different
images, it is recommended to set sufficiently large search area (outer rectangle,
which circumscribe a fiducial mark).
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In order to specify search areas use the image view window and the lens-window, along
with buttons of toolbar. TheCtrl+F8 shortcut allows to show/hide scroll bars in view windows.

4. For automatic search of fiducial marks using correlator that compares fiducial mark
image with its template, define threshold value in the Correlation threshold input
field (0.9 by default).

5. Choose images in the Project images table to perform interior orientation in semi-
automatic mode.

6. [optional] In the Search for marks section set the Search images with int. or.
already performed checkbox to include to calculation the images (from selected
ones), which have interior orientation results available, i. e. to recalculate interior
orientation for them in accordance with the selected template.

7. Choose one of the following transformation type: Rotation, Scale, Shift; Affine;
Projective in the Transform type list.

8. Click the Start button to perform semi-automatic interior orientation.

9. ChooseOrientation › Interior orientation › Report on interior orientation or click
the button of the AT additional toolbar to control results and fix errors of interior
orientation (see the Section 3.4.6).

Below the table of images there are the buttons that allow to open the following windows:

• – Project cameras management ;

• – Interior orientation (manual);

• – Automatic interior orientation ;

• – Report on interior orientation .

TheOrientation › Interior orientation › Delete interior orientation datamenu item is used
to remove interior orientation data in case of unsatisfactory results.

3.4.5. Automatic interior orientation

The system provides possibility to perform interior orientation in automatic mode, if
template-camera is specified in properties of film camera in the Fiducial marks section
(see the Section 3.3.3).

Interior orientation in automatic mode consists in automatic search and measurement
of fiducial marks on project images according to specified type of fiducial marks, and
further interior orientation. Specified Fiducial marks parameter already contains inform-
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ation about fiducials typical for the selected camera: their numbering, template and
search area.

Current version of the system supports types of fiducial marks for RC 20, RC 30 and LMK
cameras.

To correctly perform automatic interior orientation, orientation of the camera image axes should
be set correctly (see the Section 3.3).

To execute automatic interior orientation perform the following actions:

1. Choose Orientation › Interior orientation › Automatic interior orientation or
click the button of theAT additional toolbar. TheAutomatic interior orientation
window opens.

2. To perform interior orientation in automatic mode select images in the Project im-
ages table.

Fig. 27. The Automatic interior orientation window

3. For automatic search of fiducial marks using correlator that compares fiducial mark
image with its template, define threshold value in the Correlation threshold input
field (0.8 by default).

4. [optional] In the Search for marks section set the Search images with int. or.
already performed checkbox to include to calculation the images (from selected
ones), which have interior orientation results available, i. e. to recalculate interior
orientation for them in accordance with the selected template.
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5. Choose one of the following transformation type: Rotation, Scale, Shift; Affine;
Projective in the Transform type list.

6. Click the Start button to perform automatic interior orientation.

7. ChooseOrientation › Interior orientation › Report on interior orientation or click
the button of the AT additional toolbar to control results and fix errors of interior
orientation (see the Section 3.4.6).

Right from the Project images section there are the buttons that allows to open the
following windows:

• – Project cameras management ;

• – Interior orientation ;

• –Semi-automatic interior orientation;

• – Report on interior orientation .

TheOrientation › Interior orientation › Delete interior orientation datamenu item is used
to remove interior orientation data in case of unsatisfactory results.

It is strongly recommended to synchronize the data in the project to remove redundant orient-
ation results when deleting images from a project. To do this choose Project › Synchronize.

3.4.6. Report on interior orientation

Report on interior orientation allows to estimate a quality of interior orientation of film
camera images.

To view the report on interior orientation perform the following actions:

1. ChooseOrientation › Interior orientation › Report on interior orientation or click
the button of the AT additional toolbar. The Report on interior orientation
window opens.
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Fig. 28. Main parameters of interior orientation report

2. On the Main parameters tab specify the following report parameters:

• in the Show report section choose the All images or Selected images option;

• choose a type of residual: RMS (root mean square), Mean abs. value (mean)
orMax (maximal) and specify the Threshold for interior orientation residuals
value in the appropriate field in pix or mm.

If project images were scanned by photogrammetric scanner, mean absolute value Eср
should not exceed a half pixel size. The approximate ratio of the mean, maximum and
mean square error is calculated as follows:

Emax ≈ 2 Emean and RMS ≈ 2 Emean

where: Emean – mean residual, Emean
xy = 2 0.5pix – max residual, RMS – quadratic

mean RMS.

3. On the Additional tab specify the following additional parameters:

• choose format of residuals: Fixed point or Exponential;

• define accuracy of residual values output: Normal, Higher or Maximum.
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Fig. 29. Additional parameters of interior orientation report

4. Click OK. After that a report opens, which contains general information on the im-
plementation of interior orientation and consists of the following sections:

• Links used to return to previous view place or to the beginning of the report, to
refresh report data after calculating of interior orientation, and to change a report
parameters.

• Block statistics – project name, data on number of all/selected strips/images in
a block, time and date of the report creation, strips tablewith the following general
information: on which strips/images and to what extent the interior orientation is
performed, and whether the residuals values satisfy a given residuals tolerance
for measurement of fiducial marks on images. The Strips column contains links –
strips names, that allow to pass to tables of images in each strip.

• Tables of images in each strip show general information about images – camera
data, axes orientation, number of fiducial marks measured on the image, type of
image transformation and interior orientation residual of selected type (RMS,
mean module or maximal) in selected units (pix or mm) on theMain parameters
tab of theReport on interior orientationwindow. The first column contains links
that allow to open selected image in the Interior orientationwindow to edit fiducial
marks measurements. The Images column contains links – names of images
that allow to pass to detailed report about interior orientation of selected image.

Red color is used to mark images/strips, for which interior orientation is not performed,
yellow color is used for images/strips for which interior orientation is performed incorrectly
or incompletely, i.e. with residuals exceeding a threshold value, and also when not all fiducial
marks are measured. Residuals themselves also appear in red.
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The figure below displays an example of interior orientation which is not satisfactory
under the following conditions and with the following data: threshold value for mean
module – 0.2 pix, coordinates of one of the marks on image of the 9-th strip are not
measured, and coordinates of all marks of one of images of the 10-th strip are not
measured.

Fig. 30. Report on interior orientation of film camera images block

Toolbar in upper part of interior orientation report contains the following buttons:

• (Backspace) – allows to go back to previous view;

• (F5) – allows to refresh a report after change of the report parameters;

• (Ctrl+F) – allows to perform data search in a report (by keyword or its part);

• – allows to save a report to HTML-file in any folder out of active profile re-
sources;

• – allows to save a report to HTML-file in active profile resources;

• – allows to print a report;
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• (Ctrl+P) – allows to open print preview window.

5. In the table of images click the link of selected image in the Image column. After
that a detailed report on interior orientation of selected image is opened. The report
contains the following data:

• links to pass to the following places:

○ [Edit] – allows to open the Manual interior orientation window where it is
possible to “re-measure” fiducials coordinates and recalculate interior orienta-
tion;

○ [Back] – allows to return to previous window of the report;

○ [Refresh] – allows to обновить отчет при change a report parameters;

○ [Report parameters] – allows to open window used to change a report paramet-
ers.

• image statistics – camera parameters, image size, pixel size, interior orientation
data;

• table of fiducial marks on image contains the following data:

○ maximal residual threshold Ex, Ey, Exy specified on theMain parameters tab
of the Report on interior orientation window;

If threshold value on RMS or mean residual is specified, threshold on maximal residual
is automatically calculated in selected units (pix or mm).

○ marks coordinates taken form camera passport (in mm) – X,Y;

○ marks coordinates on image (in pix) – X,Y;

○ values of discrepancies between passport data and measured data (in pix and
mm) – Ex, Ey, Exy;

○ specified threshold value on selected residual in selected units on the Main
parameters tab of the Report on interior orientation window;

○ calculated on all marks residual values by RMS, mean abs. and max Ex, Ey,
Exy (pix or mm).

Residuals that are out of thresholds are highlighted by red color. Thus, the report
displays by red color the following residuals:

○ residuals on all marks, that exceed defined threshold on selected residual
(RMS, mean abs. or max);
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○ residuals on each mark, that exceed defined threshold on maximal residual.

Fig. 31. Report on interior orientation of film camera image

3.5. Interior orientation for digital camera images

Interior orientation of image acquired by digital camera is to determine the principal
point position relative to the center of the lower left pixel of the image.

To perform interior orientation of images acquired by digital camera perform the following
actions:

1. Input correctly all parameters from digital camera passport to appropriate input
fields of the Cameras window (see the Section 3.3.4).

It is necessary to pay attention to parameters units, and to define point of origin, which will
be used to specify coordinates of principal point and symmetry point (zero distortion point):
relative to the lower left pixel or the center of the image.
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2. Assign the camera to project images and setup camera axes direction for selected
images in the Camera management window (see the Section 3.3).

3. ChooseOrientation › Interior orientation › Calculate interior orientation or click
the button of the AT additional toolbar to recalculate interior orientation.

4. ChooseOrientation › Interior orientation › Report on interior orientation or click
the button of the AT additional toolbar to control results and fix errors of interior
orientation.

Report on interior orientation for digital camera contains information whether the interior
orientation is done. It also includes camera parameters and principal point coordinates,
calculated relative to the center of the lower left pixel.

Fig. 32. Report on interior orientation of digital camera images block
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Fig. 33. Report on interior orientation of digital camera image

3.6. Interior orientation control

Prior to perform aerial triangulation it is necessary to make interior images orientation.
During interior orientation in some cases radially directed systematic errors occur.

Also, when execute images interior orientation in some cases errors occur because of
incorrectly specified focal length or due to incorrect distortion considering. In order to
determine the presence of such errors, it is necessary to perform block adjustment using
GCP and the projection centers.

Accuracy of focal length, principal point coordinates and accounting distortion determ-
ining are interrelated. An error in focal length calculation results in error distortion con-
sidering and error of determining the principal point coordinates. It is necessary to
specify correct values of focal length and principal point coordinates in order the distortion
value does not exceed the specified tolerance. It is recommended to verify the sign of
the distortion correction and distortion units.
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4. Relative orientation of images

4.1. Relative orientation workflow

One of the stages of building a triangulation network is images relative orientation, that
requires measured coordinates of tie points.

Tie points – the same points on the terrain on adjacent block images needed to build
single models from stereopairs and then to merge them into triangulation networks.

After measurement of tie point coordinates it is necessary to perform relative orientation
of block images, to input and measure GCP coordinates, to perform network adjustment
and to obtain exterior orientation parameters of a block.

Measuring of tie point coordinates – is stereoscopic measurement, i.e. measuring of
coordinates of the same point on both stereopair images at once (or on multiple over-
lapped adjacent images) in stereomode.

Measuring of tie point coordinates on two images of a stereopair in manual mode is
performed in the system using one of the following ways:

• manual measuring of point coordinates on each of stereopair images;

• manual measuring of point coordinates on a single image and transfer it to another
image using correlator;

• manual measuring of point coordinates on each image in stereomode;

• search of a point and measuring its coordinates on image using correlator.

The system also allows to measure tie points coordinates on block images in fully
automatic mode.

During removing images from a project it is strongly recommended to synchronize data in the
project in order to remove unnecessary results of orientation. To do this choose Project › Syn-
chronize.

The following recommendations should be considered during tie points measurement:

• to perform relative orientation it is recommended to combine two methods – first ex-
ecute automatic measurement with “bad” points filtering and than manual mode for
editing of measurements acquired in automatic mode and adding of new tie points
(to accumulate measurements that allows to increase relative orientation accuracy);

• when using only manual procedures for tie points measurement, the optimal way is
measuring at least 2 tie points in 6 standard zones for each stereopair in a strip;
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Fig. 34. Recommended zones to measure tie points coordinates in strips

• in order to consolidate images strips into a block it is recommended to measure tie
points coordinates in inter-strip overlap zones on both sides in relation to a midline
of inter-strip overlap area.

Fig. 35. Recommended location of tie points in inter-strip images overlap areas

If block adjustment is performed using independent models method, it is necessary to transfer
inter-strip tie points to at least one adjacent image in each strip. Otherwise they will be not
taken into account when using this type of block adjustment (see the “Block adjustment” User
Manual).

4.2. The “Points measurement” module

4.2.1. General information about module

In order to measure coordinates of triangulation points (tie, check and GCP) in manual
mode and editing points coordinates with errors obtained after automatic measuring of
tie points coordinates, the system provides the Points measurement module.

The module allows to automatically calculate parameters of images interior orientation when
measuring tie points coordinates.
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The Points measurement module is used on the following steps of data collecting for
aerial triangulation operation:

• input and measurement of GCP coordinates;

Automatic selection of images for non-measured GCP in the Points measurement module
is performed after measurement of coordinates of first two-three GCP on block images or
when preliminary exterior orientation is performed in geodetic coordinate system (by projection
centers, for instance).

• measurement of tie points coordinates on block images entirely in manual mode and
performing of images relative orientation;

• editing of tie points position to fix errors obtained after automatic measurement of
points coordinates;

• editing of triangulation points to fix errors obtained on step of block adjustment (see
the “Block adjustment” User Manual);

• measurement of tie points coordinates to estimate accuracy by Y-parallax after import
of exterior orientation data.

The following items of the Orientation menu and buttons of the AT additional toolbar
are used to start the Points measurement module:

• Open selected images for measurement – allows to launch the Points meas-
urementmodule and automatically open block images selected in 2D-window in the
module;

• Open images containing marker – allows to launch the Points measurement
module and automatically open in the module all images that contain marker position
in 2D-window;

• Open in-strip stereopair – allows to launch the Points measurement module
and open two images of selected in-strip stereopair;

If just one image is selected in 2D-window, neighboring right image in a strip will be opened
by default. If the last image in a strip is selected, image to the left of the selected will be
opened.

• Open inter-strip stereopair – allows to launch the Pointsmeasurementmodule
and open two images of selected inter-strip stereopair.

If just one image is selected in 2D-window, neighboring lower image in a strip will be opened
by default. If selected image is in the outermost strip, the top image on the selected will be
opened.
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The Points measurementmodule represents a set of two windows – the main Points
measurement window and the Triangulation points window. The main Points
measurementwindow displays selected images in separate windows and contain tools
used to perform triangulation points measurement. The Triangulation points window
is a catalogue of all triangulation points along with their measurements data and contains
tools for work with points catalogue.

Fig. 36. The “Points measurement” module

Awork in the Pointsmeasurement and Triangulation pointswindows is synchronized
in the following way:

• when choosing a triangulation point on one of the images using mouse double click
the system automatically starts search for selected point on the opened images of
the module and search of appropriate point on the terrain, if the point is not measured
on the image. Besides, the point will be also automatically highlighted in the triangu-
lation points catalogue;

• when choosing a triangulation point in a catalogue using mouse click the point will
be shown on opened images of the module automatically, if the point is measured
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on these images and/or a search of appropriate point on the terrain, if the point is not
measured on opened image;

• when choosing a triangulation point in a catalogue using mouse click and by the
button or by double mouse click the system allows two ways of displaying, depending
on the Automatically choose images containing point mode (see the Sec-
tion 4.2.2):

○ all images where the point is measured are opened automatically, if the Automat-
ically choose images containing point mode is turned off;

○ all images where the point is measured and/or could bemeasured (marker is located
to the place or probable measurement) are opened automatically, if the Automat-
ically choose images containing point mode is turned on.

• filtering of display of different points types in catalogue and on opened images is also
synchronized.

When the module is launched marker is placed to estimated position of the point.

Fig. 37. Search for a point on terrain with measured coordinates and without measured coordinates
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After measurement of coordinates of each new tie point images relative orientation (Y-
parallax on measured points) is performed automatically.

For viewing results of relative orientation the system provides the following features:

• the button of the Triangulation points window toolbar is used to view relative
orientation report for the whole images block in the read-only mode. The report is
opened after defining of the report parameters;

• the button of the Points measurement upper toolbar allows to view relative ori-
entation report only for images opened in themodule. The report is opened considering
default or defined previously report parameters;

4.2.2. The “Points measurement” window

The main window of the Points measurementmodule is used to measure/edit triangu-
lation points on project images with or without correlator, in mono or stereo mode.

The Points measurement window contains the following interface elements:

• the main toolbar used to apply different operations to all opened images consists of
the following panels:

○ the upper panel contains buttons used to manage images zoom, images selection
for measurements, measuring/editing of triangulation points coordinates, transfer
of GCP from georeferenced maps, setup of triangulation points symbols and
common parameters;

○ the left toolbar contains buttons used to manage display of triangulation points and
residuals vectors in all images windows.

• windows of opened images, each of them display an image and its name, and contains
its own toolbar and status bar.

Setting of the Points measurement and Triangulation points window size is preserved after
reboot of the module/system.

During triangulation points measurement in the Points measurement window the fol-
lowing concepts are used in the system:

• The active image – image displayed in the window selected by mouse click. The
active image window is highlighted by blue frame;

• The “left” image – a status assigned to one of opened windows, that is considered
during stereopair opening and is used to correlate other images with this one during
measurement of tie points using correlator.
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To define one of opened images as a “left” one, click the button located in the toolbar of
this image. To define an active image as a “left” one click the button of the upper toolbar
of the Points measurement window.

Fig. 38. The main window of the “Points measurement” module

If in-strip or inter-strip stereopair is opened, a “square” in the middle of the Points
measurement window allows to setup relative location of main windows of images and
lens-windows.

Changed position of the Points measurement and Triangulation points windows is re-
membered by the system and restored at the module next launch.

Fig. 39. Interstrip stereopair in the “Points measurement” module
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The system provides opportunity to transform images during displaying in the opened
windows of the Pointsmeasurementmodule. The transformation influences on images
display and on measurement of points coordinates using correlator.

To choose a transformation type, click on the arrow to the right of the button. Opened
menu contains the following items:

• No transform – allows to cancel images transformation (images are shown without
rotation);

• Rotation by block scheme 90º multiple – allows to rotate images by images rotation
angle, which occurs during block forming in 2D-window, rounded to the nearest angle
multiple of 90º;

• Rotation by block scheme, exact – allows to rotate images by images rotation
angle, which occurs during block forming in 2D-window;

• Block layout: rotation – allows to rotate images according to block scheme;

• Block layout: scale and rotation – scale and rotation are used during transformation
according to block scheme;

• Block layout: projective transform – image projective transformation is used during
transformation exactly in the same way as on block scheme;

• Image scale – allows to change basic scale of images for correlator (the same scale
is used during images display 1:1).

Table 4. Upper toolbar of the Points measurement window

FunctionsButtons
standard buttons of images management in all opened windows with images at
once

, , , ,

to display the next image in a strip (to “flip” images in opened windows) to the left
or right by one image in a strip, up/down by one image in adjacent strips

, , ,

to return to previous or to pass to next marker position during image change in the
Points measurement window

,

to place image windows across the width of the Points measurement window, i.e.
to “fill out” a screen with windows if some of them were closed
to open the Add images window used to select images and add them to new win-
dows of the Points measurement module
to choose images transformation mode during their display in the Points measure-
ment window
to turn on automatic refresh mode of a block scheme as a points coordinates are
measured (the mode is turned off by default). Automatic refresh of a block scheme
applies only to images opened in the Points measurement module, i.e. The local
block scheme is refreshed
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FunctionsButtons
to open a new stereo window containing stereo image of selected images pair
where it is possible to measure points coordinates in stereo mode. By default a
stereo image in the Points measurementwindow is opened, instead of all opened
image windows. If you press the button while holding down the Shift key, the opened
stereo window will be double size of image window, selected to be displayed in a
stereo mode, Ctrl – allows to open window with one window size to the “left” image
window location. The Esc key allows to close the stereo window
is used to display images as a color or black-and-white one
to add a tie point to marker position on all opened images without correlation
(marker is positioned manually on all images)
to change position of selected in a list point on images and to add the point to
marker position on images where it was not measured
to move a point along tie residual vector on all images. To display tie residuals
vectors on images the button of the leftward toolbar is used
to move a point along GCP residual vector on all images. To display GCP residuals
vectors on images the button of the leftward toolbar is used
to remove coordinates measurement of selected point on all images
to open theDelete pointmeasurementswindow used to specify criteria of selection
points to be deleted
to synchronize marker on all images (С), so the system tries to place marker on all
opened images to the terrain point shown by marker on active image (requires
creation of block layout). The more data is considered during block layout creation,
the more accurate is marker positioning
to open a stereo pair consisting of the “left” image and active image as a rightward
to correlate the active image with the “left” one to add a new tie point using correl-
ator (see the Section 4.4)
to correlate all opened images with the “left” one to perform measurement of new
tie point coordinates using correlator
to calculate correlation coefficient (Q) of all opened images with the “left” one and
to show a value of correlation coefficient in a status bar of each opened image (in
the “left” image status bar the auto-correlation coefficient value is shown)
to open the relative orientation report for opened images (the report will consider
default settings or previously set parameters)
to open the Map window used to load georeferenced map (vector, raster map or
DEM) to transfer GCP from them on image opened in the Points measurement
module
to find on georeferenced map opened in the Map window, terrain point pointed by
marker on the active image of the Points measurement window (see also Sec-
tion 5.5)
to open the Add GCP window to transfer GCP from georeferenced map opened
in the Map window on image opened in the Points measurement module
to configure image metadata display in the windows of open images (for scanner
images only)
to show/hide toolbar on all images windows
to show/hide status bar on all images windows
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FunctionsButtons
to open theMarker settingswindow used to setup shape, size and color of marker
to open the Symbols window used to setup symbols used to display measured
triangulation points according to their type
to open the Points measurement settings window to specify correlator paramet-
ers and setup of automatic display of report on relative orientation after clicking OK
in the Points measurement module
to specify the active image as the “left” one

Table 5. Leftward toolbar of the Points measurement window

FunctionsButtons
to show/hide all measured triangulation points in opened images
to display all triangulation points measured in opened images using symbols, spe-
cified according to their type in the Symbols window
to display names labels of triangulation points measured in opened images
to display models by ties in symbols display mode of triangulation points. An addi-
tional “angle” elements are added to a tie point symbol indicating a connection with
the adjacent images (to the right and/or left). For example, to triplet point symbol
the angle brackets will be added to the left and right
[only after Block adjustment] to display GCP residuals vectors
[only after Block adjustment] to display tie residuals vectors
to turn on/off a filter of triangulation points display on opened images according to
settings made in the Points filter window
to open the Points filter window used to choose triangulation points type to by
shown in opened images and in catalogue of the Triangulation points window
to display ground control points in windows of opened images
to display overlap areas of project images as frames in windows of opened images
to display overlap areas of project images as filled polygons in windows of opened
images ( mode should be enabled)
to display 6 standard zones, recommended to be used for measurement of tie
points coordinates (see the Section 5)

4.2.3. Windows of opened images

Each of project images opened in the Points measurement module is displayed in a
separate window.

One of the images windows is the “left”, another is active. The “left” window may be
also an active window at the same time. Images shown in the “left” and active windows
are used for correlation during tie points measurement, and also for selecting a stereopair
to be opened in a stereo window to perform measurements in stereo mode.

At launch of the Points measurement module images containing selected point are
opened in viewing windows automatically. It is also possible to perform automatic
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choosing of images containing selected point in the triangulation points catalogue using
the button of the Triangulation points window.

In order to open or add images in the Points measurementmodule, perform the follow-
ing actions:

1. Click the button. The Add images window opens.

Fig. 40. Manual selection of images to add or open them in the “Points measurement” module

Strips and images containing highlighted tie point (in a list or on opened images) are shown
by light-green background color.

2. [optional] For automatic selecting of images containing a point highlighted in the
Triangulation points window, click the button.

3. Set checkboxes near images names to open them in the Points measurement
window.

4. Click OK. Marker in opened windows will be positioned to a supposed area of the
point position.

Each image window in the module contains the following interface elements:

• buttons of upper toolbox used to work with image:

○ , , , , – standard buttons for image management in the window;

○ – allows to add point and measurement in marker position;

○ – allows to move and add selected point to marker’s position;

○ – allows to move a point along tie residual vector;

○ – allows to move a point along GCP residual vector;

○ – allows to remove measurement results for point selected on image;
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○ – allows to select image as a “left” one, with which the rest images will be cor-
related, if tie points coordinates were measured using correlator (see the Sec-
tion 4.4).

• working area used to display image and its name in the upper left part;

• the status bar with the following information:

○ image zoom ratio, marker position coordinates (in pix and mm);

○ coefficient of image correlation with the “left” image if tie points coordinates were
measured using correlator (auto-correlation coefficient is displayed in the status
bar of the “left” image);

○ the icon used to display additional information about image.

Move the mouse to the icon, to view pop-up window with data about image size and
rotation angle, number of measured points and coordinates of marker position on image.

• right-click menu.

In the upper left corner of the image window the image name is shown for all images.
For scanner space images a sensor name and off-nadir angle (if any), obtained from
metadata are also shown in the upper right corner by default.

The button of the upper toolbar of the Pointsmeasurementwindow allows configure
displayed scanner imagery metadata (if available).

Fig. 41. Image window in the “Points measurement” module

In order to perform color correction of an image – to setup brightness, contrast and
gamma-correction – the Shift+F8 shortcut is used.

The Ctrl+F8 shortcut allows to show/hide scroll bars in the active image window.
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To move an image in the window the system provides the panoramic mode – moving
an image using mouse move along with pressed Alt key.

The system also provides possibility to display a frame to make easy placing marker
to center of standard shape objects. To display the frame choose the Show frame for
centering on area objects item in the right-click menu.

To change frame size rotate the mouse wheel while holding the following keys pressed:

• H – horizontal size;

• V – vertical size;

• B – the same size on both axes.

In order to hide the frame choose the Show frame for centering on area objects item
in the right-click menu once more.

Table 6. right-click menu of image window

FunctionsButtons
to add a tie point to marker position on selected
image

New tie point (Ctrl+=)

to add a tie point to marker position on all selected
images without correlation (marker should be posi-
tioned manually on all images)

Add point on all images

to change a position of a point selected in a list on
images and to add it to marker position on images
where it was not measured

Move/addmeasurement intomarker position
(Ins)

to move a point selected in a list on images and to
add it to marker position on all images

Add or move point measurements to marker
positions on all images

to move a point along tie error vector on all images.
To display tie residuals vectors on images the
button of the leftward toolbar is used

Move point along tie error vector

to move a point along GCP error vector on all im-
ages. To display GCP residuals vectors on images
the button of the leftward toolbar is used

Move point along GCP error vector

to remove measurement results for point selected
on image

Delete measurement (Del)

to specify selected image as the “left” imageLeft image (L)
to display a frame used to place marker to center
of standard shape objects

Show frame for centering on area objects

to move a marker to nearest measured point on
selected image

Move marker to the nearest point on this image
(S)

to move a marker to nearest measured point on all
images

Move marker to the nearest point on all images
(Shift+S)

to turn on the distance measuring modeDistance measuring mode (D)
to shift one image left in a stripShift one image left
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FunctionsButtons
to shift one image right in a stripShift one image right
to shift one image up on adjacent stripShift one image up
to shift one image down on adjacent stripShift one image down

4.2.4. Selecting displayed fields from metadata for scanner imagery

In the upper right corner of an active image (for scanner imagery), the sensor name is
displayer by default, as well as off-nadir angle (where available) obtained frommetadata.
The system allows you to configure displaying additional fields from scanner imagery
metadata (if available).

For this, perform the following:

1. Click the button on the upper toolbar of the Points measurement window. The
Configure displayed filelds from metadata window opens:

Fig. 42. The Configure displayed filelds from metadata window

2. Select the field with the required metadata in the list and click the button to add
them in the displayed list;

The buttons and allows to add/remove all the selected fields, the button removes
the selected field from the list.

3. Click Ok.
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4.2.5. Distance measuring

The Points measurement module provides features that allow to measure distances
on terrain (in pixels) in windows of opened images.

To calculate distance in meters use data about ground sample distance (GSD), that is specified
in the Ground sample distance (GSD) window opened using the Block › Set GSDmenu item
(see the “Project creation” User Manual).

To measure distance between terrain points on images perform the following actions:

1. Place a marker in the first point on terrain on the image. Select the Distance
measuring mode item in the right-click menu or press the D key to turn on the
distance measuring mode.

2. Indicate the second point on terrain by left button mouse click. After that a measuring
line with indicated distance between points in pixels is displayed.

3. Press the D key once again to turn the distance measuring mode off.

Distance measuring mode allows to estimate conformity error of terrain points in images
overlap areas. This error is considered during tie points measurement in automatic
mode and is used to increase measurements accuracy (see the Section 4.5). In order
to specify conformity error, use the Search area parameter on the Search for points
tab of the Tie point measurement parameters window.

To estimate conformity error of terrain points in images overlap areas after measuring
tie points in automatic mode perform the following actions:

1. Open a block stereopair in thePointsmeasurementmodule (see the Section 4.2.3).

It is recommended to estimate the conformity error on multiple stereopairs: on in-strip ste-
reopairs in different strips of a block, and on inter-strip stereopairs.

2. Indicate some point on terrain by mouse double click on one of images in overlap
area. The system perform automatic search of the same terrain point on another
image of stereopair and place marker to probable location of corresponding point.

3. Measure a distance between indicated and found point on terrain in distance
measuring mode.
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Fig. 43. Distance measuring in the “Points measurement” module

4.3. The “Triangulation points” window

The Triangulation points window contains a list of all triangulation points of a project
(ground control, check, and tie) and also tools for points view, search, edit, and import/ex-
port.

The Triangulation points window is opened independently or as a part of the Points
measurement module. In the independent Triangulation points window there is a
possibility to proceed to the Points measurementmodule that allows to display results
of измерений выбранной в каталоге точки триангуляции on project images.

To open the Triangulation points window perform one of the following actions:

• choose Orientation › Tie points list or click the button on the main toolbar or on
theAT additional toolbar. В окне Triangulation points отображается the Tie points
tab is displayed;

• choose Orientation › GCP list or click the button on the main toolbar. In the Tri-
angulation points window the GCP list tab is displayed;

• open thePointsmeasurement module. In the lower part of thePointsmeasurement
module there is the Triangulation points window located on the Tie points tab.

The Triangulation points window contains the following two main tabs:

• GCP list – list of ground control points both with measured coordinates and without
them;

• Tie points – list of all tie points.
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The title of the Triangulation points window displays a number of all triangulation
points/number of points shown in the list on selected tab.

The GCP list tab contains a list of all measured and unmeasured GC points with their
coordinates and measurements accuracy data (RMS) on terrain. Buttons of the toolbar
allow to input, view, search, edit, import and export of GCP, and for viewing of selected
point measurements on project images in the Points measurement module (see
Section 5.3).

Fig. 44. GCP list

On the Tie points tab displays full list of tie points. The toolbar allows to search, filter,
edit, import/export and display points on project images in the Points measurement
module.

Fig. 45. Tie points list

75

Aerial triangulation (Windows x64)PHOTOMOD 8.0



Table 7. Toolbar of the Triangulation points window on the Tie points tab

FunctionsButtons
to refresh the points list
to open the Find window allowing to search a point by its name (Ctrl+F). Input full name
or its part, define the search direction and click the Find next button. Found point is
highlighted in the list. The Points measurement module shows all positions of found
point on images
to remove selected points from a list (Alt+Del). To select multiple points use Shift and
Ctrl keys
to use selected points as tie points («+»), if these points were excluded previously («-»)
(Ctrl+I). In this case previously excluded GC point, that is measured on multiple images,
is used only as tie. In order to use the point as a GCP, select the Ground Control type
on the GCP list tab in editing mode
to not use selected points as tie points, i.e. to exclude the points from calculation of rel-
ative orientation (Ctrl+E). Excluded point is marked by «-» sign, but is not removed.
When excluding GC point with measurements on multiple images, it will be excluded
both by GCP and by tie
to assign numeric names to highlighted points (to rename points)
to perform import of triangulation points from PAT-B, X-Points, and from PHOTOMOD
4.x
to perform export of triangulation points to PAT-B and X-Points
to open the Point properties window used to display name, type, code and coordinates
of selected point
to display point selected in a list on images (is duplicated by mouse double click on the
point in a list) (see the Section 4.2.3)
to setup accuracy control parameters and to open relative orientation report
to display all tie points in a list
to display all tie points on opened images in the Points measurementmodule. This filter
is applied both to records in the list, and to points display on images in the Points
measurement module. The title of the Triangulation points window displays number
of points selected after filtration
to display only common tie points on opened images. This filter is applied both to records
in the list, and to points display on images in the Points measurement module. The
title of the Triangulation pointswindow displays number of points selected after filtration
to display values of Y-parallax and triplet residuals for points in the list in pixels
to display values of Y-parallax and triplet residuals for points in the list in millimeters
to enable automatic search for images containing the point’s position: if the mode is
enabled, the button or mouse double click on a row with the point in coordinates list
allows to open the images in the Points measurementmodule, on which selected point
coordinates are already measured, otherwise, to open all images that contain the point’s
coordinates
to create raster outline of triangulation points
to remove all tie points from a list

In order to invert work of the mode (change its state to the opposite) for a short time, click
the Alt key and select a point using mouse double click or click the button.
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When toggling between and modes and some point is selected in the list and is not cor-
responding to chosen mode, it is displayed by grey color in the table.

The list of tie points is a table.

Points sorting in columns of the list is performed by mouse click on the column header.

Table 8. Types of table columns – list of points on the “Tie points” tab

FunctionsButtons
displays point’s codeCode
displays point’s nameName
displays point’s type (tie, GCP, check, excluded)Type
displays «+», if the point is used for calculating of
relative orientation, «-», if the point is excluded from

Tie point included

calculation. When a tie point is excluded all values
in columns are inactive. When a GCP is excluded,
it is excluded completely by ground control and by
tie, and in the Type field the Excluded value is
displayed
displays «+», if the point is measured in automatic
mode (see the Section 4.5) or «-», if the point’s co-
ordinates are measured manually

Point measured automatically

displays number of images where point’s coordin-
ates were measured

Total measurements

displays number of strips with the point’s coordinates
measurements

Strips with point measurements

displays «+», if the point’s coordinates are measured
on a single image (with no ties) only, otherwise «-»

Measured on a single image

displays «+», the point’s coordinates are measured
on stereopairs, otherwise «-»

Measured on stereopairs

displays «+», the point’s coordinates are measured
in triplet, otherwise «-»

Measured in triplets

displays «+», if interstrip point is single within one
of the strips or «-», if it is not single within a strip
(i.e. is measured on stereopair or in triplet)

Stripswithmeasurements on isolated images

displays «+», if the point’s coordinates are measured
on images of non-adjacent strips, otherwise «-»

Measurements on non-adjacent strips

displays correlation coefficient, if the point’s coordin-
ates were measured using correlator

Minimum correlation coefficient

displays Y-parallax (in pix or mm), if stereopairs are
opened in the Points measurement module and
relative orientation is done

Max Y-par

displays triplet residual by XY for a point with
measurements in triple overlap area (in pix or mm),

Max Exy

if the triplets are opened in the Points measure-
ment module
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FunctionsButtons
displays triplet residual by Z for a point with meas-
urements in triple overlap area (in pix or mm), if the

Max Ez

triplets are opened in the Points measurement
module

During executing of relative orientation it is recommended to set the following threshold
values:

• correlation coefficient threshold – 0.9-0.95;

• maximal Y-parallax – no more than the pixel size;

• values of threshold on maximal error in triplets are calculated using the following
formula:

Emax ≈ 2 Emean , where Emean – average error threshold;

• average error by XY is calculated using the following formula:

Emean
xy = 2 0.5pix

average error by Z – is average error by XY, multiplied by ratio of the camera focal
length (f) to the survey basis (b):

Emean
z = f

b Emean
xy .

4.4. Manual measurement of tie points coordinates

ThePointsmeasurementmodule provides tools used to measure tie points coordinates
manually without correlation or using correlator.

Measurement of tie points coordinates without correlation – adding tie point to marker
position on opened images.

Measurement of tie points coordinates using correlation – automatic search on
project images for a terrain point, that corresponds to a point specified by marker on
the “left” image, and further attempt of the system to calculate correlation coefficient to
make a decision about adding of tie point. A point search using correlator depends on
the correlator parameters settings.

For tie points measuring/editing without correlator the Points measurement module
provides the following features:

• to measure tie point coordinates perform the following actions:
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1. Choose and open image to measure tie points coordinates (see the Section 4.2.3).

2. Choose and show using marker the same terrain point on opened images.

3. Click the button of the upper toolbar of the Points measurement window. A
new tie point is added to the triangulation points list and is displayed on opened
images (see also Section 6.3).

• to transfer already measured tie point into specified marker position with adding
measurements of this point to another image perform the following actions:

1. Open images with measurements of selected tie point and (if needed) images,
containing the same terrain point, but without measurements (see Section 4.2.3).

2. Show by marker new position of tie point on all opened images.

3. Click the button of the upper toolbar of the Points measurement window. Tie
point is transferred/added to specified marker position on images. Tie points
measurements are updated in the triangulation points list.

During adding of a point located out of image border, a point without coordinates values is created
in the table. At that after saving the points list data with blank record and the point on image will
be removed.

The Points measurement module provides the following opportunities for tie points
measurements using correlator:

• to correlate active image with “left” and to add tie point, perform the following actions:

1. Choose and open images to measure tie points coordinates (see the Sec-
tion 4.2.3).

2. Choose the “left” image and click the button in the toolbar of this image window.

3. Show by marker a terrain point on the “left” image.

4. Show by marker a terrain point on the active image different from the “left” one,
that approximately corresponds to this point.

The active image window is highlighted by blue frame.

5. [optional] In order to place marker on all opened images to marker position on
the active image, double click selected terrain point on the image.

When place marker within a radius of 10 pixels around existing tie point, an existing
point will be edited during using the correlator, rather than a new point will be created.
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6. Click the button of the upper toolbar of the Points measurement window.
After correlation operation one of the following events will occur:

○ if the system failed to calculate correlation coefficient, the “Bad point” warning
will appear;

○ if correlation coefficient is calculated successfully, the New tie point window
opens. The window displays point’s code and name (by default) (for its editing
it is possible to use any symbols), and calculated correlation coefficient.

Fig. 46. Correlation of the active image with the “left” image

Data display in the coefficients table depends on values of the Correlation
threshold for points measurement and Correlation threshold for marker
movement parameters, specified in the Points measurements settings
window.
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Fig. 47. Adding a point depending on degree of images correlation

7. Make a decision about adding of new tie point. To add a point set checkboxes
next to selected images in the list and click OK, otherwise click theCancel button.

• to correlate all opened image with the “left” image in order to add a tie point, perform
the following actions:

1. Choose and open images to measure tie points coordinates.

2. Choose the “left” image and click the button in the toolbar of this image window.

For correlation of all opened images with the active image, it is not necessary to choose
the “left” image.

3. Show by marker a terrain point on the “left” image.
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4. Show by marker on other opened images a terrain point, that approximately
corresponds to this point.

5. Click the button on the upper toolbar of the Points measurement window or
use the Ctrl+Space shortcut. After the correlation operation the New tie point
window opens, that allows to analyse correlation coefficients and make a decision
whether to add a new tie point or there is a warning “Bad point” (see the descrip-
tion above).

Fig. 48. Correlation of all opened images with the “left” image

6. To add a point select images in the list (set appropriate checkboxes) and click
OK, otherwise click the Cancel button.

The button on the upper toolbar of the Points measurement window is used to view
correlation coefficients of all images with the “left” image without adding of a tie point. In the
status bar of each image window, which is correlated to the “left” image, the correlation
coefficient is displayed. And in the status bar of the “left” image there is the auto-correlation
coefficient.

4.4.1. Parameters of points coordinates measurement

Semi-automatic search and measurement of tie points coordinates using correlation
algorithm includes matching of corresponding fragments of images considering maximal
relative coefficient of correlation. A point search using correlator depends on the correl-
ator parameters settings.

In order to open the Points measurement settings window click the button on the
upper toolbar of the Points measurement module.
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Fig. 49. Points measurement settings

When the Show report after finished editing checkbox is set, relative orientation report
is opened after clicking OK in the Points measurement module.

When theCorrect GCPs position while measurements checkbox is set, an improved
algorithm for searching for corresponding terrain points in block images (with marker
positioning at these points) is used during manual measurement of GCP coordinates.

Proper functioning of the improved algorithm for GCP position refinement is feasible under strict
compliance with the following conditions:

• The adjustment is performed (see the “Block adjustment” User Manual);

• All three GCP coordinates are available (see the Section 5.2);

• At least two point measurements are available in project images (see the Section 5.3.1).

TheCorrelator section contains the following parameters used to setup correlator using
during tie points measurement or for analysis of correlation coefficients (using the ,

, , buttons of the Points measurement module):

• Correlation matrix halfsize (in pixels) – allows to specify size of correlation matrix
by X and Y axes;

• Contrast point search area (in pixels) – allows to specify area where to perform a
search for a point of maximal contrast;

It is recommended to use this parameter for images with big percent of one-colour areas.
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• Corresponding point search area (in pixels) – allows to specify area where to per-
form a search for a terrain point, that corresponds to a point of the “left” image (area
around marker);

• Correlation threshold – allows to define a value of correlation threshold for point
coordinates measurements and for marker movement. These values influence
on search and measurement of tie points coordinate in the following way:

Fig. 50. Adding a point depending on degree of images correlation

4.4.2. Editing of tie points

The system allows to edit tie points, and to change points type in a list.

To change point’s position highlight it using one of the following ways:
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• chooseOrientation › Tie points list or click the button of theAT additional toolbar.
The Triangulation points window opens. Select a point to be edited in the table by
double mouse click;

• in the image window of the Points measurementmodule double click a point’s area;

• in the Triangulation points window of the Points measurement module select a
point to be edited by mouse double click;

• during the adjustment step; perform the following actions:

1. Select a point on a block scheme or in a list, which error exceeds specified
threshold value.

2. Click the button. The Information window opens.

3. Click the Measure button.

As a result marker is placed to a position of selected point on all images/only on images
with point measurements.

To change point’s position perform one of the following actions:

• change point’s position manually or using correlator in the same way as during
measurement of point’s coordinates;

• click the button of image window toolbar, to move the point along vector of the tie
error on a single image, or click the button of the upper toolbar, to move the point
on all images;

• click the button of image window toolbar, to move the point along vector of the
GCP error on a single image, or click the button of the upper toolbar, to move the
point on all images.

To display vectors of tie and GCP errors the system provides the and buttons of the left
toolbar correspondingly.

When using the , , , buttons to change over block images a marker is fixed to selected
point position. To fix a marker in relation to image border, it is possible to use theAlt+H shortcut.

Click the Apply button to confirm the changes or click OK to confirm the changes and
exit from the Points measurement module.

Change of the point type is provided in the following windows:

• the Exterior orientation parameters window;

Excluded GCP are not considered during block adjustment. It is recommended to use the
Excluded type for non-measured GC points prior block adjustment operation.
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• the GCP list and Tie points tabs of the Triangulation points window;

• the Point properties window.

4.4.3. Measurement of tie points coordinates in stereo mode

The system provides possibility to measure points coordinates in a stereomode.
Measurement of tie points coordinates in a stereomode are required when the points
are located on high objects, or at the bottom corner of the building (so that in the mono
mode a point is not visible on the second image of the stereopair).

There are the following two modes of points measurement in stereo mode on selected
stereopair in the Points measurement module:

• measurement of points coordinates in moving marker mode;

• measurement of points coordinates in fixed marker mode in stereocomparator (set
by default).

Stereocomparator mode – a mode with marker fixed in the center of the window. In
stereocomparator mode it is possible to move an image using pressed left mouse button.
At that marker remains fixed in the window center. The main advantage of this kind of
stereo measurements is that it is possible to position the marker with sub-pixel accuracy.
The pixel size depends on the current zoom and the marker moving step is defined by
the sensitivity slider located at the bottom of the stereo window. Stereocomparator
mode is used either to work with in-strip stereopairs for measuring of tie points coordin-
ates in images overlap area, or for measurement of tie points between strips in inter-
strip overlap area.

For points coordinates measurement in stereomode the stereoimage window is used.
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Fig. 51. Stereoimage in stereocomparator mode

Stereowindow toolbar contains the following information and buttons:

• , , , , – standard buttons used to manage image in the window;

• (Ctrl+F6) - allows to turn on/off stereocomparator mode;

• (F11) – allows to switch stereo phase (to swap “left” and “right” images);

• – is used to add new tie point;

• – is used to move and add a point to marker position;

• – is used to remove a point from stereoimage;

• – allows to create epipolar images by points, if at least five tie points coordinates
are measured;

Creating of epipolar images (images for which Y-parallax tends to zero) is available when
there are at least 5 measured tie points on stereopair.
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• – allows to create epipolar images using adjustment results, if it is possible (if
there are adjustment results available);

• – allows to show/hide the control panel used to setup a stereo image (in lower
stereowindow corners);

• a name of opened stereopair image;

• a value of Y-parallax Y-par (in pix) on selected tie point (available only for in-strip
stereopairs);

• – allows to close a stereo window and to go back to opened windows of the Points
measurement module.

In the lower part of stereo window there are control panels used to adjust images and
manage their movements.

Left group of red arrows is used to move the left image of stereopair (Shift + arrow
keys).

The group of grey arrows (duplicated by arrow keys of the keyboard) is used to move
left and right images at once.

The group of light blue arrows allows to move the right image (Ctrl + arrow keys).

The additional buttons on the right group of arrows allow to perform the following actions:

• – zoom in the right image scale on 5% (along with pressed Shift key – on 1%);

• – zoom out the right image scale on 5% (along with pressed Shift key – on 1%);

• 1:1 – reset the right image to 1:1 scale.

The Step slider is used for sensitivity adjustment of mouse move, mouse wheel rotation
and actions of keyboard arrows. Move step is changed from 0.1 to 20 of current screen
pixel size (which corresponds to current zoom level), and is also setup using the following
shortcuts: Ctrl+0, Ctrl+1... Ctrl+9.
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“Steering-wheels” are used for images rotation. The left “steering-wheel” is intended
for both images rotation at once (by clicking on the wheel field or entering rotation angle
value into numeric field). And the right wheel – for right image rotation.

To display the panel used to adjust the image brightness, contrast and gamma-correction
for a single image or both images of a stereopair use the Shift+F8 shortcut.

The , , sliders are used to adjust a brightness, contrast and gamma-correction
of a stereoimage. Tools located in the right part allow to select left, right or both images,
and also color channels, which correction settings will be applied to.

It is possible to setup parameters for all channels at once if the button is pressed
down, otherwise the system allows to setup individual channel.

Fig. 52. Panel used to adjust image brightness and contrast

It is possible to setup parameters for both stereopair images at once if the button is
pressed down, otherwise, separately for the right stereopair image or for the left one

.

To restore brightness and contrast settings to default values, right click the settings
panel and select the Reset item.

Brightness, contrast and gamma settings are not restored after the module restart.

To measure points coordinates in stereomode perform the following actions:

It is needed to enable the Anaglyph stereomode to measure points coordinates (the “Stereo
settings” chapter of the “General system’s parameters” User Manual).

1. In the Pointsmeasurement window select “left” and active images of a stereopair.

2. Specify approximately by marker the same terrain points on these images and click
the button of the main toolbar of the Points measurement module. By default
a single window with stereoimage instead of all opened windows of images will be
opened in the module.

Click the button while holding pressed the Shift key to open a stereo window with size
of two images on place of the “left” and active images; or hold the Ctrl key to open a stereo
window with size of one window on place of the “left” image.

3. Click the button or use the Ctrl+F6 shortcut to turn on the stereocomparator
mode (which is on by default).
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4. To measure points coordinates in stereocomparator mode perform the following
actions:

1. Place a marker at the terrain point.

2. Remove a X-parallax, rotating mouse wheel or using horizontal arrows to move
left or right image.

3. To measure coordinates of a new tie point press the Space key. As a result of
correlation one of the following events occurs:

• The “Bad point” warning is displayed if the system failed to calculate correla-
tion coefficient;

• The New tie point window opens if correlation coefficient is calculated suc-
cessfully. The window shows the point code and name (by default), and also
calculated correlation coefficient. It is possible to use any symbols to edit the
point’s name.

Fig. 53. Correlation of the active image with the “left” one

Data display in coefficients table depends on values of parameters Correla-
tion threshold for points measurements and Correlation threshold for
marker movement specified in the Points measurement settings window
(see the Section 4.4.1).
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Fig. 54. Adding a point depending on degree of images correlation

4. Make a decision on adding a new tie point. To add a point set checkboxes to
select images in the list and click OK, or click the Cancel button to cancel op-
eration.

5. [optional] To move current selected tie point to marker’s position click the
button.

6. If calculated value of Y-parallax for this point is not satisfactory it is necessary
to re-measure the point. At that for better positioning of the image it is necessary
to rotate mouse wheel while holding pressed the Ctrl key or to rotate vertical
arrows of the left and right images to eliminate vertical parallax.

Maximal acceptable value of the vertical parallax is one pixel.
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5. [optional] To turn on the moving marker mode click the button once more (to
turn the stereocomparator mode off) or use the Ctrl+F6 shortcut. When measuring
tie points in the moving marker mode use the following tricks to remove parallaxes:

• mouse wheel+Ctrl – allows to change marker’s parallax;

• mouse wheel+Shift – allows to change X-parallax;

• mouse wheel+Ctrl+Shift – allows to change Y-parallax.

6. Close stereo window to return to the Points measurement window.

4.4.4. Point properties

In order to view selected point properties click the button of the Triangulation points
window. The Point properties window opens.

Fig. 55. Point properties

The window displays the following information about point:

• the Name field allows to change a name of selected point;

• the Code field shows a code assigned to selected point (not editable);

• the Type section allows to change a type of selected point and to make it Check,
Ground control, Tie or to exclude it from orientation;

92

Aerial triangulation (Windows x64)PHOTOMOD 8.0



• set the Unused tie point checkbox if a point is not used as tie point;

• the Targeted checkbox – allows to mark a point as targeted point, without changing
its type;

• the Measured automatically checkbox – is set if a point is obtained by automatic
measurement of tie points;

During editing of automatically measured point in the Points measurement module, the
Measured automatically checkbox is cleared and a point is considered as measured
manually.

• for GC points the geodeticCoordinates andRMS of selected point are also displayed.

4.5. Automatic measurement of tie points coordinates (general
information)

The system provides possibility to measure tie points coordinates and perform relative
orientation in automatic mode. When working in automatic mode correlation algorithm
is used for search and measurement of tie points coordinates.

4.5.1. Source data

To perform automatic measurement of tie point coordinates the following data should
be available:

• interior orientation parameters of images, which will be considered in automatic
measurement of points coordinates;

It is highly recommended to perform interior orientation prior to automatic search of tie points,
since otherwise most of the filtering parameters are ignored, that considerably reduces relative
orientation quality.

• block layout;

Sufficient condition for launch the operation of automatic measurement of tie points coordinates
is availability of initial (“rough”) block layout, considering, for example, size of images overlap
and/or quick ties data. However, the more data is used for the block layout creation, the more
accurate is the block scheme and, hence, the better the results of measurement of tie points
coordinates in automatic mode.

If there are exterior orientation data received from the image provider, it is desirable to
import exterior orientation parameters before performing relative orientation of images,
although the availability of exterior orientation data is not a mandatory condition for
performing relative orientation of project images.
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4.5.2. Modes of automatic tie points measurement

TheAutomatic tie pointsmeasurementwindow have different configurations, provided
to process various data types:

When working with spaceborn scanner data the area correlator and feature based
correlator windows are used.

When working with airborne data the window allows to select manually optimal combin-
ation of basic and additional parameters of automatic ties search, measurement and
filtering, and also to save sets of this parameters as files with *.x-ini extension for the
further usage.

When working with UAS and “oblique” aerial data the window allows to load parameters
sets for automatic ties search, measurement and filtering (so called “presets”).

Preset – parameters set of automatic tie points measurement, preliminary created by user or
setup in advance.

4.5.3. Order of automatic tie points measurement

To measure tie points using automatic mode (на примере airborne data) perform the
following:

1. Create a block layout considering available data.

2. Setup parameters of tie points automatic measurement, transfer, filtering and start
the operation of automatic measurement of tie points coordinates.

3. Perform accuracy estimation of relative orientation and detecting of tie points
measurement errors.

4. Manually eliminate errors of tie points measurement in the Points measurement
module or choose other filtering parameters (for example, specify more “strict” tol-
erances for measurement errors) and start the operation of automatic measurement
of tie points coordinates once more.

5. Update block layout considering tie points. Change settings of automatic tie point
measurement parameters if necessary and start once more operation of further
collecting of tie points measurements. Repeat steps 3-4 until obtain satisfactory
results.
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4.6. Automatic measurement of tie points coordinates (scanner
imagery)

4.6.1. Area correlator

This function is not available for the central projection projects.

Automatic measurement of tie points coordinates

To measure tie points coordinates in automatic mode perform the following actions:

1. Choose Orientation › Automatic tie point measurement › Satellite scanner
survey › Area correlator. The Automatic tie points measurements window
opens.

For automatic measurements all images are selected by default. For tie points search just
on selected images clear the checkbox Select all images for automatic tie point meas-
urement on the Orientation tab of the Parameters window.

2. Use default presets of measurement parameters or set manually the main paramet-
ers for tie points search, measure and filter.

3. [optional] For more detailed tuning and refining of themainmeasurement parameters
set the additional parameters.

4. [optional] In order to use distributed processing during measurement of tie points
coordinates, perform the following actions:

1. Click the Distributed processing... button. The Distributed measurement
of tie points window opens.

The Maximum number of tasks for this project value is displayed in the
window. This parameter shows howmany processing tasks is possible to divide
the current project to.

Fig. 56. Parameters of distributed measurement of tie points in automatic mode
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2. Specify the Number of tasks to create, which will be processed on one com-
puter. See the description of distributed processing setup in the General inform-
ation User Manual.

3. Click OK to go back to previous window.

5. Click the Start button in the Automatic tie points measurement window to start
operation of automatic measurement of points coordinates.

6. Open the relative orientation report to view results of relative orientation operation
and to fix measurement errors.

The report will open automatically after the operation completion, if the appropriate
checkbox is set (see below).

Main parameters of tie points measurement

The Automatic tie point measurement window allows to use parameters presets of
tie points measurement, or to manually choose the optimal combination of basic and
additional parameters for automatic tie points search, measurement and filtering.

ChooseOrientation › Automatic tie point measurement › Satellite scanner survey ›
Area correlator. The Automatic tie points measurement window opens.

Fig. 57. The Automatic tie points measurement window

The Automatic tie points measurement window includes the following interface ele-
ments:
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• the images selection toolbar used to open auxiliary windows, to save and load sets
of parameters;

• a list of project images allows to select images, scheduled to perform automatic
measuring of tie points coordinates;

• the Tasks section used to specify main actions (measurement, transfer, filtering, re-
porting) during operation of automatic measuring of tie points coordinates;

• the Parameters section used to specify main parameters of automatic measuring of
tie points coordinates;

• the More button used to setup additional parameters of measuring of tie points co-
ordinates;

• the Start button used to launch an operation of tie points measurement and to perform
relative orientation in automatic mode;

• the Distributed processing button is used for automatic tie points measurement in
distributed processing mode.

The system provides the following buttons in the toolbar to work with auxiliary windows:

• – allows to select stereopairs where there is no tie points coordinates measure-
ments, and their adjacent images;

• – allows to select triplets without tie points;

• – allows to select interstrip stereopairs where there is no tie points coordinates
measurements;

When searching for stereopairs and triplets, excluded ( ) points are also not taken into ac-
count. The Excluded status (in this case) is equivalent to no measurements. The user can
change the status of a point using the appropriate tools of the Triangulation points window.

• – allows (in case of already existing measured tie points) to deselect stereopairs,
triplets, and inter-strip stereopairs by setting the following:

○ Minimum points for inter-strip pairs;

○ Minimum points for in-strip pairs;

○ Minimum points for triplets.

• – allows to open the Relative orientation report settings window used to specify
parameters and view a relative orientation report;

97

Aerial triangulation (Windows x64)PHOTOMOD 8.0



• – allows to open the Triangulation points window used to view a list of triangu-
lation points;

• – allows to open the Points measurement module and open automatically open
images selected in the list, if more than 6 images are chosen. Otherwise, an in-strip
stereopair with image selected in the list will be opened.

To save and load sets of main and auxiliary parameters the system provides the following
buttons:

• – is used to load a set of parameters from *.x-ini file saved previously in active
profile resources or out of them.

The arrow located next to the button allows to open a drop-down menu containing
the following items:

○ Load settings from file allows to open the Load settings window used to load a
set of parameters from *.x-ini file, located out of active profile resources;

○ Reset settings to defaults allows to use default settings;

• – used to save setting of main and additional parameters to a file with *.x-ini
extension in active profile resources.

To save setting to a file with *.x-ini extension located out of active profile resources, open
drop-down list by clicking the arrow next to the button and choose Save settings to file....

Setting saving is used to create files with settings directed to work with certain type of block,
kind of images, or terrain, etc.

The Tasks section is used to specify the following actions during automatic tie points
measurement:

• Measure tie points in stereopairs allows to perform search and measurement of
tie points coordinates on in-strip and inter-strip stereopairs;

A stereopair is called in-strip, if it is formed by two adjacent images in a strip, and inter-strip
is any other stereopair of a block.

• Transfer tie points allows to perform transfer of measured points to adjacent stereo-
pairs (transfer of points located in triple overlap area to adjacent models), and transfer
of tie points to adjacent strips;

• Filter tie points by relative orientation allows to perform points filtering that have
measurements, exceeding specified values of errors thresholds;
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During points check if to filter them or not, the system check out whether the point falls within
specified correlation threshold. Check for exceeding correlation threshold is applied only to
new points (if measured points are already available). In order to check all points whether
they exceed correlation threshold, set the additional Delete points with correlation below
threshold checkbox on theRejection tab in the Tie pointmeasurement parameterswindow
of additional parameters.

It is possible to perform actions with tie points inside strips, between strips, or not perform at
all.

• Report on relative orientation on completion allows to open the Relative orient-
ation report window automatically to view and edit tie points measurements just
after completing of automatic relative orientation.

TheParameters section allows tomake the following settings of automatic measurement
of tie points coordinates:

• Points per stereopair – allows to specify a number of points to be measured on in-
strip and inter-strip stereopairs;

Resulting amount of measured points may be either greater than a predetermined amount –
because of points transfer from adjacent stereopairs, or less due to further filtering. Default
amount of points is 30 per each images pair in forward overlap and 10 points in side overlap.
The minimum number of points to perform control by the vertical parallax residual – 6 points.

The Points per stereopair parameter depends on settings defined on the Miscellaneous
tab in the additional parameters window.

• Correlation threshold (%) – minimal acceptable value of correlation coefficient for
tie points, that will be selected during automatic search;

Recommended values lie in range from 90 to 95%. In contrast to all other filtering criteria,
this parameter directly influences on operation of points measurement and transfer. Check
for exceeding of correlation threshold is performed only for new points (if there are already
measured points). To check all measured points for exceeding of correlation threshold (usually,
at final stage of collecting measurements of tie points) set the additional Delete points with
correlation below threshold checkbox on the Rejection tab in the additional parameters
window.

• Measure points by zones – allows to apply a method of sequential measurement
by zones of overlap area. If the checkbox is cleared, points search is performed over
the whole area of images overlap. The system allows to select zones and define their
size in the Zones section on the Miscellaneous tab of the additional parameters
window;

• Filter points by zones – is used to filter points in stereopair zones sequentially;
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The operation provides filtering the worst (by parallax) points on stereopair, passing zone by
zone one after another. So the worst point on stereopair is found and deleted first, then the
worst one in the next zone and so on. Uniformity of point’s distribution on stereopair is also
verified in such a way.

• DEM – allows to choose a DEM (if any) to consider its data during automatic tie points
measurement. For this it is necessary to have saved adjustment results available.

This parameter allows to use DEM for calculation of the true position of the point. Thereby
the required search area of points reduces.

Click the button to clear a DEM.

Additional parameters of automatic measurement of tie points coordinates

For more detailed setup and adjustment and refinement of the basic parameters of tie
points coordinates measurement the Tie point measurement parameters window of
additional parameters is used. It is opened using the More button located in the main
Automatic tie point measurement window.

Fig. 58. Points search parameters

The Tie point measurement parameters window contains four tabs with parameters.

To reset to default parameters, delete the ProjCorrMatchOptions.x-ini file located in the project
root folder.

The Search for points tab allows to setup the following parameters:

• Search area (pix) – allows to specify a “halfsize” of area of matching point search;
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• Contrast point search area (pix) allows to search tie points in areas with maximal
contrast (on images with clear objects outlines);

In some cases it is reasonable to measure points in areas with low contrast, for example,
when forested areas have maximal contrast, and in these areas correlator’s errors are very
probable. In this case the Contrast point search area value should be set to 0.

• Tries per point – number of tries of matching point search with correlation coefficient
value that exceeds specified in the search area;

• Multipass points search allows to perform points search and filtering on stereopairs
in multiple passes with help of different algorithms. It is applied in case of insufficient
quality of the block layout, when real relative rotation of images relative to each other
is sufficiently big;

For multipass points search it is recommended to set correlation threshold high enough, for
example, 95%.

It is recommended to use multipass points search for UAS images.

• Search the whole images area allows to specify images pairs to search points: ad-
jacent images in each strip and/or non-adjacent pairs of images in a strip and inter-
strip pairs of images.

Fig. 59. Parameters of correlator

The Correlator tab is used to setup parameters of area correlator work and contains
the following parameters:

• Correlation matrix half size (pix) allows to specify size of correlation matrix by X
and Y axes;
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• Autocorrelation control allows to specify level of auto-correlation – the Maximum
value of sigma in Gaussoid that is the top limit of distribution of the mask correlation
coefficient in a small area on the same image. The more the sigma value, the less
probability of correct points measurement, which were measured using correlation
with the given point as an initial one;

• Do not use image border area is used to specify a size of area near the image
border, that is not used during correlation operation;

Service area width (2% of image width and height by default) should not be less than on the
image; otherwise a big amount of “bad” points would be measured in image service areas.

• the Image blur slider is used to consider image material quality, from No to Strong
blur.

For images without blur or with negligible blur it is highly not recommended to place the slider
to position different from No.

In most cases the Image blur parameter is applied for processing of UAS images block.

Fig. 60. Filtering parameters

The Rejection tab is used to setup filtering parameters of points found and contains
the following options:

• Preliminary filtering with detection of trusted points group is used to preliminary
filtering of blunders, that do not allow calculate correctly angular elements of relative
orientation (see the parameters of trusted points group on the Miscellaneous tab);

This function is not available for the scanner projects.
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• Delete all tie points, if after filtering number of them left is less then specified
number – allows to delete all tie points on a stereopair, acquired during operation of
automatic measurement of points coordinates, if after their filtering their number is
not sufficient to perform correct relative orientation;

This function is not available for the scanner projects.

• Deletemeasurements on non-adjacent images allows to filter potentially erroneous
points, measured on non-adjacent images inside a strip;

To measure tie points for UAS images in two steps it is recommended to set the Delete
measurements on non-adjacent images checkbox on the first step and to not to use this
parameter on the second step.

This function is not available for the scanner projects.

• Delete single points allows to reject points measured on single images;

• Delete points with correlation below threshold allows to delete points previously
measured using correlator, if their correlation coefficient in below threshold value
specified in theCorrelation threshold field of theAutomatic tie point measurement
window;

It is recommended to use the option for recurrent or final points filtration, since the filtering
covers all measured points, not only new ones, added during just another start of automatic
tie points measurement operation.

• Delete points surplus allows to delete points, if their number exceeds number spe-
cified in the Points per stereopair field of the Automatic tie point measurement
window, sorted by the Y-parallax in descending order;

The parameter considers whether the Filter points by zones checkbox is marked, that allows
to delete points evenly. It is recommended to use the option after the initial tie points meas-
urement on UAS images.

The points are deleted regardless of type and number of measurements per point (the system
may delete both GC point and the points in triple overlap).

• Check correlation of measurements transferred from other stereopairs is used
to check on each stereopair correlation coefficient of measurements, collected during
points transfer from other stereopairs, since the chain of such transfers may lead to
errors accumulation and bring unacceptable result;
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• X-parallax clipping (%) allows to specify number of points with minimal and maximal
x-parallax (relatively to total amount of points) which will be deleted after filtering in
strip and between strips.

It is recommended to apply this rejection method if erroneous points are dispersed clearly
along stereopair basis (if, for example, a highway with bright marking goes in parallel to survey
basis and correlator puts points on marking line elements, which do not correspond with each
other.

This function is not available for the scanner projects.

• Check by reverse stereopair –allows to check the search results on reverse stereo-
pair; if the results are not equal, point deletes;

Fig. 61. Miscellaneous parameters

TheMiscellaneous tab contains sections and options to setup the following additional
parameters:

104

Aerial triangulation (Windows x64)PHOTOMOD 8.0



• Number automatically measured points starting with is used for automatic num-
bering of measured tie points starting with number, specified in the entry field, that
allows to distinguish these points from the ones already measured on the project
images;

Regardless of the set value, the system does not generate points with duplicate numbers. If
the point with some number already exists, then this number will be skipped when creating
new points.

• Minimum distance between points (pix) allows to specify minimal distance in pixels
between points measured on the image;

It is recommended to increase the value of this parameter, when the problems with block
adjustment occur. The parameter is considered only during measurement new points. Existing
tie points are not rejected.

• Minimal dispersion allows to specify minimal dispersion of mask to protect from
points search on the clouds and water bodies;

The option is used to exclude points in monotonous areas, for example, for satellite scanner
images, if there are black strips on images borders, and for overexposure due to cloudiness.

• Pyramid level for preliminary search (only for central projection images) – allows
to choose an image pyramid level used to preliminary search of points. If the checkbox
is set on, preliminary search is performed by source image;

• Fixed search sequence – allows to obtain the same results of automatic measure-
ment of tie points coordinates during multiple runs of the operation with the same
initial parameters;

• The “Points per stereopair” parameter influences on the Points per stereopair
parameters located in the Automatic tie point measurement window and allows to
select the following number of points:

○ Points to add per session – values specified in the main window, that mean a
number of new points, which will be added to already measured ones;

○ Target number of points on a stereopair – values specified in the main window,
that define total points number;

The resulting number of measured points may be both greater than a predetermined amount –
due to points transfer from adjacent stereopairs, and less due to the subsequent rejection of
points. Default value is 30 points on each in-strip images pair, and 10 points – in inter-strip
overlap. The minimum number of points to control the vertical parallax residual is 6.
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• parameters which allow to specify trusted points group to be used as a master sample
for points rejection (see the Preliminary filtering with detection of trusted points
group parameter on the Rejection tab). A group of points is considered as trusted
if the following two conditions are met during the points search:

1. The distance between the point on one image and the corresponding point on
another image should not exceed the parameter specified in the Maximum
spread radius within trusted points group input field.

2. Number of points found, which satisfy to the first condition should not be less
than the parameter specified in the Minimum trusted points group size input
field.

If a trusted group has been found, it supposedly means that angles of relative orient-
ation have been computed correctly and the points rejection can be performed using
these data. Otherwise, the rejection of points will not be executed, even if the Prelim-
inary filtering with detection of trusted points group checkbox is set on the Re-
jection tab.

TheMaximumpoints to use filtering by trusted group parameter is used to specify
the limitation on the number of points to reject.

It is recommended to set theMaximum points to use filtering by trusted group value from
40 to 60. It is not recommended to set more than 60 points.

The Stereopairs section contains the following parameters:

• Create stereopairs based on exterior orientation data, from images, projection
centers of which are within range of – if this option is checked, the stereopairs will
be composed from images, projection centers of which are located at the distance
no more than a specified value (in meters), otherwise, the stereopairs are composed
from nearest images in a strip.

• From different strips only – if this option is checked, the in-strip stereopairs will not
be considered. Otherwise, all in-strip stereopairs will be considered, including the
nonadjacent.
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Fig. 62. Miscellaneous parameters

The Zones section allows to define a zone size on a stereopair, where the system
performs automatic search and measurement of tie points coordinates. Information
about recommended zones is located in the Section 4.1.

The Points transfer section contains the following parameters:

• Strict limits for initial point position – if the checkbox is set, the system performs
search for a point only inside of image, otherwise, the search is possible out of the
image boundary, if the Search area parameter value on the Search for points tab
exceeds the image size.

• Tie points, measured manually – allows to transfer and filter tie points, measured
manually.

If checkboxes for filter are set on, but checkboxes for transfer are set off, filter does not per-
form, because there is no transfered points.

• GC points, measuredmanually – allows to transfer and filterGC points, measured
manually.

If checkboxes for filter are set on, but checkboxes for transfer are set off, filter does not per-
form, because there is no transfered points.
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• Points, measured automatically – allows to transfer and filterGC points, measured
automatically.

If checkboxes for filter are set on, but checkboxes for transfer are set off, filter does not per-
form, because there is no transfered points.

The Rejection by angles section allows to specify parameters of measured points fil-
tering by single or multiple relative orientation parameters of the right or left image.

In some cases after automatic measurement of tie points coordinates due to erroneous
points the images are rotated in a block and their relative orientation parameters are
calculated incorrectly. To prevent images rotation the filtering of measured tie points
by the values of the rotation angle is used. To do this it is necessary to change angles
threshold value (in degrees) for each of stereopair elements. As a result, the points
which cause exceeding of angles thresholds will be rejected after relative orientation
recalculation.

It is not recommended to use this method of rejection for blocks, in which the images can actually
be rotated in relation to each other, since in this case the likelihood of removing properly placed
tie points increases.

4.6.2. Feature based correlator

This function is not available for the central projection projects.

The object-oriented correlator provides for correct automatic measurement of tie points in imagery
with missing exterior orientation elements (metadata). Further successful adjustment of similar
projects is possible if georeferenced data are available.

Automatic measurement of tie points coordinates

To measure tie points coordinates in automatic mode perform the following actions:

1. Choose Orientation › Automatic tie point measurement › Satellite scanner
survey › Feature based correlator. Automatic tie points measurement window
opens.

For automatic measurements all images are selected by default. For tie points search just
on selected images clear the checkbox Select all images for automatic tie point meas-
urement on the Orientation tab of the Parameters window.

2. Set the main parameters for tie points search, measure and filter.

3. [optional] In order to use distributed processing during measurement of tie points
coordinates, perform the following actions:
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1. Change settings and run the distributed processing server/client (see the “Dis-
tributed processing” chapter in the “General information about system” User
Manual).

2. Click the Distributed processing... button. The Distributed processing set-
tings window opens.

Specify the Maximum number of parallel tasks value is displayed in the
window. This parameter shows howmany processing tasks is possible to divide
the current project to.

In case the workstation processor supports the hyperthreading technology, it is recom-
mended to reduce themaximum number of parallel tasks by half in order to ensure
system’s stability.

Hyper-threading (hyper-threading technology) is simultaneous multithreading imple-
mentation used to improve parallelization of computations. With HTT, one physical
core appears as two processors to the operating system, allowing concurrent
scheduling of two processes per core.

Fig. 63. Parameters of distributed measurement of tie points in automatic mode

3. Click OK to go back to previous window.

The Progress bar remains open during the entire operation running, allowing the user
to directly monitor the progress of data processing from the PHOTOMOD interface
without opening the Monitor for distributed processing (see “Progress bar for dis-
tributed processing” in the “General information” User Manual).

4. Click the OK button in the Automatic tie points measurement window to start
operation of automatic measurement of points coordinates.

5. Open the relative orientation report to view results of relative orientation operation
and to fix measurement errors.
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Main parameters of tie points measurement

The Automatic tie points measurement window allows to use parameters presets of
tie points measurement, or to manually choose the optimal combination of basic and
additional parameters for automatic tie points search, measurement and filtering.

ChooseOrientation › Automatic tie point measurement › Satellite scanner survey ›
Feature based correlator. Automatic tie points measurement window opens.

Fig. 64. The Automatic tie points measurement window

The Automatic tie points measurement window includes the following interface ele-
ments:

• the images selection toolbar used to open auxiliary windows, to save and load sets
of parameters;

• a list of project images allows to select images, scheduled to perform automatic
measuring of tie points coordinates;

• the parameters used to specify main parameters of automatic measuring of tie points
coordinates;

• the Ok button used to launch an operation of tie points measurement and to perform
relative orientation in automatic mode;

• the Distributed processing button is used for automatic tie points measurement in
distributed processing mode.

The system provides the following buttons in the toolbar to work with auxiliary windows:
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• – allows to select stereopairs where there is no tie points coordinates measure-
ments, and their adjacent images;

• – allows to select triplets without tie points ;

• – allows to select interstrip stereopairs where there is no tie points coordinates
measurements;

When searching for stereopairs and triplets, excluded ( ) points are also not taken into ac-
count. The Excluded status (in this case) is equivalent to no measurements. The user can
change the status of a point using the appropriate tools of the Triangulation points window.

To configure automatic tie points measurement the following parameters are used:

• The system allows for manual setting the initial and final levels of the pyramid of im-
ages, which are used to search for points, if the Automatic pyramid level detection
led to unsatisfactory results.

Start pyramid level – it is recommended to increase the value of starting pyramid level when
system performance is insufficient, and when there is no high requirements to processing
results accuracy. Recommended value of starting pyramid level is 2. When processing data
with small overlap, it is recommended to set the initial pyramid level equal to 1. The value of
the starting pyramid level that equals to zero provides maximum accuracy of the results, but
leads to increasing of data processing time;

End pyramid level – it is recommended to increase the value of ending pyramid level when
using data with different resolution (including cases of significant difference in spatial resolution
within one image).

• Maximum vertical parallax (in pixels) – threshold value for rejection executed after
points measuring/transfer. On each step of rejection process, the program searches
for the point with maximal Y-parallax on the stereopair and rejects it. After that, it
makes relative orientation once more and the iteration is executed until maximal Y-
parallax exceeds the parameter specified here, or until 6 points or less remain on
stereopair. Recommended value is a pixel size;

• Points per stereopair – allows to specify a number of points to be measured on in-
strip and inter-strip stereopairs;

Resulting amount of measured points may be either greater than a predetermined amount –
because of points transfer from adjacent stereopairs, or less due to further filtering. Default
amount of points is 30 per each images pair in forward overlap and 10 points in side overlap.
The minimum number of points to perform control by the vertical parallax residual – 6 points.

• Minimum convergence angle for approximation (in degrees) – allows to filter
points on images with convergence angle of smaller or null value, using affine model
(considering these images as a mono images);
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• Tile parameters – allows to set the Size (in pixels) and the Overlap (in percents) of
the tiles (the separate image fragments, where points measurement and filtering
should be performed);

• To increase the system performance through graphic processing unit resources, set
the Use GPU checkbox and select the desired device from the drop-down list;

The intensity of GPU usage can be monitored using various free software.Windows 10 users
can monitor GPU activity through theWindows Task Manager (Performance Tab).

It is recommended to usemodern graphics adapters with at least 4-6 GB of memory, especially
in the case of parallel execution of several tasks in distributed processing mode.

It should be considered that the performance of a video adapter as an extra device for com-
putations is not directly dependent on its memory amount but is influenced by the algorithms
used and features of the system architecture.If there is a choice, first of all, NVidia video ad-
apters are preferable.

During distributed processing, video adapters are to be selected in theMonitor for Distributed
Processing window, individually for each computer used as a distributed processing client
(see “Computers” in the “General information” User Manual. However, video adapters’ re-
sources will be used for distributed computations only if the Use GPU checkbox is set in the
current window.

If the computer used to configure the operation options (server) is also used as one of the
clients, the selection of the video adapter used by it is also carried out through the Monitor
for Distributed Processing, regardless of which device was selected in the drop-down list
in the current window (this choice is taken into account only in the case of standard data
processing mode).

• [optional] clear the Delete intermediate data checkbox to not to delete processing
data after computation is complete. It is recommended to leave the checkbox set if
automatic re-measurement of tie points coordinates is not planned;

The intermediate processing data may occupy a significant.

• [optional] clear the Search on total image area checkbox, to exclude from tie point
search those areas of a block where there are no image overlap according to rough
block layout results. This will allow to increase the system speed and improve the
correlator accuracy.

This checkbox is recommended only if primary block layout was performed correctly, after
visual estimation of image positions.
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4.7. Automatic measurement of tie points coordinates (aerial
survey)

4.7.1. Area correlator

This function is not available for the satellite scanner imagery or ADS projects.

Automatic measurement of tie points coordinates

To measure tie points coordinates in automatic mode perform the following actions:

1. Choose Orientation › Automatic tie point measurement › Aerial survey (Area
correlator). Automatic tie points measurement window opens.

For automatic measurements all images are selected by default. For tie points search just
on selected images clear the checkbox Select all images for automatic tie point meas-
urement on the Orientation tab of the Parameters window.

2. Use default setting of measurement parameters or set manually themain parameters
for tie points search, measure and filter.

3. [optional] For more detailed tuning and refining of themainmeasurement parameters
set the additional parameters.

4. [optional] In order to use distributed processing during measurement of tie points
coordinates, perform the following actions:

1. Click the Distributed processing... button. The Distributed measurement
of tie points window opens.

The Maximum number of tasks for this project value is displayed in the
window. This parameter shows howmany processing tasks is possible to divide
the current project to.

Fig. 65. Parameters of distributed measurement of tie points in automatic mode

2. Specify the Number of tasks to create, which will be processed on one com-
puter. See the description of distributed processing setup in the General inform-
ation User Manual.
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3. Click OK to go back to previous window.

5. Click the Start button in the Automatic tie points measurement window to start
operation of automatic measurement of points coordinates.

6. Open the relative orientation report to view results of relative orientation operation
and to fix measurement errors.

The report will open automatically after the operation completion, if the appropriate
checkbox is set (see below).

Main parameters of tie points measurement

The Automatic tie points measurement window allows to use presets of tie points
measurements, or manually choose optimal combination of basic and additional para-
meters for automatic search, measurement and filtering of tie points.

Choose Orientation › Automatic tie point measurement › Aerial survey (Area cor-
relator). The Automatic tie points measurement window opens.

Fig. 66. The Automatic tie points measurement window
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The Automatic tie points measurement window includes the following interface ele-
ments:

• the images selection toolbar used to open auxiliary windows, to save and load sets
of parameters;

• a list of project images allows to select images, scheduled to perform automatic
measuring of tie points coordinates;

• the Tasks section used to specify main actions (measurement, transfer, filtering, re-
porting) during operation of automatic measuring of tie points coordinates;

• the Parameters section used to specify main parameters of automatic measuring of
tie points coordinates;

• the More button used to setup additional parameters of measuring of tie points co-
ordinates;

• the Start button used to launch an operation of tie points measurement and to perform
relative orientation in automatic mode;

• the Distributed processing button is used for automatic tie points measurement in
distributed processing mode.

The system provides the following buttons in the toolbar to work with auxiliary windows:

• – allows to select stereopairs where there is no tie points coordinates measure-
ments, and their adjacent images;

• – allows to select triplets without tie points;

• – allows to select interstrip stereopairs where there is no tie points coordinates
measurements;

When searching for stereopairs and triplets, excluded ( ) points are also not taken into ac-
count. The Excluded status (in this case) is equivalent to no measurements. The user can
change the status of a point using the appropriate tools of the Triangulation points window.

• – allows (in case of already existing measured tie points) to deselect stereopairs,
triplets, and inter-strip stereopairs by setting the following:

○ Minimum points for inter-strip pairs;

○ Minimum points for in-strip pairs;

○ Minimum points for triplets.
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• – allows to open the Relative orientation report settings window used to specify
parameters and view a relative orientation report;

• – allows to open the Triangulation points window used to view a list of triangu-
lation points;

• – allows to open the Points measurement module and open automatically open
images selected in the list, if more than 6 images are chosen. Otherwise, an in-strip
stereopair with image selected in the list will be opened.

To save and load sets of main and auxiliary parameters the system provides the following
buttons:

• – is used to load a set of parameters from *.x-ini file saved previously in active
profile resources or out of them.

The arrow located next to the button allows to open a drop-down menu containing
the following items:

○ Load settings from file allows to open the Load settings window used to load a
set of parameters from *.x-ini file, located out of active profile resources;

○ Reset settings to defaults allows to use default settings;

• – used to save setting of main and additional parameters to a file with *.x-ini
extension in active profile resources.

To save setting to a file with *.x-ini extension located out of active profile resources, open
drop-down list by clicking the arrow next to the button and choose Save settings to file....

Setting saving is used to create files with settings directed to work with certain type of block,
kind of images, or terrain, etc.

The Tasks section is used to specify the following actions during automatic tie points
measurement:

• Measure tie points in stereopairs allows to perform search and measurement of
tie points coordinates on in-strip and inter-strip stereopairs;

A stereopair is called in-strip, if it is formed by two adjacent images in a strip, and inter-strip
is any other stereopair of a block.

• Transfer tie points allows to perform transfer of measured points to adjacent stereo-
pairs (transfer of points located in triple overlap area to adjacent models), and transfer
of tie points to adjacent strips;
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• Filter tie points by relative orientation allows to perform points filtering that have
measurements, exceeding specified values of errors thresholds;

Points check if to filter them or not, is performed sequentially by errors type – first check -
whether the point falls within specified correlation threshold, then whether it does not exceed
maximal vertical parallax value, and finally, search for triplet errors is performed, if the appro-
priate option is specified.

Check for exceeding correlation threshold is applied only to new points (if measured points
are already available). In order to check all points whether they exceed correlation threshold,
set the additionalDelete points with correlation below threshold checkbox on theRejection
tab in the Tie point measurement parameters window of additional parameters.

It is possible to perform actions with tie points inside strips, between strips, or not perform at
all.

• Filter tie points by adjustment results allows to perform automatic block adjustment
using specified parameters and to filter measured tie points after that;

Points filtering using adjustment results is applied if there are blunders on images between
strips. The filtering is performed using residuals tolerance specified in the Adjustment
parameters window, see the “Block adjustment” User Manual.

• Report on relative orientation on completion allows to open the Relative orient-
ation report window automatically to view and edit tie points measurements just
after completing of automatic relative orientation.

TheParameters section allows tomake the following settings of automatic measurement
of tie points coordinates:

• Points per stereopair – allows to specify a number of points to be measured on in-
strip and inter-strip stereopairs;

Resulting amount of measured points may be either greater than a predetermined amount –
because of points transfer from adjacent stereopairs, or less due to further filtering. Default
amount of points is 30 per each images pair in forward overlap and 10 points in side overlap.
The minimum number of points to perform control by the vertical parallax residual – 6 points.

The Points per stereopair parameter depends on settings defined on the Miscellaneous
tab in the Tie point measurement parameters window.

• Correlation threshold (%) – minimal acceptable value of correlation coefficient for
tie points, that will be selected during automatic search;

Recommended values lie in range from 90 to 95%. In contrast to all other filtering criteria,
this parameter directly influences on operation of points measurement and transfer. Check
for exceeding of correlation threshold is performed only for new points (if there are already
measured points). To check all measured points for exceeding of correlation threshold (usually,
at final stage of collecting measurements of tie points) set the additional Delete points with
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correlation below threshold checkbox on the Rejection tab in the additional parameters
window.

• Maximum vertical parallax (in pixels or mm) – threshold value for rejection executed
after points measuring/transfer. On each step of rejection process, the program
searches for the point with maximal Y-parallax on the stereopair and rejects it. After
that, it makes relative orientation once more and the iteration is executed until max-
imal Y-parallax exceeds the parameter specified here, or until 6 points or less remain
on stereopair. Recommended value is a pixel size;

• Maximumerror in triplets in XY-plane and by Z (in pixels, meters or mm) – threshold
discrepancy of points measurements on adjacent stereopairs in triple overlapping
zone of adjacent images in a strip. Use the following formula to calculate values of
acceptable errors in triplets:

Emax ≈ 2 Emean , where Emean – acceptable mean error (recommended acceptable
mean error value – 0.5 pix.).

Mean triplet errors in XY plane is calculated using the following formula:

RMS ≈ 2 Emean

Mean error by Z equals the mean error value in XY plane multiplied by the ratio of
focal length (f) to survey basis (b):

Emean
z = f

b Emean
xy .

• Measure points by zones – allows to apply a method of sequential measurement
by zones of overlap area. If the checkbox is cleared, points search is performed over
the whole area of images overlap. The system allows to select zones and define their
size in the Zones section on the Miscellaneous tab of the additional parameters
window;

• Filter points by zones – is used to filter points in stereopair zones sequentially;

The operation provides filtering the worst (by parallax) points on stereopair, passing zone by
zone one after another. So the worst point on stereopair is found and deleted first, then the
worst one in the next zone and so on. Uniformity of point’s distribution on stereopair is also
verified in such a way.

• DEM – allows to choose a DEM (if any) to consider its data during automatic tie points
measurement. For this it is necessary to have saved adjustment results available.

This parameter allows to use DEM for calculation of the true position of the point. Thereby
the required search area of points reduces.
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Click the button to clear a DEM.

Additional parameters of automatic measurement of tie points coordinates

For more detailed setup and adjustment and refinement of the basic parameters of tie
points coordinates measurement the Tie point measurement parameters window of
additional parameters is used. It is opened using the More button located in the main
Automatic tie point measurement window.

Fig. 67. Points search parameters

The Tie point measurement parameters window contains four tabs with parameters.

To reset to default parameters, delete the ProjCorrMatchOptions.x-ini file located in the project
root folder.

The Search for points tab allows to setup the following parameters:

• Search area (pix) – allows to specify a “halfsize” of area of matching point search;

• Contrast point search area (pix) allows to search tie points in areas with maximal
contrast (on images with clear objects outlines);

In some cases it is reasonable to measure points in areas with low contrast, for example,
when forested areas have maximal contrast, and in these areas correlator’s errors are very
probable. In this case the Contrast point search area value should be set to 0.

• Tries per point – number of tries of matching point search with correlation coefficient
value that exceeds specified in the search area;
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• Multipass points search allows to perform points search and filtering on stereopairs
in multiple passes with help of different algorithms. It is applied in case of insufficient
quality of the block layout, when real relative rotation of images relative to each other
is sufficiently big;

For multipass points search it is recommended to set correlation threshold high enough, for
example, 95%.

It is recommended to use multipass points search for UAS images.

• Search the whole images area allows to specify images pairs to search points: ad-
jacent images in each strip and/or non-adjacent pairs of images in a strip and inter-
strip pairs of images.

Fig. 68. Parameters of correlator

The Correlator tab is used to setup parameters of area correlator work and contains
the following parameters:

• Correlation matrix half size (pix) allows to specify size of correlation matrix by X
and Y axes;

• Autocorrelation control allows to specify level of auto-correlation – the Maximum
value of sigma in Gaussoid that is the top limit of distribution of the mask correlation
coefficient in a small area on the same image. The more the sigma value, the less
probability of correct points measurement, which were measured using correlation
with the given point as an initial one;

• Do not use image border area is used to specify a size of area near the image
border, that is not used during correlation operation;
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Service area width (2% of image width and height by default) should not be less than on the
image; otherwise a big amount of “bad” points would be measured in image service areas.

• the Image blur slider is used to consider image material quality, from No to Strong
blur.

For images without blur or with negligible blur it is highly not recommended to place the slider
to position different from No.

In most cases the Image blur parameter is applied for processing of UAS images block.

Fig. 69. Filtering parameters

The Rejection tab is used to setup filtering parameters of points found and contains
the following options:

• Preliminary filtering with detection of trusted points group is used to preliminary
filtering of blunders, that do not allow calculate correctly angular elements of relative
orientation (see the parameters of trusted points group on the Miscellaneous tab);

• Delete all tie points, if after filtering number of them left is less then specified
number – allows to delete all tie points on a stereopair, acquired during operation of
automatic measurement of points coordinates, if after their filtering their number is
not sufficient to perform correct relative orientation;

• Deletemeasurements on non-adjacent images allows to filter potentially erroneous
points, measured on non-adjacent images inside a strip;

To measure tie points for UAS images in two steps it is recommended to set the Delete
measurements on non-adjacent images checkbox on the first step and to not to use this
parameter on the second step.
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• Delete single points allows to reject points measured on single images;

• Delete points with correlation below threshold allows to delete points previously
measured using correlator, if their correlation coefficient in below threshold value
specified in theCorrelation threshold field of the Automatic tie point measurement
window;

It is recommended to use the option for recurrent or final points filtration, since the filtering
covers all measured points, not only new ones, added during just another start of automatic
tie points measurement operation.

• Delete points surplus allows to delete points, if their number exceeds number spe-
cified in the Points per stereopair field of the Automatic tie point measurement
window, sorted by the Y-parallax in descending order;

The parameter considers whether the Filter points by zones checkbox is marked, that allows
to delete points evenly. It is recommended to use the option after the initial tie points meas-
urement on UAS images.

The points are deleted regardless of type and number of measurements per point (the system
may delete both GC point and the points in triple overlap).

• Check correlation of measurements transferred from other stereopairs is used
to check on each stereopair correlation coefficient of measurements, collected during
points transfer from other stereopairs, since the chain of such transfers may lead to
errors accumulation and bring unacceptable result;

• X-parallax clipping (%) allows to specify number of points with minimal and maximal
x-parallax (relatively to total amount of points) which will be deleted after filtering in
strip and between strips.

It is recommended to apply this rejection method if erroneous points are dispersed clearly
along stereopair basis (if, for example, a highway with bright marking goes in parallel to survey
basis and correlator puts points on marking line elements, which do not correspond with each
other.

• Check by reverse stereopair –allows to check the search results on reverse stereo-
pair; if the results are not equal, point deletes;
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Fig. 70. Miscellaneous parameters

TheMiscellaneous tab contains sections and options to setup the following additional
parameters:

• Number automatically measured points starting with is used for automatic num-
bering of measured tie points starting with number, specified in the entry field, that
allows to distinguish these points from the ones already measured on the project
images;

Regardless of the set value, the system does not generate points with duplicate numbers. If
the point with some number already exists, then this number will be skipped when creating
new points.

• Minimum distance between points (pix) allows to specify minimal distance in pixels
between points measured on the image;

It is recommended to increase the value of this parameter, when the problems with block
adjustment occur. The parameter is considered only during measurement new points. Existing
tie points are not rejected.

• Minimal dispersion allows to specify minimal dispersion of mask to protect from
points search on the clouds and water bodies;
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The option is used to exclude points in monotonous areas, for example, for satellite scanner
images, if there are black strips on images borders, and for overexposure due to cloudiness.

• Pyramid level for preliminary search (only for central projection images) – allows
to choose an image pyramid level used to preliminary search of points. If the checkbox
is set on, preliminary search is performed by source image;

• Fixed search sequence – allows to obtain the same results of automatic measure-
ment of tie points coordinates during multiple runs of the operation with the same
initial parameters;

• The “Points per stereopair” parameter influences on the Points per stereopair
parameters located in the Automatic tie point measurement window and allows to
select the following number of points:

○ Points to add per session – values specified in the main window, that mean a
number of new points, which will be added to already measured ones;

○ Target number of points on a stereopair – values specified in the main window,
that define total points number;

The resulting number of measured points may be both greater than a predetermined amount –
due to points transfer from adjacent stereopairs, and less due to the subsequent rejection of
points. Default value is 30 points on each in-strip images pair, and 10 points – in inter-strip
overlap. The minimum number of points to control the vertical parallax residual is 6.

• parameters which allow to specify trusted points group to be used as a master sample
for points rejection (see the Preliminary filtering with detection of trusted points
group parameter on the Rejection tab). A group of points is considered as trusted
if the following two conditions are met during the points search:

1. The distance between the point on one image and the corresponding point on
another image should not exceed the parameter specified in the Maximum
spread radius within trusted points group input field.

2. Number of points found, which satisfy to the first condition should not be less
than the parameter specified in the Minimum trusted points group size input
field.

If a trusted group has been found, it supposedly means that angles of relative orient-
ation have been computed correctly and the points rejection can be performed using
these data. Otherwise, the rejection of points will not be executed, even if the Prelim-
inary filtering with detection of trusted points group checkbox is set on the Re-
jection tab.
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TheMaximumpoints to use filtering by trusted group parameter is used to specify
the limitation on the number of points to reject.

It is recommended to set theMaximum points to use filtering by trusted group value from
40 to 60. It is not recommended to set more than 60 points.

The Stereopairs section contains the following parameters:

• Create stereopairs based on exterior orientation data, from images, projection
centers of which are within range of – if this option is checked, the stereopairs will
be composed from images, projection centers of which are located at the distance
no more than a specified value (in meters), otherwise, the stereopairs are composed
from nearest images in a strip.

• From different strips only – if this option is checked, the in-strip stereopairs will not
be considered. Otherwise, all in-strip stereopairs will be considered, including the
nonadjacent.

Fig. 71. Miscellaneous parameters

The Zones section allows to define a zone size on a stereopair, where the system
performs automatic search and measurement of tie points coordinates. Information
about recommended zones is located in the Section 4.1.
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The Points transfer section contains the following parameters:

• Strict limits for initial point position – if the checkbox is set, the system performs
search for a point only inside of image, otherwise, the search is possible out of the
image boundary, if the Search area parameter value on the Search for points tab
exceeds the image size.

• Tie points, measured manually – allows to transfer and filter tie points, measured
manually.

If checkboxes for filter are set on, but checkboxes for transfer are set off, filter does not per-
form, because there is no transfered points.

• GC points, measuredmanually – allows to transfer and filterGC points, measured
manually.

If checkboxes for filter are set on, but checkboxes for transfer are set off, filter does not per-
form, because there is no transfered points.

• GC points, measured automatically – allows to transfer and filter GC points,
measured automatically.

If checkboxes for filter are set on, but checkboxes for transfer are set off, filter does not per-
form, because there is no transfered points.

The Rejection by angles section allows to specify parameters of measured points fil-
tering by single or multiple relative orientation parameters of the right or left image.

In some cases after automatic measurement of tie points coordinates due to erroneous
points the images are rotated in a block and their relative orientation parameters are
calculated incorrectly. To prevent images rotation the filtering of measured tie points
by the values of the rotation angle is used. To do this it is necessary to change angles
threshold value (in degrees) for each of stereopair elements. As a result, the points
which cause exceeding of angles thresholds will be rejected after relative orientation
recalculation.

It is not recommended to use this method of rejection for blocks, in which the images can actually
be rotated in relation to each other, since in this case the likelihood of removing properly placed
tie points increases.

4.7.2. Feature-based correlator

This function is not available for the satellite scanner imagery or ADS projects.
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Automatic measurement of tie points coordinates

To measure tie points coordinates in automatic mode perform the following actions:

1. ChooseOrientation › Automatic tie pointmeasurement › Aerial survey (Feature-
based correlator). Automatic tie points measurement window opens.

For automatic measurements all images are selected by default. For tie points search just
on selected images clear the checkbox Select all images for automatic tie point meas-
urement on the Orientation tab of the Parameters window.

2. Use default setting of measurement parameters (presets) or set manually the main
parameters for tie points search, measure and filter.

3. [optional] Specify the adjustment parameters, if it is necessary to perform the ad-
justment on the current project step, otherwise – clear theMake block adjustment
checkbox..

4. [optional] In order to use distributed processing during measurement of tie points
coordinates, perform the following actions:

1. Change settings and run the distributed processing server/client (see the “Dis-
tributed processing” chapter in the “General information about system” User
Manual).

2. Click the Distributed processing... button. The Distributed processing set-
tings window opens.

Specify the Maximum number of parallel tasks value is displayed in the
window. This parameter shows howmany processing tasks is possible to divide
the current project to.

In case the workstation processor supports the hyperthreading technology, it is recom-
mended to reduce themaximum number of parallel tasks by half in order to ensure
system’s stability.

Hyper-threading (hyper-threading technology) is simultaneous multithreading imple-
mentation used to improve parallelization of computations. With HTT, one physical
core appears as two processors to the operating system, allowing concurrent
scheduling of two processes per core.

Fig. 72. Parameters of distributed measurement of tie points in automatic mode
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3. The system allows to clear the task list step by step in the distributed pro-
cessing monitor (tasks are removed from the list as they are successfully
completed).

Clearing the task list makes it possible to limit the increasing size of the distrib-
uted processing database, what can significantly affect system performance.

It is strongly suggested to clear the task list when processing large amounts of
data on workstations with limited disk space.

Full display of the task list (for further analysis of their logs) may be feasible
when restarting calculations, if the previous data processing session failed.

4. Click OK to go back to previous window.

The Progress bar remains open during the entire operation running, allowing the user
to directly monitor the progress of data processing from the PHOTOMOD interface
without opening the Monitor for distributed processing (see “Progress bar for dis-
tributed processing” in the “General information” User Manual).

5. Click the OK button in the Automatic tie points measurement window to start
operation of automatic measurement of points coordinates.

6. The block processing report opens automatically after the operation is completed,
if the adjustment was also carried out (see the Make block adjustment checkbox
below).

Main parameters of tie points measurement

The Automatic tie points measurement window allows to use parameters presets of
tie points measurement, or to manually choose the optimal combination of basic and
additional parameters for automatic tie points search, measurement and filtering.

Choose Orientation › Automatic tie point measurement › Aerial survey (Feature-
based correlator). Automatic tie points measurement window opens.
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Fig. 73. The Automatic tie points measurement window

The Automatic tie points measurement window includes the following interface ele-
ments:

• the images selection toolbar used to open auxiliary windows, to save and load sets
of parameters;

• a list of project images allows to select images, scheduled to perform automatic
measuring of tie points coordinates;

• the Correlator configuration section is used to load, create and edit sets of para-
meters of automatic tie points measurement;

• the Ok button used to launch an operation of tie points measurement and to perform
relative orientation in automatic mode;

• the Distributed processing button is used for automatic tie points measurement in
distributed processing mode.

The system provides the following buttons in the toolbar to work with auxiliary windows:
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• – allows to select stereopairs where there is no tie points coordinates measure-
ments, and their adjacent images;

• – allows to select triplets without tie points;

• – allows to select interstrip stereopairs where there is no tie points coordinates
measurements;

When searching for stereopairs and triplets, excluded ( ) points are also not taken into ac-
count. The Excluded status (in this case) is equivalent to no measurements. The user can
change the status of a point using the appropriate tools of the Triangulation points window.

To configure automatic tie points measurement and (optionally) for further adjustment
procedure the following parameters are used:

• [optional] clear the Calibrate camera checkbox if camera calibration has already
done and is not needed;

It is recommended to clear the Calibrate camera checkbox only if there is reason to trust
the camera calibration. It is necessary to consider, that if the calibration was not carried out
in actual operating conditions, then significant discrepancies in the obtained calibration
parameters may occur.

If polyplets (sets of several overlapped images located on different strips) are not found, one
of camera calibration stages (calibration by polyplets) will be skipped (an appropriate warning
message will appear). Other calibration stages will be carried out.

In certain cases, since some coefficients can be dependent, it is impossible to calculate cor-
rections to them (during camera calibration, before performing adjustment). In such cases,
some of these coefficients can be automatically excluded from the calibration process (but
not from the adjustment process) i.e. during data processing, the initial coefficient value will
be used, without introducing corrections. An appropriate info message is to be displayed in
the progress bar (see the “Loading progress window” section in the “General information”
User Manual).

• [optional] clear the Make block adjustment checkbox if the adjustment operation is
not necessary at this stage of the project;

• [optional] clear the Search on total image area checkbox, to exclude from tie point
search those areas of a block where there are no image overlap according to rough
block layout results. This will allow to increase the system speed and improve the
correlator accuracy.

This checkbox is recommended only if primary block layout was performed correctly, after
visual estimation of image positions.

In case of aerial survey data processing, primary block layout is as usual quite accurate for
imagery provided with correct elements of exterior orientation and taken with off-nadir angle
no more than 15 degrees.
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○ In order not to use boundary regions of imagery while search, set the Offset from
image boundaries, % by clicking the button. The Image margin window
opens. Set image margins in percent which are not to be involved in points search;

Fig. 74. The Image margin window

• To increase the system performance through graphic processing unit resources, set
the Use GPU checkbox and select the desired device from the drop-down list;

The intensity of GPU usage can be monitored using various free software.Windows 10 users
can monitor GPU activity through theWindows Task Manager (Performance Tab).

It is recommended to usemodern graphics adapters with at least 4-6 GB of memory, especially
in the case of parallel execution of several tasks in distributed processing mode.

It should be considered that the performance of a video adapter as an extra device for com-
putations is not directly dependent on its memory amount but is influenced by the algorithms
used and features of the system architecture.If there is a choice, first of all, NVidia video ad-
apters are preferable.

During distributed processing, video adapters are to be selected in theMonitor for Distributed
Processing window, individually for each computer used as a distributed processing client
(see “Computers” in the “General information” User Manual. However, video adapters’ re-
sources will be used for distributed computations only if the Use GPU checkbox is set in the
current window.

If the computer used to configure the operation options (server) is also used as one of the
clients, the selection of the video adapter used by it is also carried out through the Monitor
for Distributed Processing, regardless of which device was selected in the drop-down list
in the current window (this choice is taken into account only in the case of standard data
processing mode).

The Correlator configuration section is used to load, create and edit presets – sets
of parameters of automatic tie points measurement;
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• the download button in the right part of the Correlator configuration section allows
to open the Correlator precision window, which contains a list of available (both
predefined and user-created) presets and the following buttons:

Fig. 75. The Correlator precision window

○ Create – allows to create a custom preset – set of parameters of automatic tie
points measurement. Click the Create button to open the Enter entry window,
where user should enter a name for a preset to be created (default user preset).

Fig. 76. The Enter entry window

It is not allowed to create presets with identical names. When you try to create presets
with identical names, the system opens a window with a corresponding error message.

Clicking the OK button opens the Edit parameters window, where you should
manually specify the following parameters:
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Fig. 77. The Edit parameters window

■ Starting pyramid level – it is recommended to increase the value of starting
pyramid level when system performance is insufficient, and when there is no
high requirements to processing results accuracy. Recommended value of
starting pyramid level is 1. The value of the starting pyramid level that equals to
zero provides maximum accuracy of the results, but leads to increasing of data
processing time;

In order to perform the automatic detection of pyramid levels – set the appropriate
checkbox.

■ Ending pyramid level – it is recommended to increase the value of ending
pyramid level when using data with different resolution (including cases of signi-
ficant difference in spatial resolution within one image);

For example, when using data which resolution varies 2 times, it is recommended to
increase the default value of the ending level of the pyramid on the one.

■ Maximum vertical parallax (in pixels or mm) – threshold value for rejection
executed after points measuring/transfer. On each step of rejection process, the
program searches for the point with maximal Y-parallax on the stereopair and
rejects it. After that, it makes relative orientation once more and the iteration is
executed until maximal Y-parallax exceeds the parameter specified here, or until
6 points or less remain on stereopair. Recommended value is a pixel size;
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■ Points per stereopair – allows to specify a number of points to be measured
on in-strip and inter-strip stereopairs;

The resulting number of measured points may be both greater than a predetermined
amount – due to points transfer from adjacent stereopairs, and less due to the sub-
sequent rejection of points. Default value is 30 points on each in-strip images pair, and
10 points – in inter-strip overlap. The minimum number of points to control the vertical
parallax residual is 6.

■ Minimal correct matching points in pair, in percent allows to exclude from the
processing “bad” stereopairs that do not match the given values. The increase
of this parameter can improve the system performance by excluding a portion
of data from the processing;

Default value of this parameter is 30%.

When the default value increase, an approximate estimation of the system speed change
is displayed – faster than 30% in ... times.

When the default value decrease, an approximate estimation of the system speed
change is displayed – slower than 30% in ... times.

■ Set the Filter non-transferred points checkbox on to reject points located on
inter-strip stereopairs. A point will be filtered, if the system recognizes it on a
single image of some strip.

Set the image pair selection method:

■ [optional] by block scheme;

The Low block layout quality checkbox allows to divide the process of stereopair
search by block scheme into several iterations, thereby increasing the accuracy of final
results.

■ [optional] by image centers – set the number of neighbour images andmin-
imum distance between centers in stereopair.

In case of the processing of quite high-quality data with satisfactory overlap, limiting
the number of adjacent images leads to a significant increase of data processing speed,
without affecting the accuracy of the final results.

Limiting the minimum distance between two centers in a stereopair allows to exclude
from processing stereopairs with projection centers that are too close to each other.

When you click OK, the system creates a new user preset – a set of parameters
used for automatic tie points measurement.
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○ the Edit button allows to open the Edit parameters window to change settings of
the selected preset.

○ the Copy button allows to copy a preset.

○ the Rename button allows to rename a preset.

○ the Delete button allows to delete a preset.

○ the Close button allows to close the Correlator precision window.

• The arrow to the left of the button which opens the Correlator precision window al-
lows to open a drop-down list, used to select one of the following presets.

The system provides a set of predefined presets, allowing to vary the settings of
automatic tie point measurements. Predefined presets are marked by the asterisk
symbol “*” – Optimal, Optimal 2, Multitime survey, Nadir-oblique camera, Exact
and PHOTOMOD 6.5 correlator settings.

The system does not allow the user to edit the predefined presets. A copy of the predefined
preset is available for editing, as well as a custom preset.

4.7.3. UAS

This function is not available for the satellite scanner imagery or ADS projects.

Automatic measurement of tie points coordinates

To measure tie points coordinates in automatic mode perform the following actions:

1. Choose Orientation › Automatic tie point measurement › UAS. The Automatic
tie points measurement window opens.

For automatic measurements all images are selected by default. For tie points search just
on selected images clear the checkbox Select all images for automatic tie point meas-
urement on the Orientation tab of the Parameters window.

2. Use default settings of measurement parameters (presets) or set manually the main
parameters for tie points search, measure and filter.

3. [optional] Specify the adjustment parameters, if it is necessary to perform the ad-
justment on the current project step, otherwise – clear theMake block adjustment
checkbox.

4. [optional] In order to use distributed processing during measurement of tie points
coordinates, perform the following actions:
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1. Change settings and run the distributed processing server/client (see the “Dis-
tributed processing” chapter in the “General information about system” User
Manual).

2. Click the Distributed processing... button. The Distributed processing set-
tings window opens.

Specify the Maximum number of parallel tasks value is displayed in the
window. This parameter shows howmany processing tasks is possible to divide
the current project to.

In case the workstation processor supports the hyperthreading technology, it is recom-
mended to reduce themaximum number of parallel tasks by half in order to ensure
system’s stability.

Hyper-threading (hyper-threading technology) is simultaneous multithreading imple-
mentation used to improve parallelization of computations. With HTT, one physical
core appears as two processors to the operating system, allowing concurrent
scheduling of two processes per core.

Fig. 78. Parameters of distributed measurement of tie points in automatic mode

3. The system allows to clear the task list step by step in the distributed pro-
cessing monitor (tasks are removed from the list as they are successfully
completed).

Clearing the task list makes it possible to limit the increasing size of the distrib-
uted processing database, what can significantly affect system performance.

It is strongly suggested to clear the task list when processing large amounts of
data on workstations with limited disk space.

Full display of the task list (for further analysis of their logs) may be feasible
when restarting calculations, if the previous data processing session failed.

4. Click OK to go back to previous window.

The Progress bar remains open during the entire operation running, allowing the user
to directly monitor the progress of data processing from the PHOTOMOD interface
without opening the Monitor for distributed processing (see “Progress bar for dis-
tributed processing” in the “General information” User Manual).
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5. Click the OK button in the Automatic tie points measurement window to start
operation of automatic measurement of points coordinates.

6. The block processing report opens automatically after the operation is completed,
if the adjustment was also carried out (see the Make block adjustment checkbox
below).

Main parameters of automatic tie points measurement

The Automatic tie point measurement window allows to use parameters presets of
tie points measurement, or to manually choose the optimal combination of basic and
additional parameters for automatic tie points search, measurement and filtering.

Choose Orientation › Automatic tie point measurement › UAS. The Automatic tie
points measurement window opens.

Fig. 79. The Automatic tie points measurement window

The Automatic tie points measurement window includes the following interface ele-
ments:

• the images selection toolbar used to open auxiliary windows, to save and load sets
of parameters;
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• a list of project images allows to select images, scheduled to perform automatic
measuring of tie points coordinates;

• the Correlator configuration section is used to load, create and edit sets of para-
meters of automatic tie points measurement;

• the OK button used to launch an operation of tie points measurement and to perform
relative orientation in automatic mode;

• the Distributed processing button is used for automatic tie points measurement in
distributed processing mode.

The system provides the following buttons in the toolbar to work with auxiliary windows:

• – allows to select stereopairs where there is no tie points coordinates measure-
ments, and their adjacent images;

• – allows to select triplets without tie points;

• – allows to select interstrip stereopairs where there is no tie points coordinates
measurements;

When searching for stereopairs and triplets, excluded ( ) points are also not taken into ac-
count. The Excluded status (in this case) is equivalent to no measurements. The user can
change the status of a point using the appropriate tools of the Triangulation points window.

To configure automatic tie points measurement and (optionally) for further adjustment
procedure the following parameters are used:

• [optional] clear the Calibrate camera checkbox if camera calibration has already
done and is not needed;

It is recommended to clear the Calibrate camera checkbox only if there is reason to trust
the camera calibration. It is necessary to consider, that if the calibration was not carried out
in actual operating conditions, then significant discrepancies in the obtained calibration
parameters may occur.

If polyplets (sets of several overlapped images located on different strips) are not found, one
of camera calibration stages (calibration by polyplets) will be skipped (an appropriate warning
message will appear). Other calibration stages will be carried out.

In certain cases, since some coefficients can be dependent, it is impossible to calculate cor-
rections to them (during camera calibration, before performing adjustment). In such cases,
some of these coefficients can be automatically excluded from the calibration process (but
not from the adjustment process) i.e. during data processing, the initial coefficient value will
be used, without introducing corrections. An appropriate info message is to be displayed in
the progress bar (see the “Loading progress window” section in the “General information”
User Manual).
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• [optional] clear the Make block adjustment checkbox if the adjustment operation is
not necessary at this stage of the project;

• [optional] clear the Search on total image area checkbox, to exclude from tie point
search those areas of a block where there are no image overlap according to rough
block layout results. This will allow to increase the system speed and improve the
correlator accuracy.

This checkbox is recommended only if primary block layout was performed correctly, after
visual estimation of image positions.

In case of aerial survey data processing, primary block layout is as usual quite accurate for
imagery provided with correct elements of exterior orientation and taken with off-nadir angle
no more than 15 degrees.

○ In order not to use boundary regions of imagery while search, set the Offset from
image boundaries, % by clicking the button. The Image margin window
opens. Set image margins in percent which are not to be involved in points search;

Fig. 80. The Image margin window

• To increase the system performance through graphic processing unit resources, set
the Use GPU checkbox and select the desired device from the drop-down list;

The intensity of GPU usage can be monitored using various free software.Windows 10 users
can monitor GPU activity through theWindows Task Manager (Performance Tab).

It is recommended to usemodern graphics adapters with at least 4-6 GB of memory, especially
in the case of parallel execution of several tasks in distributed processing mode.

It should be considered that the performance of a video adapter as an extra device for com-
putations is not directly dependent on its memory amount but is influenced by the algorithms
used and features of the system architecture.If there is a choice, first of all, NVidia video ad-
apters are preferable.

During distributed processing, video adapters are to be selected in theMonitor for Distributed
Processing window, individually for each computer used as a distributed processing client
(see “Computers” in the “General information” User Manual. However, video adapters’ re-
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sources will be used for distributed computations only if the Use GPU checkbox is set in the
current window.

If the computer used to configure the operation options (server) is also used as one of the
clients, the selection of the video adapter used by it is also carried out through the Monitor
for Distributed Processing, regardless of which device was selected in the drop-down list
in the current window (this choice is taken into account only in the case of standard data
processing mode).

The Correlator configuration section is used to load, create and edit presets – set of
parameters of automatic tie points measurement;

• the download button in the right part of the Correlator configuration section allows
to open the Correlator precision window, which contains a list of available (both
predefined and user-created) presets and the following buttons:

Fig. 81. The Correlator precision window

○ Create – allows to create a custom preset – set of parameters of automatic tie
points measurement. Click the Create button to open the Enter entry window,
where user should enter a name for a preset to be created (default user preset).

Fig. 82. The Enter entry window

It is not allowed to create presets with identical names. When you try to create presets
with identical names, the system opens a window with a corresponding error message.

Clicking the OK button opens the Edit parameters window, where you should
manually specify the following parameters:
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Fig. 83. The Edit parameters window

■ Starting pyramid level – it is recommended to increase the value of starting
pyramid level when system performance is insufficient, and when there is no
high requirements to processing results accuracy. Recommended value of
starting pyramid level is 1. The value of the starting pyramid level that equals to
zero provides maximum accuracy of the results, but leads to increasing of data
processing time;

■ Ending pyramid level – it is recommended to increase the value of ending
pyramid level when using data with different resolution (including cases of signi-
ficant difference in spatial resolution within one image);

For example, when using data which resolution varies 2 times, it is recommended to
increase the default value of the ending level of the pyramid on the one.

■ Maximum vertical parallax (in pixels or mm) – threshold value for rejection
executed after points measuring/transfer. On each step of rejection process, the
program searches for the point with maximal Y-parallax on the stereopair and
rejects it. After that, it makes relative orientation once more and the iteration is
executed until maximal Y-parallax exceeds the parameter specified here, or until
6 points or less remain on stereopair. Recommended value is a pixel size;

■ Points per stereopair – allows to specify a number of points to be measured
on in-strip and inter-strip stereopairs;

The resulting number of measured points may be both greater than a predetermined
amount – due to points transfer from adjacent stereopairs, and less due to the sub-
sequent rejection of points. Default value is 30 points on each in-strip images pair, and
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10 points – in inter-strip overlap. The minimum number of points to control the vertical
parallax residual is 6.

■ Minimal correct matching points in pair, in percent allows to exclude from the
processing “bad” stereopairs that do not match the given values. The increase
of this parameter can improve the system performance by excluding a portion
of data from the processing;

Default value of this parameter is 30%.

When the default value increase, an approximate estimation of the system speed change
is displayed – faster than 30% in ... times.

When the default value decrease, an approximate estimation of the system speed
change is displayed – slower than 30% in ... times.

■ Set the Filter non-transferred points checkbox on to reject points located on
inter-strip stereopairs. A point will be filtered, if the system recognizes it on a
single image of some strip.

Set the image pair selection method:

■ [optional] by block scheme;

The Low block layout quality checkbox allows to divide the process of stereopair
search by block scheme into several iterations, thereby increasing the accuracy of final
results.

■ [optional] by image centers – set the number of neighbour images andmin-
imum distance between centers in stereopair.

In case of the processing of quite high-quality data with satisfactory overlap, limiting
the number of adjacent images leads to a significant increase of data processing speed,
without affecting the accuracy of the final results.

Limiting the minimum distance between two centers in a stereopair allows to exclude
from processing stereopairs with projection centers that are too close to each other.

When you click OK, the system creates a new user preset – a set of parameters
used for automatic tie points measurement.

○ the Edit button allows to open the Edit parameters window to change settings of
the selected preset.

○ the Copy button allows to copy a preset.
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○ the Rename button allows to rename a preset.

○ the Delete button allows to delete a preset.

○ the Close button allows to close the Correlator precision window.

• The arrow to the left of the button which opens the Correlator precision window al-
lows to open a drop-down list, used to select one of the following presets.

The system provides a set of predefined presets, allowing to vary the settings of
automatic tie point measurements. Predefined presets are marked by the asterisk
symbol “*” – Optimal, Optimal 2, Multitime survey, Nadir-oblique camera, Exact
and PHOTOMOD 6.5 correlator settings.

The system does not allow the user to edit the predefined presets. A copy of the predefined
preset is available for editing, as well as a custom preset.

4.8. Relative orientation report

4.8.1. Report parameters and output

The system allows to view the results of relative orientation operation after measurement
of tie points coordinates. To view and analyze the data, and control accuracy of relative
orientation the system allows to generate a report, that is formed considering specified
parameters of accuracy control, residuals threshold and data output format.

Relative orientation and accuracy control includes the following steps:

• accuracy control for measurements on stereopairs using residual vertical parallaxes;

• accuracy control for measurements in triple overlap zones using discrepancies in tie
points measurements taken on two adjacent stereopairs (models);

• control of tie points number and uniformity of their distribution on stereopairs and in
triplets;

• control of difference between kappa angle and a block scheme.

It is possible to view the relative orientation report in the Automatic tie point meas-
urement , Triangulation points windows, and in the Points measurement module
after clicking the button. Prior to the report appearing the Relative orientation report
settings window opens.

When the report is opened from the Points measurementmodule, theRelative orient-
ation report settings window is not opened, and the report is shown only for images
opened in the module considering previously set or default parameters. To view and
edit the parameters it is possible to use the link in the report window [Report parameters].
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In order to open the relative orientation report perform the following actions:

1. Choose Orientation › Relative orientation report or click the button in the
toolbar of the Triangulation window. The Relative orientation report settings
window opens. It is used to specify parameters of accuracy control and format of
output results of relative orientation in report.

Fig. 84. Parameters of relative orientation report

2. Select the Main parameters tab (it is selected by default).

3. In the Show report section specify block images to be included to relative orientation
report:

• to view a general report for the whole images block select the for all images
option;

• to view a report for selected images select the for selected images option;

• to view a report for selected and their adjacent images select the for selected
images option and set the add adjacent images checkbox.
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4. In the Stereopairs section specify the following parameters of accuracy control for
points measurements on block stereopairs:

• to check measurements for vertical parallax error select the Check vertical
parallax checkbox and input acceptable threshold value (in pixels or mm) for
selected error type (RMS, mean or maximal error);

It is recommended to set the threshold value of maximal error equal to the pixel size.

• to check discrepancy of kappa angle from block layout set theCheck discrepancy
of kappa angle from block layout checkbox and specify a threshold value of
angles discrepancy in degrees;

It is recommended to specify Angle discrepancy threshold values from 30 to 45 de-
grees.

• to check stereopairs for sufficient measurements number set theCheck number
of tie points checkbox and specify minimal number of tie points per stereopair;

It is recommended to specify Minimal number value not less than 12 point per in-strip
stereopair (2 points per each of 6 standard zones) and at least 2 points per inter-strip
stereopair.

• to check distribution uniformity of tie points on stereopairs set the Check point
distribution uniformity checkbox;

There is non-uniform points distribution on a stereopair, if in each of 6 standard zones
a number of points differs more than 2 times from average amount of points in zone.

• to check number of tie points and their distribution uniformity on inter-strip stereo-
pairs set the Check errors in inter-strip stereopairs checkbox.

The checkbox is cleared by default, since an analysis of points in 6 standard zones for
inter-strip stereopair is not necessary in many cases.

5. In the Triplets section specify the following parameters of accuracy control for
points measurements in triplets:

• to check measurement errors in triplets set the Check residuals in triplets
checkbox and input threshold value by XY and by Z (in pix, mm or meters) for
selected residual type (RMS, mean or maximal error);

A threshold value for maximal error in triplets is calculated using the following formula:
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Emax ≈ 2 Emean , where Emean – mean error threshold.

Mean triplet errors in XY plane is calculated using the following formula:

RMS ≈ 2 Emean

Mean error by Z equals the mean triplet errors value in XY plane multiplied by the ratio
of focal length (f) to survey basis (b):

Emean
z = f

b Emean
xy .

• to check triplets for sufficient number of measured tie points set the Check
number of tie points checkbox and specify minimal number of points.

It is recommended to specify a Minimal number at least 3 points per each triplet.

6. To exclude points without adjustment from the report (see the “Setup of points
symbols” chapter of the “Block adjustment” User Manual), clear the Take into ac-
count unadjusted points checkbox;

7. To use adjustment results for relative orientation control – set the appropriate
checkbox;

8. Open theAdditional tab, that includes sections used to setup data view parameters
in the report.

The Residuals format section is used to setup format of errors numeric values in
the report:

• fixed point – is used to set format of errors numeric values accurate within 3
decimal places;

• exponential – is used to set format of errors numeric values in exponential
notation, where a part of number is replaced with symbols E+n, where E (expo-
nent) means multiplying the preceding number by 10 to the power n.

The Precision section is used to setup output data accuracy, select: normal, high
or maximal.

The Angles section is used to setup angles format in the report:

• Alpha, omega, kappa – angular elements of image exterior orientation (are used
in Russian coordinate systems);

146

Aerial triangulation (Windows x64)PHOTOMOD 8.0

solver.pdf


• omega, phi, kappa – angular elements of image exterior orientation (are used
in International coordinate systems (see the “Block adjustment” User Manual)).

The Angle units section is used to setup format of angles measurements units:

• radians;

• degrees;

• gons – plane angle measure that equals to 1/100 of a right angle measure,
measurement of full rotation is 400 gons.

Fig. 85. Additional report parameters

9. Click OK. The report on relative orientation results is opened. It considers all spe-
cified main and additional parameters (see the Section 4.8.2).

4.8.2. Report view and analysis

Report on relative orientation includes results of relative orientation operation, displays
statistics of tie points measurement, and allows to reveal and eliminate errors of points
measurement. The report is generated for all or for selected project images considering
parameters specified in the Relative orientation report settings window.

A feature of relative orientation report is the ability to pass to the Points measurement module
directly from the report that allows to eliminate detected measurement errors.

It is possible to view relative orientation report from different windows of the system using the
button. The Relative orientation report settings window opens before the report displaying.

When the report is opened in the Pointsmeasurementmodule, theRelative orientation report
settings window in not opened, and the report is opened only for images opened in the module
considering preset or default parameters. To view and edit the parameters it is possible to use
the link in the report window [Report parameters].
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Fig. 86. Relative orientation report

Relative orientation report contains the following main elements and sections:

• the toolbar with buttons used to perform the following operations:

○ – allows to return to previous view of the report;

○ – allows to refresh relative orientation results in the report after editing of tie
points in the Points measurement module;

○ – allows to perform a search for information in the report;

○ – allows to save report data to files with *.htm, *.html extensions out of active
profile resources;

○ – allows to save report data to files with *.htm, *.html extensions in active
profile resources;

○ – allows to print a report.

• the links in upper part of a report:

○ jump to [in-strip measurements] – allows to view the points measurements inside
strips;
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○ jump to [inter-strip measurements] – allows to view the points measurements
between strips;

○ see also the [interior orientation report] – allows to open report on interior orientation;

○ [Back] – allows to go back to previous report view;

○ [Refresh] – allows to refresh relative orientation results in the report after tie points
editing in the Points measurement module;

○ [Report parameters] – allows to change the parameters and refresh the report;

○ [Unselect all] – allows to cancel data selection in the report;

○ [Top] – allows to go to the report top.

• the Block statistics section of a report used to view general statistics, contains the
following information:

○ a project name;

○ a total number of project strips/images;

○ a number of selected strips/images;

○ report generating date.

• the In-strip measurements section of a report used to view and analyse points
measurements inside strips, contains the following tables:

○ statistics table on in-strip measurements (strips table);

○ table of stereopairs of each strip;

○ table of triplets of each strip.

In inter-strip stereopairs and triplets tables there is a possibility to go to the Points measure-
mentmodule and open images of selected stereopair/triplet automatically, that allows to edit
points measurements there.

• the Inter-strip measurements section of a report used to view and analyse points
measurements between strips, contains the following tables:

○ statistics table on inter-strip measurements;

○ table of inter-strip stereopairs.

In inter-strip stereopairs tables there is a possibility to open selected stereopair in the Points
measurement module that allows to edit points measurements there.
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4.8.3. The in-strip measurements section

The In-strip measurements section of report is used to view points measurements
results inside a strip and contains the following data:

Fig. 87. The “In-strip measurements” section

• Table of strips(Statistics) contains measurements data inside each strip and includes
the following columns:

○ the Strips column is used to display a strip name in block;

○ the Images column is used to display names of the first and the last images in a
strip;

○ the Total column is used to display a number of stereopairs/triplets in each strip;

○ the Complete column is used to display a number of stereopairs/triplets with per-
formed relative orientation with errors within specified thresholds;

○ theResiduals column is used to display a number of stereopairs/triplets with errors
exceeding specified thresholds;

○ the Not complete column is used to display a number of stereopairs/triplets for
which relative orientation is not performed.
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Yellow color highlight is used if relative orientation inside a strip is performed with
errors.

Strips where there is no relative orientation results are highlighted by red color.

• Table of stereopairs contains points measurements data on stereopairs for each strip
and includes the following columns:

○ the first column is used for points measurements editing and allows to open the
Points measurement module with images of stereopair selected in the table;

When editing is completed and the Points measurement module is closed, click the
[Refresh] link in the report to re-calculate relative orientation and refresh the report.

○ the Stereopair column is used to display names of images of each stereopair of
a strip;

Click the stereopair link to open detailed report on measurements of selected stereopair
(see the Section 4.8.5).

○ the Number of points column is used to display a number of points measured on
a stereopair;

○ the Vertical parallax column is used to display a value of vertical parallax for all
measurements on a stereopair (RMS, mean abs. and maximal error) considering
threshold parameters, error type and measurement units specified in the Relative
orientation report settings window;

A row of stereopair with points which coordinates failed to be calculated, is highlighted by
red color, and in the Vertical parallax column the warning message “Coordinates calcu-
lation failed” is displayed with specifying Y-parallax value in brackets.

○ theDiscrepancy of kappa angle column is used to display a value of kappa angles
difference (calculated using block scheme) between images.

○ the Distribution uniformity column is used to display data about uniform or non-
uniform distribution of points on a stereopair;

A distribution of points on a stereopair is considered as non-uniform, when in any of 6
standard zones, on which images overlap area is conventionally divided, a number of
points differs more than twice from average number of points in zone.

○ the +/- buttons in the last column allow to highlight/cancel highlight of stereopair
on a block scheme in 2D-window for visual estimation of stereopair location in im-
ages block.
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A stereopair is highlighted along with adding it to already highlighted ones in 2D-window.
Cancelling of a stereopair highlighting is performed along with “subtraction” from highlighted
stereopairs.

Stereopairs with measurements errors are highlighted by yellow color, stereopairs
with unavailable relative orientation by red color.

The following errors are shown by red color (they are depending on parameters
specified in the Relative orientation report settings window):

○ number of points measured on a stereopair, below specified threshold;

○ values of vertical parallax, exceeding specified threshold;

○ non-uniformity of points distribution;

If there each standard zone contains measurements of coordinates of at least one point,
then a stereopair with measurements errors is highlighted by yellow color.

○ difference of kappa angles, that exceeds specified value.

• Table of triplets displays data on measurements in each triplet of a strip and contains
the following columns:

○ The first column is used for measurements editing and allows to open the Points
measurement module and to open automatically images of selected triplet at the
same time;

After the editing is completed and the Points measurement is closed click the [Refresh]
hyperlink in the report to re-calculate relative orientation and refresh the report.

○ the Triplet column is used to display names of images of each triplet in a strip;

After clicking the triplet link the detailed report on selected triplet measurements is opened
(see the Section 4.8.6).

○ the Number of points column is used to display number of points measured on
triplet;

○ the Tie residuals column is used to display values of tie residuals in triplet by XY
and Z (RMS, mean abs. and max error) considering parameters of threshold, error
type and measurement units specified in the Relative orientation report settings
window.

Triplet errors by ties, exceeding specified thresholds, are highlight by red color.
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4.8.4. The inter-strip measurements section

The Inter-strip measurements section of report is used to view points measurements
results inside a strip and contains the following data:

Fig. 88. The “Inter-strip measurements” section

• The inter-strip ties table (Statistics) displays a number of inter-strip stereopairs for
each pair of adjacent strips and presence of measurement errors during relative ori-
entation operation.

• The inter-strip stereopairs table contains the following columns:

○ the first column is used to edit points measurements and allows to open the Points
measurement module and to open automatically at the same time images of inter-
strip stereopair selected in the table;

After the editing is completed and the Points measurement is closed click the [Refresh]
hyperlink in the report to re-calculate relative orientation and refresh the report.

○ the Stereopair column is used to display names of images of each inter-strip ste-
reopair;

After clicking the inter-strip stereopair link the detailed report on selected stereopair
measurements is opened (see the Section 4.8.4).
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○ the Number of points column is used to display a number of points measured on
inter-strip stereopair;

○ the Vertical parallax column is used to display a value of vertical parallax for all
measurements on a inter-strip stereopair (RMS, mean abs. and maximal error)
considering threshold parameters, error type and measurement units specified in
the threshold parameters;

○ theDiscrepancy of kappa angle column is used to display a value of kappa angles
difference (calculated using block scheme) between images.

○ the Distribution uniformity column is used to display data about uniform or non-
uniform distribution of points on a inter-strip stereopair.

○ the last columns allows to highlight a stereopair (+) or cancel the highlighting of a
stereopair (-) in 2D-window that allows to estimate visually whether the stereopair
is located within images block.

A stereopair is highlighted with adding it to already highlighted ones in 2D-window. Can-
celling of a stereopair highlighting is performed along with “subtraction” from highlighted
stereopairs.

If in the Relative orientation report settings window the Check errors in interstrip
stereopairs checkbox is set, then the errors in the report are highlighted in the following
way: yellow color shows strips and stereopairs that contain points measurements ex-
ceeding threshold, and the errors values are shown by red color.

4.8.5. The stereopair measurements section

Relative orientation report provides possibility to view a detailed report on any selected
stereopair that contains data on tie points measurements, calculated relative orientation
parameters, information about kappa angles difference and uniformity of tie points dis-
tribution on a stereopair. A detailed report allows to perform control of measurement
accuracy of common points of a stereopair images by values of vertical parallax resid-
uals. To view detailed report for selected stereopair click the stereopair hyperlink in the
tables of in-strip and inter-strip stereopairs.
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Fig. 89. Detailed report for selected stereopair

Detailed report on selected stereopair includes the following data:

• hyperlinks of detailed report:

○ [Relative orientation report] – the link is used to return to the first page of the
common report on in-strip and inter-strip measurements;

○ [Back] – the link is used to return to previous view of detailed report on stereopair
measurements;

○ [Refresh] – the link is used to refresh relative orientation results in the report after
editing of tie points in the Points measurement module;

○ [Report parameters] – the link is used to change the report parameters and to re-
fresh the report;

○ [Edit] – the link is used to view and edit measurements on a stereopair in the
Points measurement module;

○ [Select stereopairs] – allows to select a stereopair on a block scheme in 2D-window;
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○ [Unselect stereopairs] – allows to unselect a stereopair on a block scheme in 2D-
window;

○ [Unselect all] – allows to unselect all previously selected stereopairs.

• information about number of measured tie points on a stereopair;

• the Vertical parallax table contains the following columns:

○ the first column is used to edit selected tie point and allows to open the Points
measurement module and to open at the same time images of the stereopair
automatically and place marker on selected point;

After the point editing is completed and the Points measurement module is closed click
the [Refresh] hyperlink in the report to re-calculate relative orientation and refresh the report.

○ the Point column displays names of tie points;

○ the Number of points column is used to display a number of points measured on
inter-strip stereopair;

○ the Image ... (left) column displays a value of vertical parallax residual on the left
image of stereopair (in mm and pix);

○ the Image ... (right) column displays a value of vertical parallax residual on the
right image of stereopair (in mm and pix).

In the threshold row the threshold for vertical parallax residual is displayed in accord-
ance with specified value, measurements units and residual type (RMS, Mean abs.
and max error) of the Vertical parallax threshold parameter in the Relative orient-
ation report settings window.

At the bottom of the table there are final values of vertical parallax residual on all
measurements of the stereopair (RMS, Mean abs. and max error). The system per-
forms control of threshold exceeding only for error type specified in the Relative
orientation report settings window.

Values of vertical parallax residuals exceeding specified threshold, are highlight by
red color.

• theRelative orientation parameters table contains values of calculated relative orient-
ation angles for the left and right images according to selected angular system and
measured units on the Additional tab in the Relative orientation report settings
window;

• theOrientation 2D (by block scheme) andDiscrepancy of kappa angles tables contain
values of kappa angles;
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Accuracy control of kappa angles discrepancy between images is performed if in theRelative
orientation report settings window the appropriate checkbox is set and a threshold value
for kappa angles discrepancy is specified.

• the Distribution uniformity tables contain information about uniformity of points distri-
bution over standard zones. To estimate the parameter the system analyses a differ-
ence of points number in each of 6 standard zones.

Control of points number and uniformity of their distribution on stereopair’s zones is performed
if corresponding parameters are specified in theRelative orientation report settingswindow.

4.8.6. The triplet measurements section

Relative orientation report provides possibility to view a detailed report on selected
triplet. A detailed report for a triplet is used to view and perform accuracy control of
measurements in triplet by tie points errors. In order to view a detailed report on selected
triplet click the triplet link in the triplets table of the Inter-strip measurements section
of the report (see the Section 4.8.3).

Fig. 90. Detailed report for selected triplet
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Detailed report on selected triplet includes the following data:

• hyperlinks of detailed report:

○ [Relative orientation report] – the link is used to return to the first page of common
report on relative orientation;

○ [Back] – the link is used to return to previous view of detailed report on measure-
ments in triplet;

○ [Refresh] – the link is used to refresh relative orientation results in the report after
tie points editing in the Points measurement module;

○ [Report parameters] – the link is used to change the report parameters and to re-
fresh the report;

○ [Edit] – the link is used to view and edit a triplet measurements in the Points
measurement module;

○ [Stereopairs] – two links used to proceed to detailed measurements report of points
on stereopairs, that form the triplet (see the Section 4.8.5).

• information about number of measured tie points in a triplet;

• the Tie residuals table contain the following columns:

○ the first column is used to edit selected tie point and allows to open the Points
measurement module and to open automatically at the same time triplet images
and to place marker on selected point;

After the point editing is completed and the Points measurement module is closed click
the [Refresh] hyperlink in the report to re-calculate relative orientation and refresh the report.

○ the Point column is used to display a tie point name;

○ the Ex, Ey, Ez, Exy columns – tie residuals by X, Y, Z axes and tie residual by
(XY) in measurement units specified for residuals control in triplet in the Relative
orientation report settings window.

In the threshold row there is a triplet residual threshold according to specified value,
measurement units and error type (RMS, Mean abs. and max error) of the Triplet
residuals threshold parameter in theRelative orientation report settings window.

At the bottom of the table final values of tie residuals on all triplet measurements are
shown (RMS, Mean abs. and max error). Accuracy control is performed only for the
residual type that is specified for the Triplet residuals threshold parameter in the
Relative orientation report settings window.
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Values of tie errors that exceed specified threshold are highlighted by red color.

4.9. Relative orientation control

4.9.1. Control of points recognition correctness

In order to perform aerial triangulation it is necessary to measure on stereopairs tie
points coordinates, that are needed for buildingmodels by stereopairs formed by adjacent
images of a strip, and for joining images into strips and blocks networks.

If tie points weremeasured automatically, some of interstrip points, measured in shadows
or on trees may be a source of errors.

Time between shooting of two adjacent images is usually small enough and object
shadow does not shift on significant distance.

When surveying two different strips the time difference often allows the shadow to move
on distance that is close to required accuracy of adjustment. It causes systematic shift
of strips relatively to each other. At that it will result in systematic error on projection
centers, and a random error on GCP.

Trees shadows and heads position may be changed due to wind. In this case, the error
is random or systematic within small area. During automatic filtering it is impossible to
detect error of points measurements.

In the case when tie points are measured automatically, some of points measured on
borders of extended objects also may be reason of errors. In this case there is possib-
ility of big correlation coefficient on such points, however, measurement accuracy of
points located along extended objects borders is small enough due to homogeneity of
this object. At the same time accuracy of points measurements in direction perpendic-
ular to to the object border is high. During automatic filtering it is impossible to detect
error of points measurements.

After points filtering it is necessary to perform control of points recognition correctness on ste-
reopairs and triplets.

4.9.2. Control of uniform distribution of points measurements on ste-
reopairs

For relative orientation it is necessary to measure not less than 5 tie points on each
stereopair, each 3 of them should not be on the same line.

In order to increase adjustment accuracy it is recommended to measure more than 6
points on each stereopair.

It is also recommended to avoid situations when there are many points in some small
part relatively to the rest area of stereopair. It is better to either thin out these points or

159

Aerial triangulation (Windows x64)PHOTOMOD 8.0



add more points on the rest of stereopair area to distribute the points over stereopair
uniformly.

When measuring points along man-made extended objects: roads, power lines, etc., group of
points measured along straight line, is equal to only two points on this line during relative orient-
ation calculation.

4.9.3. Control of vertical parallax residuals on stereopairs

To perform aerial triangulation beside to measure of tie points coordinates it is also
necessary to calculate differences of tie points coordinates on both images of a stereo-
pair.

Difference of points coordinates on two images is called parallax. Vertical parallax is difference
of Y-coordinates, horizontal parallax is difference of X-coordinates of points on images that
compose a stereopair.

In some cases, errors of points’ recognition may not result in big vertical parallax resid-
uals, but cause wrong angles of relative orientation (for example, when kappa angle is
more than 45 degrees).

4.10. Adjustment control in triplets

4.10.1. Control of uniform distribution of points measurements in
triplets

For correct triplets creation it is necessary to measure not less than 2 points with distance
between not less than 1/3 of image width.

It is recommended to measure not less than 1 point in each of 3 zones: central and 2
outermost.

If it is impossible to measure more than 1 point in each of 3 zones (for example, if water
body covers more than a half of strip width) use bundle adjustment. During this operation
it is necessary to measure more tie points during relative orientation and in interstrip
ties. In areas where there is no images overlap but it is necessary to provide high ac-
curacy it is recommended to use “not-transferred” points as well.

“Not-transferred” point – points which coordinates are measured only on a single image in one
strip (it is not measured in overlap of adjacent images in a strip).

4.10.2. Errors control in triplets

During errors control you should consider that height errors in triplets are bigger on
average than plane errors. A coefficient is equal to survey height/basis ratio.

Too big height errors in triplets are usually caused by the following reasons:
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• wrong points measurement;

• interior orientation errors;

• blunders in focus length;

• blunders in distortion input.

If it is impossible to reduce height errors by control of wrong points measurement, it is
recommended to check accuracy of images relative orientation.

If the strip is drifted too much in height, it is recommended to check camera parameters
(distortion).

The system does not provide errors control in triplets, for this strip adjustment is used
(one of a block strips) by independent strips method in free model. In this case each
strip is adjusted individually with subblock selection.

4.11. Subblock analysis

The system provides for checking blocks of images within central projection projects
for subblocks, i.e. groups of images isolated for some reason. The analysis takes into
account the coverage of block images by triangulation points, and, optionally, the results
of adjustment. Subblocks may indicate, for example, insufficient georeferenced data or
insufficient coverage of block images with triangulation points.

Such situations can arise not only due to operator’s errors, but also due to objective
reasons, in particular, due to the presence of water surfaces in the area covered by the
images of the project under processing.

A subblock analysis can be useful both during the preparation to adjustment and after
it when analyzing and correcting errors, i.e. additional measuring tie and ground control
points, excluding some subblocks from the adjustment, ore excluding some images
from the project under processing.

To check subblocks, choose Orientation › Subblock analysis. When this operation
is complete, the Subblock analysis window opens:
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Fig. 91. The Subblock analysis window

The window contains the following instruments for image selection:

• – allows to select all images in the list;

• – allows to deselect all images in the list;

• – allows to inverts images selection;

• – allows to select highlighted images;

• – allows to unselect highlighted images;

• – allows to select the images that are highlighted on block scheme in 2D window;

• – allows to highlight on block scheme in 2D window the images selected in the
list.

By default, the window displays the results of analysis by triangulation points. In order
to display the results of subblock analysis taking into account the adjustment results,
set theUse bundle adjustment results checkbox. The difference in the analysis results
before and after adjustment may indicate the presence of errors.
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5. Images exterior orientation
Aerial triangulation workflow provides for defining parameters of block exterior orientation
after images relative orientation.

Exterior orientation parameters of image are geometric parameters of image, that specify
its position and orientation in relation to object of photogrammetric survey in a moment
of the survey. There are linear and angular exterior orientation parameters of image.

Linear exterior orientation parameters of image – coordinates of center of optical image
projection in coordinate system of photogrammetric survey object.

Angular exterior orientation parameters of image – parameters that define image angular
orientation in coordinate system of photogrammetric survey object, slope and rotation
angles of image.

An exterior orientation of block images implies the following actions:

• [optional] Input of ground control points (GCP) coordinates to catalogue and meas-
urement of these points coordinates images;

• [optional] Import and usage of preliminary exterior orientation data, obtained with input
images.

When accurate enough exterior orientation parameters of block images are available,
it is possible to skip steps of GCP and tie coordinates measurement, as well as block
adjustment step from the workflow and proceed right away to steps of stereovectorization,
DEM and orthomosaic generation (see how to estimate accuracy of imported exterior
orientation parameters in Section 7.5.4). Otherwise, if there are inaccurate exterior ori-
entation parameters of block images, imported exterior orientation parameters are used
to block scheme refinement (see above).

5.1. List of exterior orientation parameters

The exterior orientation parameters are projection centers coordinates of each block
image, 3 angles (omega, phi, kappa), as well as survey time. All the above parameters
describe image position in space.

In order to view, import, input or edit exterior orientation parameters chooseOrientation ›
Exterior orientation data list or click the button of the main toolbar of the system
or of the AT additional toolbar.

The Exterior orientation parameters window opens, which contains a table (list) of
exterior orientation parameters and its toolbar.

Use the Ctrl+mouse wheel to quickly scroll through the list (аналогично полосам прокрутки
окна). To navigate through the rows rotate the mouse wheel.
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Fig. 92. List of exterior orientation parameters

The list of exterior orientation parameters contains the following exterior orientation
data of project images:

• project images code and name;

• XYZ – projection center coordinates in meters;

• Omega-Phi-Kappa – angles of exterior orientation in degrees;

• survey time;

• type and RMS of projection centers coordinates and angles.

The table displays adjusted and initial values of angles and GC points coordinates.

The toolbar buttons allow to work with the table, to perform import/export of exterior
orientation parameters, to define a type of exterior orientation parameters, to exclude
coordinates, to define kappa angle, etc.

Excluded coordinates values are displayed in the table by grey color. It is possible to edit these
values, and after that the coordinates are automatically considered during adjustment.

If there are XY points or Z points with unused coordinates available, the coordinates values are
not deleted and are displayed in the table as inactive.

Points with not specified angles RMS, but at least one angle value is specified, are displayed
in the table as inactive. If both angles RMS values and angles values are not specified in the
table, then the angles are not shown in the table.
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If there are no exterior orientation parameters for some images but survey time is spe-
cified for them, the button is used to calculate missing exterior orientation parameters
for all or for selected images using linear interpolation by time.

It is recommended to calculate missing exterior orientation parameters using linear interpolation
by time for UAS images, since the time data is acquired from images containing metadata.

The system provides connection between the Exterior orientation parameterswindow
and 2D-window: images selected in 2D-window are automatically selected in the table
of the Exterior orientation parameters window. When the images are selected in the
table, they are automatically selected in 2D-window.

Table 9. The “Exterior orientation parameters” toolbar

FunctionsButtons
to turn on/off the editing mode of the table data (data shown in the Code and Name
columns are not editable)
to perform a search in the table for image by its name (Ctrl+F)
to delete highlighted rows from the table
to delete all data from the table
to import a list of exterior orientation parameters from text file
to export the list of exterior orientation parameters to text files with *.csv and *.txt ex-
tensions
to change coordinate system for selected/all images in the table
to swap X and Y coordinates of projection centers for selected/all images in the table
to shift the coordinates of projection centers for selected/all images in the table
to make exterior orientation parameters (angles and/or projection centers) of images
selected in the table GCP
to make exterior orientation parameters (angles and/or projection centers) of images
selected in the table check
to make exterior orientation parameters (angles and/or projection centers) of images
selected in the table excluded
to include all three coordinates (X, Y, Z) of projection centers for selected images in the
table, if some coordinates were excluded
to exclude Z-coordinate of projection centers for selected images in the table (for points
with XY coordinates)
to exclude X, Y-coordinates of projection centers for selected images in the table (for
points with Z coordinate)
to open the Set exterior orientation parameters accuracy window used to specify
threshold values in meters for RMS by XY and Z for projection centers, and for angles
accuracy values for selected/all images in the table
to change the kappa angle by a predetermined value for selected/all images in the table
to calculate missing data on projection centers coordinates and/or angle using interpol-
ation of exterior orientation parameters by time
to specify the kappa angle value in accordance with the flight path
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FunctionsButtons
to copy “adjusted” exterior orientation parameters to corresponding fields of initial exter-
ior orientation parameters for images selected in the table
to show/hide initial data (input to the table manually or obtained during import)
to show/hide “adjusted” data – exterior orientation parameters corrections, calculated
during block adjustment operation
to show/hide “adjusted” data – exterior orientation parameters corrections, calculated
during block adjustment operation, taking in account the rolling shutter effect (see the
“Adjustment parameters of central projection images block” chapter in the “Block adjust-
ment” User Manual).

The effect of rolling shutter is the distortion of object shapes in an image when a picture is not
captured at the same instant but the image is captured progressively. This effect appears at the
short shutter speed of focal plane shutters or interline transfer CCD.

Survey data containing such distortions can be obtained using cameras installed aboard some
UAS. It is recommended to use rolling shutter compensation algorithms if appropriate information
about the properties of the equipment used is available (see the “Adjustment parameters of
central projection images block” in “Block adjustment” User Manual).

5.1.1. Projection center shift

The system allows for shifting projection centers for selected/all images in the table of
the Exterior orientation parameters window.

For this, perform the following:

1. [optional] select the required images in the table of the Exterior orientation para-
meters window;

2. Click the button of the Exterior orientation parameters window toolbar. The
Shift center’s coordinates window opens:

Fig. 93. The Shift center’s coordinates window

3. Set the shift for the projection center coordinates by X, Y and Z axis, in meters;
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4. Choose either shift projection center coordinates For all images or only For the
selected images;

5. Click OK.

To undo changes, click the Reset button in the Exterior orientation parameters window.

5.2. GCP list

In order to input GC points coordinates to the GCP list perform the following actions:

1. Choose Orientation › GCP list (Ctrl+Alt+G) or click the button of the main
toolbar. The Triangulation points window opens on the GCP list tab.

Use Ctrl+wheel to quickly scroll through the list (similar to scroll bars). Rotate the mouse
wheel to move through the lines.

Fig. 94. The GCP list

2. To add a new GCP to the table click the button or use the Alt+Ins shortcut.

Editing mode of the table data is automatically on.

Input to the table the following data:

• Name – a name of GC point;

• Type – point type: Ground control (by default), Check or Excluded;

The Check and Excluded types are assigned to GC points only after their meas-
urement on project images. The Check points is not involved into block adjustment,
but is used for accuracy control. The Excluded points type is used for temporal
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point exclusion from GC points list, for example, to exclude unmeasured GC
points prior to block adjustment.

In order to change a point’s type use the , , buttons of the toolbar of the GCP
list tab.

• X, Y, Z – X, Y, Z coordinates of GCP in meters.

During adding of new GCP, a default coordinates values are equal to 0 meters.

If some coordinates values are unavailable, and also for excluding of some co-
ordinates valuers there is a possibility to assign a point type: XYZ, Z or XY.

To assign a point XY type use the button. To assign a point Z type use the
button. The button is`used to consider all three coordinates of GC point.

GC points coordinates are specified in coordinate system selected on a step of project
creation (see the “Project creation” User Manual).

The system allows to use Z coordinate taken from DEM. The button is used
for this. In order to load a DEM from project resources, select single or multiple
points and click the .

If a DEM is already loaded to a project, it will be used automatically.

• Std.dev. X, Std.dev. Y, Std.dev. Z – values of RMS accuracy by X, Y, Z coordin-
ates (in meters);

• Number ofmeasurements – number of block imageswhereGC point coordinates
are measured (filled in automatically after measurement of GCP coordinates on
images).

On a step of GCP input theNumber of measurements column displays 0 value.

The system also provides opportunity to performimport of GCP list from a text file.

Prior to adjustment it is recommended to measure coordinates of all input GCP or to assign
the Excluded type for points without measurements.

3. Complete input of GCP to the table and proceed to their coordinates measurement
on images (see the Section 5.3.1).

For successful adjustment of central projection images block the coordinates of projection
centers of the block images are used or at least three GC points, which coordinates should be
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measured on at least two adjacent images of the block. Information about recommended amount
of GC points for blocks of scanner spaceborne images see in the Appendix A.

The toolbar of theGCP list tab is used to input/import/editing of GC points coordinates,
and also allows to open themodule of GCP coordinatesmeasurement on project images.

Table 10. Toolbar on the “GCP list” tab

FunctionsButtons
to turn on/off the editing mode of GC points in the table
to search for GCP in the list using its name (Ctrl+F)
to add a new GCP to the list
to delete either selected ground control points, or measurements the selected ground
control points in reference points directory.
to delete either all the ground control points from the directory along with themeasurement
results, or the measurement results only
to import the GCP list from text file to the list
to export the GCP list from the list to text file
to swap X and Y coordinates for selected/all GCP in the list
to re-calculate the coordinate system for selected/all GCP in the list
to consider all three X, Y, Z coordinates in case of XYZ GC points (default parameter)
to use XY GC points, i.e. to exclude the Z-coordinate of selected/all points of the list
to Z GC points, i.e. to exclude the XY-coordinates of selected/all points of the list
to open the Set exterior orientation parameters accuracy window used to define ac-
curacy of coordinates (RMS) by XY or by Z for selected/all GC points of the list
to assign the Ground control type to points selected in the list

to assign the Check type to points selected in the list

to assign the Excluded type to points selected in the list
to open the Point properties window to view a name, type, code and coordinates of
selected point (see the Section 4.4.4)
to open the Points measurement module to measure/view on image a GCP selected
in the list. Thus the button allows to display the GCP on the images where it was already
measured or may be measured in the future
to open the relative orientation report
to load a DEM used to obtain or refine Z coordinate values for GCP from the list
to acquire (extract) Z coordinate from loaded DEM for GCP selected in the list (if the
DEM is already used in the project, it is loaded automatically)
[only for the “Points measurement” module] to acquire GCP from DEM considering ad-
justment results, i.e. to measure the GC point in marker position on selected images in
the Points measurementmodule. Coordinates of the GC point are measured using the
following way: X, Y – adjusted coordinates, Z – is taken from DEM (see the description
in Section 5.3.1)
allows to turn on the automatic selection of images, that contain the point’s position: if
the mode is on, click the button or double click the point’s record in the coordinates
list allows to open all images in the Pointsmeasurementmodule, where the coordinates
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FunctionsButtons
of the selected point are already measured, otherwise – all images of the block, that
contain the point’s coordinates
to create raster outline of triangulation points

5.3. GCP adding and measurement their coordinates

Measurement of GC point coordinates means adding of known terrain point coordinates
to GC points list and measurement of its pixel coordinates on image.

GC point is a terrain point with known geodetic coordinates, which is a source point for
photogrammetric measurements.

Adding and measurement of GC points coordinates on block images in the system allow
to calculate exterior orientation parameters of images block, when metadata with exter-
ior orientation parameters, obtained from a provider, is not available.

Generally, adding and measurement of GC points coordinates is performed on a step of tie
points coordinates measurement and relative orientation. Then it is necessary to adjust a block
and calculate exterior orientation parameters. After that project images block is fully prepared
for further processing, including stereo vectorization, DEM and orthomosaic generation.

If the GC points coordinates data is unavailable at the time of data collection for aerial
triangulation procedure, the system provides possibility to adjust a block in a free
model (without GC points), that allows to proceed to project processing step directly
(see the “Block adjustment” User Manual).

When deleting images from a project it is highly recommended to synchronize data in a project
to remove redundant results of orientation. To do this choose Project › Synchronize.

In order to use GC points during block adjustment perform the following actions:

1. Input coordinates of GCP to coordinates list.

2. Measure coordinates of GC points on project images.

To perform correct block adjustment it is recommended to measure coordinates of all input
GC points on block images, since all points – both measured and unmeasured – take part
in statistics during block adjustment. Otherwise, it is possible to exclude unmeasured points
on steps of coordinates measurement and block adjustment.

5.3.1. Measurement of GCP coordinates

After completing of GCP coordinates input it is possible to measure these GCP on block
images in the Points measurement module.

In order to measure GC point coordinates perform the following actions:
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1. Open the Triangulation points window on the GCP list tab.

2. Select GC point in the table to measure its coordinates on images and click the
button or double click the point name in the table. The Points measurement module
is opened.

If at least three GCPwere already measured on block images or there was executed
preliminary orientation in geodetic coordinate system (by projection centers, for in-
stance), the system performs automatic search for corresponding terrain point on
block images (according to XY coordinates) and places marker on this image point.

When the system performs a search for terrain point in mode of images automatic selection
(the button of the Triangulation points window is clicked) it automatically opens all
images that contain the terrain point with measurements or without them, otherwise – only
images that contain measurements of selected point.

To use the improved algorithm for searching for corresponding terrain points, taking
into account GCP elevations, perform the following:

1. Click the button on the upper Points measurementmodule toolbar, to open
the Points measurement settings window;

2. Set the Correct GCPs position while measurements checkbox.

Proper functioning of the improved algorithm for GCP position refinement is feasible under
strict compliance with the following conditions:

• The adjustment is performed (see the “Block adjustment” User Manual);

• All three GCP coordinates are available see the Section 5.2);

• At least two point measurements are available in project images.

If GCP measurements or preliminary orientation results are unavailable, click the
button of the upper toolbar of the Points measurement module. Select and

open images and perform a search for terrain point manually.

3. Measure coordinates of GC point on a single or multiple images (the point lies in
the overlap area) using one of the following ways:

• GCP coordinates measurement without correlator is used if a point is located on
terrain and is clearly recognized on all images.

Show by marker the terrain point on images. Click the button of the upper
toolbar of the module.

• GCP coordinates measurement and transfer with correlator is used if a point is
not clearly recognized on all images.
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In this case measure the point on a single image using the button of the upper
toolbar of the image window or use the Ins hotkey. Define the image as the left
using the button in the image window. Then transfer the point from the left
image to other images using the button to transfer the point on the image in
the active window or use the button to transfer the point on all images opened
in the module.

Recommended correlation coefficient during GCP transfer is 0.90–0.95.

• measurement of coordinates in stereomode is used when the point is located
on high-rised object and/or is not displayed on all images.

4. After measurement of GCP coordinates an information about the measurement
appears in the Tie points list.

Fig. 95. Measurement of GCP coordinates in the “Points measurement” module

In order to find a GCP in the Triangulation points table perform the following actions:

1. Click the button. The Find window opens.

2. Input GCP full name or its part into the Find field, specify a search direction and
click OK.

172

Aerial triangulation (Windows x64)PHOTOMOD 8.0



Tomove a GCP on images (to edit measurement of selected point) perform the following
actions:

1. Select measured GC point in the table of the Triangulation points module and
click the button or double click the point name in the table to display the meas-
urements of selected point on block images.

2. Show by marker new position for selected GC point.

3. Click the of the module upper toolbar. After that the GC point on images is moved
to marker’s position, and measurements data is refreshed in the Triangulation
points table.

To delete the ground control point measurements from the image, select the point in
the Triangulation points table and click the button of the image window in the
Points measurement module.

To delete the ground control point measurements from all images, perform one of the
following actions:

• select a point in the Triangulation points table and click the button on the upper
toolbar on the Points measurement module;

• select a point in the Triangulation points table and click the button on the toolbar
of the Triangulation points window. The Delete points window opens. Click the
Delete point measurements only button.

Fig. 96. The Delete points window

The operation does not lead to deletion of GC point coordinates from the Triangulation
points table (see also Section 6.7).

To delete a ground control point completely (both the point measurements on the images
and the point with the coordinates from the table), select the point in the table and click
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the button of the toolbar of the Triangulation points window. The Delete points
window opens. Click the Delete points from catalogue button.

Fig. 97. The Delete points window

To delete all measurements of ground control points, click the button of the toolbar
of the Triangulation pointswindow. TheDelete pointswindow opens. Click theDelete
measurements only button.

Fig. 98. The Delete points window

To delete the entire ground control points catalogue along with the measurements,
press the button on the toolbar of the Triangulation points window. The Delete
points window opens. Click the Delete catalogue and measurements button.
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Fig. 99. The Delete points window

A description of GCP transfer from georeferenced map (raster or vector map, as well
as DEM of the same terrain, where project images are acquired) see in the Section 5.5.

To transfer a GC point from DEM considering adjustment data perform the following
actions:

GC points transfer from DEM considering adjustment data is performed only for the projects of
the Space scanner survey type, adjusted by metadata, when it is necessary to improve a block
scheme in case of discrepancy of nadir and off-nadir images. Namely, to improve results of
adjustment (to refine Z coordinate) by DEM using GCP coordinates measurement.

1. Open the Points measurement module.

2. Click the button of the Triangulation points window toolbar to go to the GCP
list tab.

3. Click the button to load DEM. Select a file containing DEM and click OK.

If a DEM is already loaded to the system, it will be used automatically.

If there is loaded DEM the status bar of the window displays the path to opened DEM and
its name, and there is also the button allowing to close the DEM.

4. Click the button of the upper toolbar of the module to open an image to transfer
a point from DEM.

5. Show the location of a new GCP on images by marker.

6. Click the button of the Triangulation points window toolbar to add a new GC
point, which coordinates are calculated by DEM and adjustment data. A new GC
point arrears in the list of the Triangulation points window.

To add the only one measurement of GC point coordinates on selected image click the
button holding pressed Alt key, otherwise the point will be added on all opened images.
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5.4. Automatic ground control points measurement

The system provides for automatic measuring GC points if supplement ground control
data are available, i.e. an orthoimage and DEM, coverage of those considerable coincide
with the terrain showed in the imagery of the project under processing.

Automatic GCP measuring allows to increase the position accuracy according to refer-
ence data and can be performed at various stages of project processing, supplementing
the list of imported (manually measured) GCPs, if available.

This operation is recommended in the following cases:

• In order to improve the accuracy of the results of processing the project, which has
already been subjected to preliminary adjustment, relative orientation of images and,
optionally, import of the GCP list;

For example, after automatic tie point measuring and preliminary project adjustment, in case
of central projection project processing.

• Before performing relative and exterior image orientation and project adjustment.

Automatic measurement of GCPs at this stage of processing requires significantly more time
(compared to measurements for the adjusted project).

The system also allows to delete adjustment results before searching for ground
control points (see below). In this case, the results of the project adjustment and relative
orientation of the images will be deleted and the GCP search will be performed “from
zero” (as in the second case described above.

Imported (measured manually) GCPs will not be removed.

5.4.1. Aerial survey

To measure ground control points coordinates in automatic mode perform the following
actions:

1. Choose Orientation › Automatic GCPs measurements. The GCPs searching
parameters window opens:
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Fig. 100. The GCPs searching parameters window

To download, save, and reset ground control points search parameters, the following
buttons are provided:

• – allows to download the set of search parameters and paths to the input files
from the *.x-ini file;

• – allows to download only search parameters from the *.x-ini file;

• – allows to download only paths to the input files from the *.x-ini file;

• – allows to save the whole set of parameters in the *.x-ini file in theWindows
file system.

2. Select the input Resources in an appropriate tab:
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• DEM – click the button to select DEM in active profile resources;

Click the button to open the Layer selection window and select the source DEM
from the list of DEMs uploaded to the project.

• Orthoimage – click the button to select a orthoimage file in Windows file
system.

Click the button to open the Layer selection window and select the source image
from the list of ortho images uploaded to the project.

3. Set the following GCPs searching parameters:

• Set the interpolation cell size in pixels.

• The Standard deviation section allows to set RMS errors on the plane and in
elevation for the used ortho in the appropriate input fields.

These values are entered by a user, taking into account the characteristics of the input
data.

• Correlation threshold is the minimum value of the correlation coefficient to
measure point coordinates in images. Points with correlation threshold below the
specified value are not considered to be added;

• The search area (pix) allows to define the area (in pixels of the downloaded ortho)
where a GCP corresponding to the orthophoto point is to be searched;

• Maximum vertical parallax is the value of maximum error of GCP mapping in
project imagery and in the downloaded orthophoto (in downloaded orthophoto
pixels).

4. The Compress intermediate data section allows to set the method and degree of
compression for intermediate raster imagery (imagery in projects, orthophotomaps)
in order to save drive space:

• No – files are created without compression;

• LZW – the Lempel-Ziv-Welch universal algorithm of lossless compression;

• Deflate – the universal algorithm of lossless compression;

• JPEG – color image compression algorithm with losses. The quality of the com-
pressed image in percent is set.
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5. Set the number of tasks per CPU core to create several tasks of long processes
per one core. This reduces time required for process execution.

Maximum recommended number of tasks is 2 or 3 per core.

6. The additional options button allows to choose additional settings for GCP search:

Fig. 101. Additional settings for GCP search

• The Autocorrelation control checkbox allows you to define the degree of
autocorrelation, i.e. maximum σ value in the gaussoide that places an upper
limit on the mask correlation coefficient distribution in a small area in the same
image. The higher is the σ value, the lesser is the probability of correct measure-
ment of points obtained through correlation with the given point as source.

• Approximate final minimum number of points on stereopair after rejection.

7. In case of UAS data processing, it may be necessary to perform additional meas-
urements of tie points in certain areas of the images under processing. For this, set
the appropriate checkbox and click Correlator configuration configure for further
configuring tie point search.

8. To delete adjustment results before searching set the appropriate checkbox;

9. To delete intermediate data when operation is completed, set the appropriate
checkbox.

10. Click OK.

5.4.2. Satellite scanner imagery

To measure ground control points coordinates in automatic mode perform the following
actions:

1. Choose Orientation › Automatic GCPs measurements. The GCPs searching
parameters window opens:

179

Aerial triangulation (Windows x64)PHOTOMOD 8.0



Fig. 102. The GCPs searching parameters window

To download, save, and reset ground control points search parameters, the following
buttons are provided:

• – allows to download the set of search parameters and paths to the input files
from the *.x-ini file;

• – allows to download only search parameters from the *.x-ini file;

• – allows to download only paths to the input files from the *.x-ini file;

• – allows to save the whole set of parameters in the *.x-ini file in theWindows
file system.
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2. Select the input Resources in an appropriate tab:

• DEM – click the button to select DEM in active profile resources;

Click the button to open the Layer selection window and select the source DEM
from the list of DEMs uploaded to the project.

• Orthoimage – click the button to select a orthoimage file in Windows file
system.

Click the button to open the Layer selection window and select the source image
from the list of ortho images uploaded to the project.

3. Set the following GCPs searching parameters:

• Set the interpolation cell size in pixels.

• The Standard deviation section allows to set RMS errors on the plane and in
elevation for the used ortho in the appropriate input fields.

These values are entered by a user, taking into account the characteristics of the input
data.

• Correlation threshold is the minimum value of the correlation coefficient to
measure point coordinates in images. Points with correlation threshold below the
specified value are not considered to be added;

• Points per stereopair input field allows to set the number of GCPs for measure-
ment;

The resulting number of measured GCPs may be both more than the set number due
to point transfer from neighboring pairs, and less due to further rejection.

• Correlationmatrix half-size (pix) input field allows to define the size of a correl-
ation matrix in downloaded orthophoto pixels by X and Y axes (input value multi-
plied by 2).

• The search area (pix) allows to define the area (in pixels of the downloaded ortho)
where a GCP corresponding to the orthophoto point is to be searched;

• Maximum vertical parallax is the value of maximum error of GCP mapping in
project imagery and in the downloaded orthophoto (in downloaded orthophoto
pixels).
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4. The Distributed orthorectification for satellite images checkbox allows to in-
crease the system performance in case of very large amount of source images
(more than 2 Gb). Otherwise, the use of this option is not expedient.

• The number ofMegaTiff fragments per task andMaximal fragment size (Mb)
are also displayed here (obtained by the automatic calculation);

5. The Compress intermediate data section allows to set the method and degree of
compression for intermediate raster imagery (imagery in projects, orthophotomaps)
in order to save drive space:

• No – files are created without compression;

• LZW – the Lempel-Ziv-Welch universal algorithm of lossless compression;

• Deflate – the universal algorithm of lossless compression;

• JPEG – color image compression algorithm with losses. The quality of the com-
pressed image in percent is set.

6. Set the number of tasks per CPU core to create several tasks of long processes
per one core. This reduces time required for process execution.

Maximum recommended number of tasks is 2 or 3 per core.

7. The additional options button allows to choose additional settings for GCP
search:

Fig. 103. Additional settings for GCP search

• The Check correlation by reverse stereopair checkbox allows to check the
results of point search on the reverse stereopair. If the results do not coincide,
the point is removed;

• The Autocorrelation control checkbox allows to define the degree of autocor-
relation, i.e. maximum σ value in the gaussoide that places an upper limit on the
mask correlation coefficient distribution in a small area in the same image. The
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higher is the σ value, the lesser is the probability of correct measurement of points
obtained through correlation with the given point as the source;

• The Search contrast point checkbox is to search GCPs in the most contrast
areas (in the images with clear object contours);

• Tries per point is the number of attempts to search the appropriate point having
the correlation coefficient above a value specified in the search area;

• Approximate final minimum number of points on stereopair after rejection.

8. To delete adjustment results before searching set the appropriate checkbox;

9. To delete intermediate data when operation is completed, set the appropriate
checkbox;

10. Click OK.

5.5. Georeferenced external data

5.5.1. The “Map” window

Georeferenced external data (raster and vector maps, DEMs, and web-maps) for the
same terrain as project images, are used as a basis to obtain GCP coordinates and
measurement of the GCP on project images.

In order to use all features of the Map window it is recommended to work with georeferenced
block scheme, i.e. it is necessary to have already measured GCP available on project images
(two, at least) or block layout created using exterior orientation data (see the Section 5.5.3).

General workflow on GCP transfer includes the following steps:

1. Load of georeferenced data (briefly: map).

2. Selection of terrain point on the map and search for the point on project images.

3. Transfer the point from the map – add/measure of point’s coordinates on project
images.

4. [optional] Editing of the GC point.

Main purpose of theMap window – load of georeferenced data (raster and vector maps
and DEMs) in order to use them for adding GC points andmeasurement their coordinates
on project images.

To open the Map window, open the Points measurement module and click the
button of the main module toolbar.
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Fig. 104. Окно “Карта”

By default, all data opened in 2D-window is displayed in working area of theMapwindow.
Besides, if there is georeferenced block scheme the Triangulation points layer is created,
and work with it is synchronized with windows of images opened in the Points meas-
urement module.

In the right part of theMap window there is the Layer’s Manager used to manage these
data and navigation window for fast move to needed part of the map. There is a toolbar
in the top of the window.

In the status line of theMap window the marker’s position coordinates on the georefer-
enced map are shown.

It is possible to move the whole image in the working area of theMapwindow in panning
mode by moving mouse with pressed left button along with holding pressed the Alt key.

In the bottom of the working area of the Map window there is the panel used to setup
brightness, contrast and gamma-correction of the image shown in the working area.
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The Shift+F8 shortcut allows to hide the brightness setting panel.

In order to return to default settings of brightness and contrast, right click the settings panel and
select Reset.

Settings of brightness, contrast and gamma-correction are not restored after the module restart.

Table 11. The Map window toolbar

FunctionsButton
to open a window used to select a raster map file located out from profile re-
sources, which have one of the raster formats supported by GDAL library
to open a window used to select a vector map file located in active profile re-
sources
to open a window used to select a file of DEM located in active profile re-
sources to obtain Z coordinates for measured GC points
to open a window used to select a source of geospatial data of WMS format
and to load web-maps, located on specified area
[for georeferenced block scheme only] to find marker position in windows of
opened images of the Points measurement module (the button action is

Find on open images

duplicated by double mouse click) – allows to perform automatic search for a
placement of marker specified on the map on images opened in the module
to perform a search of a terrain point specified on the map by marker on all
project images – after that windows of those project images where the point

Find on all images

was found are opened in the Pointsmeasurement module (the button action
is duplicated by Shift + mouse double click)
to add a GC point on opened images of the module without correlation, i.e.
to transfer a point with coordinates from the map to a terrain point specified
by marker on selected images. The added point is displayed on images and
in the list of triangulation points of the Points measurement module
to open a window used to add and measure GCP coordinates with correlation
to search corresponding points on project images, and to use a DEM to acquire
Z-coordinate (see the Section 5.5.4)
to move the view area in any direction
to use the marker=mouse (F4) mode of working area
to use the Fixed marker mode (F6) – when marker is always at the center
of the screen and mouse moving results in the image moving
to center image in working area by marker (F7)
to show/hide service windows, located to the right from the working area:
Layer manager and navigation window
to show/hide navigation window only
to show/hide scroll bars
to manage a zoom of the whole image of the window working area. The

field is used to display a current zoom, and allows to change

, , , , ,

the zoom using the slider (see the “Image scaling in 2D-window” chapter of
the “General information” User Manual)
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5.5.2. Prepare and load georeferenced data

The system supports using of the following georeferenced data: raster maps, vector
maps, DEMs, and web-maps to acquire GCP data.

Loaded external georeferenced data are restored during next module session, but removed
from memory during log off from the system.

Prior to use georeferenced maps and DEM (briefly:maps) perform the following actions:

1. Prepare the input data in the following way:

• for raster data specify a folder out of active profile resources to place a raster
format file supported by GDAL library and georeference file with the same name.

The need for a separate georeference file depends both on the raster file format on the
whole and characteristics of a particular file, due to its origin.

Thus, for example, GeoPDF and GeoTIFF images initially contain georeference data,
what, however, is not true by default for an arbitrary file with *.pdf or *.tiff extensions.

In turn, formats of some images (for example, *.bmp) do not provide for including geor-
eference data and require obligatory separate georeference files.

The system allows to georeference scanned cartographic raster material using points
with known geodetic coordinates (see the Section 5.5.5).

• (see the Section 5.5.5);

• for vector data and DEM perform their import to files of interior format of the
system (*.x-data and *.x-dem correspondingly) and save them to the folder in
active profile resources. See a description of the vector data and DEM import in
the “Vectorization” User Manual.

The system provides possibility to import vector objects from the GeoPDF georeferenced
raster file (if such data is available in current GeoPDF file, see more in “Import from
GeoPDF” chapter of “Vectorization” User Manual).

2. Open the Points measurement module.

3. Click the button of the top module toolbar. The Map window opens. In the
working area of the Map window the data loaded during work in 2D-window is dis-
played.

4. [optional] Click the button to display a list of layers and to manage them.

5. Load georeferenced map, using one of the methods listed below.

To load a raster map to a project perform the following actions:
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1. Click the button. The Loading images window opens.

2. Select a raster map file and click theOpen button. The Load georeferenced images
window opens.

3. [optional] Re-calculate coordinate system of the raster map to bring it in correspond-
ence with the project coordinate system. If there is a background color on the edges
of the map, specify the background color and define the color transparency.

4. Click OK. New georeferenced raster layer appears in the Layers manager and
loaded raster map is displayed in the Map window working area.

To load a DEM to a project perform the following actions:

1. Click the button. The Open window opens.

2. Select DEM file in active profile resources and click the Open button.

3. New DEM layer appears in the Layers manager and loaded DEM is displayed in
the Map window working area.

To load a vector map to a project perform the following actions:

1. Click the button. The Open window opens.

Fig. 105. Parameters of vector map loading
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2. Select vector map file in active profile resources.

3. [optional] Recalculate coordinate system if necessary.

4. Click theOpen button. New vector layer appears in the Layers manager and loaded
vector map is displayed in the Map window working area.

Perform the following actions to load a web-map to a project:

1. Click the button. The Settings window opens.

Web-map loading is possible for georeferenced block scheme only.

Fig. 106. Parameters of web-map loading

2. [optional] Setup parameters of the web-map loading.

3. Click OK. The Load web-map window opens.
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Fig. 107. Parameters of web-map loading

4. In the Source list select a source of georeferenced data of WMS standard.

5. [optional] Define a working area to load a web-map.

6. In the Reproject section define a coordinate system of loaded web-map using the
following way:

• Auto – automatic transformation to coordinate system of a project;

• None – use coordinate system of the web-service;

• Reproject into coordinate system and specify necessary coordinate system.

7. Click OK. New vector layer appears in the Layers manager and loaded map is dis-
played in the Map window working area.

5.5.3. Search for GCP on project images

To transfer GC points from a map to a project it is necessary to find these points on
project images. To do this perform the following actions:

1. Select specific terrain point on a map in the Map window and place marker on this
point.

Specific terrain point – a terrain point which is clearly visible in comparison with other terrain
objects: it has good contrast, sharpness, is distinguished by color and shape.

2. Find this terrain point on project images in the Points measurement module.

Search for corresponding terrain point on images depends on availability of some project
data.
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3. [optional] If there no measured GCP and exterior orientation data available in the
project perform the following actions:

1. In the Points measurement module click the button of the upper toolbar.

2. Select and open those project images that contain the terrain point specified
in the map.

3. Find this point manually and show it on project images using marker.

4. If the project contains at least 2 measured GCP and/or exterior orientation paramet-
ers are used for block layout creation, use the following synchronization tools to
perform search for the terrain point on project images:

• for automatic search for the point on project images opened in the Points
measurement module click the button in the Map window. Define the point
position more exactly using marker, if necessary;

• to perform automatic search for the point on all project images and to open in
the Points measurement module just those images where the point is found,
and also with marker positioning, click the button in the Map window. Define the
point position more exactly, if necessary.

The system also provides reverse synchronization, when it is searching on the map for the
terrain point specified on the image. To do this place marker on the image point in the
active window of the Points measurement module, and then click the Find on map
button of the main toolbar of the module.

5.5.4. Transfer GCP from map

To transfer selected GCP from map, i.e. to add/measure coordinates of found point on
project images, the system provides the following features:

• adding GCP without use of correlator;

• adding GCP using correlator.

To use correlator it is necessary to have already measured GCP in a project and/or exterior
orientation parameters along with created block layout using these parameters. Besides,
during adding a GCP using correlator there is a possibility to use DEM to obtain a value of
point’s Z-coordinate.

To quickly add GCP without correlator perform the following actions:

1. Load raster or vector map.

The system allows to use multiple raster and/or vector maps at the same time.
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2. Make the maps layer active in the Map window.

3. Use marker to match terrain points on the map in the Map window and on project
images in the Points measurement module (see the Section 5.5.3).

4. Click the Add point without correlation button in the Map window. A new
GCP is displayed on project images and appears in the triangulation points list of
the Points measurement module.

5. [optional] Edit coordinates values or change the point’s type (GCP, check) on the
GCP list tab of the Triangulation points window.

To add GCP from raster map using correlator perform the following actions:

1. Load raster map.

2. Make raster layer active in the Map window. If there is a DEM available, load in to
the Map window to obtain Z coordinate.

3. Specify a terrain point on the raster map using marker. Click the Find on all
images button in the Map window to open all project images contains this terrain
point in the Points measurement module.

4. Click the Open tool panel for addingGCPs frommap button in theMapwindow
or in the Points measurementmodule. The Add GCPs frommap window opens.

When the Add GCPs from map window is opened it is possible to work both in the Map
window and in the Points measurement module.
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Fig. 108. Transfer of GCP from a map

5. In the Raster layer for correlation drop-down list select active layer of raster map.
In the DEM layer for obtaining Z drop-down list select a DEM layer (if any).

To refresh a list of layers use the button.

6. Setup the following correlator parameters:

• set the Auto checkbox to define the GSD automatically, or input pixel size value
manually;

• specify the Search area of corresponding point on image in meters, the default
value is 100;

• specify the Correlation mask halfsize by X and Y axes (pix), the default value
is 12;

• set the Contrast point search area checkbox and specify a size of the area in
meters (the default value is 10), where the system will search for the point with
maximal contrast;
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It is necessary to define more precisely this area size to process data with big monochro-
matic areas.

When measuring points in low contrast areas it is recommended to set 0 value (for ex-
ample, when maximal contrast corresponds to forested areas, where there are good
chances of correlator errors).

• specify the Correlation threshold – minimal value of correlation coefficient for
points coordinates measurement (0.8, by default). Points that have correlation
threshold below specified value are not considered during adding (the “Bad point”
warning appears).

Correlation threshold is defined considering source data quality.

7. To add GCP using correlator it is possible to use the following buttons of the Add
GCPs from map window toolbar:

• Correlate and move marker – allows to search for corresponding point on
opened images of the Points measurementmodule using correlator. In case of
successful correlation marker is moved to the found point, otherwise, the “Bad
point” warning appears;

• Add point with correlation on the active image – allows to add/measure
GCP coordinates on image in active window of the Points measurement mod-
ule – in other words, to search for corresponding point on image in active window
using correlator. In case of successful correlation marker is moved to the found
point and the New GCP window opens, otherwise, the “Bad point” warning ap-
pears;

• Add point with correlation on all images – allows to add/measure GCP
coordinates on all images opened in the Points measurementmodule – in other
words, to search for corresponding point on all opened images. In case of suc-
cessful correlation marker is moved to the found point and the NewGCP window
opens, otherwise, the “Bad point” warning appears;

• Add point without correlation – allows to “quickly” add a GCP without cor-
relation to a marker position on image in the Points measurement module.

The New GCP window is intended to view/edit coordinates of selected terrain point
on a map, and to analyse correlation coefficient and to select the images of the
project where a new GC point will be added.
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Fig. 109. Edit point’s measurements

To add a new GCP perform the following actions:

1. Input a name of a new point to the Name field.

2. Select coordinates to be transferred during point adding.

A value of Z coordinate is displayed when DEM is used.

3. Estimate correlation coefficient shown in the table and select images, where
to add GCP.

4. To add/measure GCP coordinates on selected images click one of the buttons
located at the bottom of the window.

FunctionsButtons
to add new GCP with its coordinates to the tri-
angulation points list and to measure it on se-
lected images

Add point with measurements

to add newGCPwith its coordinates to triangu-
lation points list without its measurement on
selected images

Add point without measurements
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FunctionsButtons
to replace coordinates of selected GCP in the
triangulation points list and to re-measure it on
images

Replace GCP with measurements

to replace only coordinates of selected GCP
in the triangulation points list without editing of
measurements on images

Replace GCP coordinates

to re-measure selected GCP on images in the
triangulation points list without coordinates re-
fresh

Replace measurements only

5.5.5. Raster map georeference

The system allows to georeference scanned cartographic raster material using points
with known geodetic coordinates. If there is a raster georeferenced map on terrain area
is available allows to use it as a reference, i.e. to transfer GC points and measure them
on project images.

The Raster georeference window is used to perform raster map georeference.

Fig. 110. Raster map georeference window

The window contains the following GUI elements:

• toolbar used to reference raster image by points with known coordinates;
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• map window in the top part of the working area (there can be located multiple maps,
if the reference raster or vector map is loaded) with the standard tools panel used to
manage map’s image zoom and rotation in the window;

• table in the bottom part of the working area containing points coordinates with the
following columns:

○ Xg, Yg – point’s geodetic coordinates;

○ Xp, Yp – pixel point’s coordinates after adding the point on the raster map;

○ Name – point’s name;

○ Ex, Ey – errors in point’s X,Y coordinates measurements.

Table 12. Main toolbar of the Raster georeference window

FunctionsButtons
to load raster map to the window for its georeference
to load georeferenced raster map to another working window
to add georeferenced vector map of DXF, SHP or DGN format to another working
window
to load GC points data from text file to coordinate table
to save georeference data to a file ofMapInfo TAB format with a name that coincides
with the raster map name
to manage the zoom of map display, , ,
to remove all points from the table and from the map
to add a new point both to the map and to the coordinate table (at that, marker co-
ordinates are saved as pixel ones, and geodetic coordinates are assigned to 0
value)
to delete a point selected in the table
to refresh coordinates of selected point (to save pixel coordinates of a new marker
position on on the map for the point selected in the table)
to move marker on map point, selected in the table, that means that the system
performs search for selected point on the map
to copy coordinates of a point selected in the table to clipboard (the coordinates
are copied in the following format Xp Yp Xg Yg)
to refresh coordinates of selected point – to paste them from a clipboard (the fol-
lowing formats are acceptable: Xg Yg; Xg Yg Zg; Xp Yp Xg Yg; Xp Yp Zp Xg Yg Zg,
where Zp is identically equal to 0)
to open Windowsstandard color box that allows to choose color of GCP symbols
shown on the map
[raster map window] to display raster image in grey scale
[raster map window] to rotate image in the working window of raster map (no rota-
tion, rotate by 90, 180, 270 degrees)

, , ,
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To perform georeference of raster map perform the following actions:

1. Select Rasters › Images georeferencing. The Raster georeference window
opens.

2. Click the button of the main toolbar. Select a file with raster map located out of
active profile resources and click OK. After that a raster image is displayed in the
map window.

If folder with raster map file already contains a file ofMapInfo TAB format with reference
data, and TAB-file name is the same as a file name of raster map, then the coordinate
table of the window displays reference data.

3. [optional] In order to load additional data used for georeference perform one of the
following actions:

• to import points coordinates from a text file:

1. Click the button. The Import parameters window opens.

Fig. 111. Import parameters of points coordinates from a text file

2. Specify set of the data to be imported and its format and load it to the coordin-
ates table.

3. [optional] In order to prevent change of points coordinates, which are already
measured on images, set the Clear before import checkbox.

4. Click OK to add points to catalogue.

5. Find and add these points on the map by clicking the button and match
geodetic coordinates of point selected in the table to pixel coordinates of the
point on the map.
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• to load georeferenced raster map click the button. Reference map is opened
in the separateMap window (next to the window with un-referenced raster map)
and allows to acquire geodetic coordinates in any point. Show by marker two
identical terrain points both on raster and vector reference maps. Click the
button to add GC point on the raster map and to the coordinates table;

• to load georeferenced vector map click the button. Reference vector map is
opened in the separate Map map (next to the window with un-referenced raster
map) and allows to acquire geodetic coordinates in any point. Show by marker
two identical terrain points both on raster and vector reference maps. Click the

button to add GC point on the raster map and to the coordinates table.

4. In order to add geodetic coordinates of GCP on the map manually perform the fol-
lowing actions:

1. Locate GC point on the map and place marker to this terrain point.

2. Click the button. The point’s pixel coordinates are added to the table.

3. Input manually geodetic coordinates of this point into the Xg, Yg columns and
specify the point’s name in the Name field.

When the fifths point coordinates on the map are measured, coordinates measurement
residuals are calculated automatically and are shown in the Ex, Ey columns of the
table.

4. Repeat the 1–3 steps for other GC points.

For correct map reference it is recommended to recognize at least four points on the
map. If the reference is performed using only one point, the system considers that
measurement unit is one pixel and axes coincide. When two points are used for refer-
ence, the system performs image zoom and rotation, in case of reference by three
points the system applies affine transformations.

5. [optional] Edit GC points (see the description of the main toolbar of the Raster
georeference window).

6. Click the button to save georeference file toMapInfo format.

6. Editing of triangulation points

6.1. General information about triangulation points display

The system provides displaying of triangulation points in the following windows:
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• in windows of opened images of the Points measurement module (see the Sec-
tion 6.3);

• on a block scheme or on a stereopair in 2D-window (see the Section 6.4);

• on a conventional scheme in the Delete point measurements window for pictorial
view of points to be deleted (see the Section 6.7).

6.2. List of triangulation points

The system provides possibility to view, search and edit of triangulation points. The
Triangulation points window is used to do this.

ChooseWindow › Triangulation points coordinates to open the Triangulation points
window.

Fig. 112. The Triangulation points window

The Triangulation points window contains the toolbar with buttons used to perform
the following operations:

• – allows to set on/off the filter of triangulation points display;

• – allows to setup the filter of triangulation points display;

• – allows to display all/selected on a block scheme points in the table;

• – is used to search for an image by name (part of name);
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• – allows to display GC/check points initial coordinates (X, Y, Z – see the ’Aerial
triangulation” User Manual);

• – allows to display triangulation points coordinates obtained after adjustment (X',
Y', Z');

• – allows to display errors on points:

○ dX, dY, dZ – error values on point;

○ Ex(adj.), Ey(adj.), Exy(adj.) – average residuals of points on images.

• – is used export the table content to text file with *.csv extension;

• – allows to set the errors (Ex(adj.), Ey(adj.) и Exy(adj.)) displaying for the
central projection projects – in pixels or in mm:

Fig. 113. The Error settings window

For satellite scanner imaging and ADS 40/80/100 projects, error data are displayed only in
pixels.

For refreshing data about project state after changes the Refresh button is used.

The list of triangulation points is a table with the following columns:

• Code – an object code;

• Name – image name;

• Type – displays point’s type (tie, GCP, check, excluded);

• X, Y, Z – GC/tie point initial coordinates ( );

• X', Y', Z' – adjusted coordinates of triangulation points ( );

• dX, dY, dZ – error values on point ( );

• Ex(adj.), Ey(adj.), Exy(adj.) – average residuals of points on images ( ).
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The Triangulation pointswindow is synchronized with 2D-window: when point selecting
in 2D-window it is also selects in the table. Double-click by row with point allows to open
the Points measurements module to edit point’s position.

6.3. Points display in the “Points measurement” module

In order to display triangulation points on images, opened in the Points measurement
module, it is possible to use the following buttons of the left toolbar of the Points
measurement window:

• – allows to show/hide triangulation points;

• – allows to display triangulation points by symbols;

• – allows to show/hide triangulation points names;

• – allows to show/hide models by ties in a mode of triangulation points display by
symbols;

This mode allows to show in addition to tie point symbol “arrows”, indicting its connection
with adjacent images (left and/or right). For example, a triplet point symbol receives additional
right and left angle brackets.

Fig. 114. The left image shows triplet point, located in the center of triple overlap area, the
right one – triplet point from the right image

• – allows to show/hide GCP error vectors;

This function becomes available after block adjustment (see the “Block adjustment” User
Manual).

• – allows to show/hide tie error vectors;
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This function becomes available after block adjustment (see the “Block adjustment” User
Manual).

• – allows to apply/cancel a filter used to show triangulation points of certain types,
selected using the button;

The filtering is also applicable to points displaying in the points catalogue shown in the Trian-
gulation points window.

• – allows to select triangulation points types in order to apply a filter when displaying
them on images and in the points list of the Points measurement module (see
Section 6.6).

Fig. 115. The “Points measurement” module

6.4. Triangulation points display in 2D-window

To display triangulation points in 2D-window or on a block scheme or on a stereopair
perform the following actions:
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1. Choose Orientation › Load triangulation points or click the button.

The Triangulation points layer appears in the Manager. Triangulation points are
shown in 2D-window and the Display options window opens.

Fig. 116. Settings of points display in 2D-window

2. Setup parameters and modes of triangulation points display in 2D-window. All
changes in window settings are automatically displaying in 2D-window.

In order to open the Display options after their loading once more, choose Window ›
Triangulation points view control.

TheDisplay optionswindow allows to setup display of the following triangulation points:

• Measurements – all triangulation points measured on block images;

• Source coordinates – only GC/check points with source coordinates, input to the
list of GCP coordinates (see the Section 5.3);

• Adjusted coordinates – all triangulation points with coordinates, acquired after ad-
justment (see the “Block adjustment” User Manual);

• Block scheme position – all triangulation points with averaged coordinates of block
scheme (the option is used in mode of block scheme without reference, for instance).

The Block scheme position points type is unavailable for display of triangulation points in
the stereopair window.

The ability to display a particular type of points depends on the current mode in 2D-
window. It is possible to select one of the following modes in upper part of the Display
options window:
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• georeferenced block scheme – the system displays any types of points;

• block schemewithout georeference – the system displays only results of measure-
ments on block images and points positions in averaged coordinates;

• stereopair – the system displays only results of measurements on left and right im-
ages of a stereopair, as well as points positions in source and adjusted coordinates
of points, located in stereopair area.

To setup symbols and filter usage for points display the system provides the following
buttons:

• – allows to choose symbols for triangulation points of different types;

• and – allow to apply (the first button) and setup (the second one) filter used to
display points of selected types only (see the Section 6.6).

The filter settings are not saved for next module sessions.

The system provides the following modes to setup display of each type of points position:

• – do not display points;

• – points are displayed as small squares, which size is specified by the Point size
parameter;

• – points are displayed using symbols, which are setup using the button.

In the stereopair mode “small arrows” are added in addition to the main symbol to indicate
connection with adjacent images.

Besides, for each points type the system allows the following modes of additional in-
formation display:

• – allows to hide/show points names;

• – allows to hide/show XY-coordinates;

• – allows to hide/show Z-coordinates (this mode is unavailable for the Measure-
ments and Block scheme position points display modes).

Moreover, the system allows to display error vectors between point measurements on
block images and position of this point in source, adjusted or averaged coordinates. To
do this, set the Error vectors checkbox.
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Error vectors between measured and source point’s position are shown using crimson color,
between measured and adjusted point’s position – by blue color, between measured and aver-
aged point’s position – by yellow color.

The system provides possibility to save triangulation points as point vector objects in
vector layer, that can be used along with other base vector layers for TIN creation (see
the “DEM” User Manual).

To save triangulation points as vector layer perform the following actions:

1. Choose Vectors › Create layer from triangulation points. The Load triangulation
points window opens.

Fig. 117. Saving triangulation points on vector layer

2. Choose one or multiple points types according to coordinates to save them to a
vector layer:

• Ground control point catalogue – to save triangulation points in source coordin-
ates;

• Block scheme – to save triangulation points in averaged coordinates;

• Adjustment results – to save triangulation points in adjusted coordinates.

3. Click OK. After that the system opens information windowwhich contains information
about number of points of each selected type, saved on a vector layer. The Trian-
gulation points (Vectors) appears in the Layer manager. Vector point objects – tri-
angulation points are displayed in 2D-window on a block scheme or stereopair.

6.5. Symbols of triangulation points

To setup symbols for triangulation points the Symbols window is used. It could be
opened using one of the following ways:

• the button of the upper toolbar of the Points measurementmodule used to setup
points display on opened images (see the Section 4.2);
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• the button of the Display options window toolbar to setup points display on a
block scheme/on stereopair in 2D-window (see the Section 6.4);

• the Symbols button of the Delete point measurements window used to configure
display of points selected for deletion on graphical scheme (see the Section 6.7).

No matter at what stage and in which system module the symbols are configured, the symbols
settings are stored and are valid for the entire system until the next their change.

Fig. 118. Setup of points symbols

The window contains the list of all triangulation points. In the left column the symbols
selected (or configured by default) for each point type are displayed. There is also
possibility to change symbol shape and color for tie points (both in-strip and inter-strip).

To change a symbol perform the following actions:

1. In the By ties list select a point type which symbol needed to be changed.
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2. Select Symbol option to define a point’s shape – circle , rhombus or square
.

3. Click theColor field and select necessary color from standardWindowscolor palette.

4. [optional] To go back to symbols configured by default, click the Cancel button
while holding the Alt key.

5. Click OK to confirm changes.

6.6. Points filter

Points filter is intended for displaying of triangulation points of selected types. For ex-
ample, it is possible to show only triplet tie points or just GCP and check points.

For points filtering there are two buttons of the left toolbar of the Points measurement
module:

• – for filter setup – choosing points types to be shown;

• – to apply/cancel a filter.

Triangulation points filtering is available for images opened in the Points measurement
module (see the Section 6.3), for a block scheme or stereopair in 2D-window (see the
Section 6.4) and for window with parameters of points and error display on a block
scheme (see the “Block adjustment” User Manual).

It is possible to use special symbols to display points in the system (see the Section 6.5).

For points filtering setup perform the following actions:

1. Click the button. The Point filter window opens.
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Fig. 119. Selecting points to be displayed

2. In the following sections choose points types to be shown:

• the By coordinates section allows to select points to be displayed depending
on their coordinates:

○ ground control – GC points (ground and projection centers);

○ check – check points (ground and projection centers);

○ excluded – points with known coordinates, excluded from adjustment;

○ XYZ points – points with known coordinates (X, Y, Z);

○ XY points – points with known coordinates (X, Y);

○ Z points – points with known coordinates (Z);

○ No coordinates – points with unknown coordinates (ties and projection centers,
if their coordinates are not available);
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○ All – allows to select/unselect all points mentioned in the section.

• the By ties section allows to select points to be displayed depending on number
of their coordinates measurements on images:

○ Single – points which are not measured on any stereopair;

○ Stereopair – points measured on one stereopair, at least;

○ Triplet – points measured on one triplet, at least;

○ Strip tie – points measured in inter-strip overlap area;

○ Non-transferred – tie points, which are not measured on adjacent images;

○ Used – tie points used as ties during adjustment;

○ Excluded – tie points excluded from adjustment;

○ All – allows to select/unselect all points mentioned in the section.

• the Auxiliary section allows to select points to be displayed depending on their
type:

○ Geodetic – tie points which are not targeted and projection centers;

○ Targeted – targeted points;

○ Projection centers – projection centers;

○ With changed type – points which type was changed during adjustment.

• theBy residual value section allows to select points depending on residual value
on the point:

TheBy residual value section is available on block adjustment step only (see the “Block
adjustment” User Manual).

○ Worst points – points with maximal residuals (number of points to be displayed
is specified in the appropriate field);

○ Over acceptable residuals – points with residuals, exceeding threshold. Points
selection by residuals value is performed using additional checkboxesGround
XY, Ground Z, Tie in stereopairs XY, Tie in stereopairs Z, Tie on images.

Residual thresholds are specified on block adjustment step (see the “Block adjustment”
User Manual).
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• In selected models – used to select points located in selection area of stereo-
pair/strip or multiple steropairs/strips:

○ At least one – points measured on one selection area;

○ All – points measured on all selection areas simultaneously.

3. Click OK.

The Apply button is available only when working with the Display options window (see
the “Block adjustment” User Manual).

4. Click the button to apply the filter.

6.7. Triangulation points deletion

For points deletion the system provides the following possibilities:

• tools in the Points measurementmodule (see the Section 4.2.2) and in the triangu-
lation points catalogue;

• menu item Orientation › Clear point catalogue is used for deleting all points with
measurement results at once (GCP, check and tie);

• menu item Orientation › Delete point measurements for selective deleting of trian-
gulation points;

• menu itemOrientation › Delete points outside useful areas allows to delete points
out of useful areas (with specified background color) (used mainly during automatic
points measurements on scaner images);

• menu item Orientation › Delete border points allows to delete points of selected
types from near-boundary areas of project images marked in the list.

6.7.1. Selective deleting of triangulation points

Selective points deleting allows to delete points of selected types from project images
marked in the list.

For selective points deleting perform the following actions:

1. Choose Orientation › Delete point measurements or click the button of the
AT panel toolbar of on the main toolbar of the Points measurement module. The
Delete points measurements window opens.
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Fig. 120. Choosing of points types to be deleted

2. In the Selected images with point measurements section select project images
with measured points coordinates, that should be deleted. The section contains list
of project image and the toolbar used for images selection.

For selective points deleting it is necessary to choose at least one image. An exception is
the removal of All without measurements on images points type, i.e. GC points located
on none images of the block. It is possible to obtain such points, for example, after triangu-
lation points import or after deleting images from the block.

3. Set checkboxes next to point types to be deleted as well as deletion modes in the
Select points and Delete mode sections accordingly.

The section contains a list and graphical scheme of point types. The list of point
types and the scheme are synchronized, i.e. points of type selected in the list are
automatically marked (by check mark) on the graphical scheme. And vice versa,
selected point types on the graphical scheme leads to automatic selecting of cor-
responding checkboxes in the point types list.
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To select multiple point types on a scheme use the Shift key.

The Symbols button allows to change points symbols on the scheme.

The system provides the following tools to manage image zoom and BCG paramet-
ers on the scheme:

• «*» – allows to zoom in the image;

• «/» – allows to zoom out the image;

• Alt – allows to turn on panning mode;

• Shift+F8 – allows to setup brightness, contrast and gamma.

For selective points deletion it is necessary to select at least one type of triangulation points
in each of three subsections: By measurement type, By coordinate type and By meas-
urement mode.

In the Select points section select triangulation point types to be deleted from the
following list:

• By measurement type:

○ All – all points of all measurement types on selected images according to co-
ordinates type, measurements method and deletion mode.

Points type is determined by the whole block, rather than by selected images.

○ Strip points:

■ ties on selected images – in-strip tie points on selected images, i.e. points
that contain two or more coordinates measurements on images selected in-
side a strip;

■ isolated – points with a single measurement on selected images;

■ on stereopairs – stereopair tie points, including those that have non-adjacent
measurement in strip;

■ on triplets – all measurements of triplet points, including measurements on
non-adjacent images inside a strip;

■ with non-adjacent measurements – in-strip tie points, with one at least
non-adjacent measurement.

○ Interstrip points:
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■ All interstrip ties – all interstrip tie points, if at least one coordinates
measurement of each point falls into selected images;

■ Interstrip ties for selected strips – interstrip tie points, if all coordinates
measurement of each point falls into selected images (strictly inside the im-
age);

■ Ties on selected images – interstrip tie points, that have two or more
measurements on selected images;

■ With non-adjacent and isolated measurements – interstrip tie points,
without stereopair measurements;

■ On stereopair – interstrip tie points, that havemeasurements on a stereopair,
but without triplet, isolated or non-adjacent measurements;

■ On triplet – interstrip tie points, that have measurements on a triplet, but
without isolated or non-adjacent measurements;

■ On stereopair, isolated, non-adjacent – interstrip tie points, that have
stereopair and isolated measurements; interstrip tie points, that have stereo-
pair and non-adjacent measurements.

○ Additionally:

■ Excluded as tie – all tie points on selected images, excluded by tie in the
Triangulation points window.

• Also:

○ All without measurements on images – coordinates measurements of GC
points, located on none of block images of the project (for example, measure-
ments left after deletion images from the block).

• By coordinate type:

○ Tie;

○ Ground control;

○ Check;

○ Excluded as control.

• By measurement mode:

○ Manual – to delete manually measured points;
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○ Automatical – to delete automatically measured tie points.

In the Delete mode section select points deletion mode:

• Delete measurements of selected points:

○ All – to delete all measurements of selected points, if at least onemeasurement
of selected point coordinates is located on selected images;

In this case all measurements of selected points coordinates will be marked
by red color on the graphic scheme.

○ On selected images – to delete measurements of selected points only on
selected images;

If tie point have only one measurement (out of selected images), it will be also deleted.
Such single measurements are marked by yellow cross on the graphic scheme.

○ only non-adjacent and isolated – to delete measurements of selected points
on non-adjacent images, as well as isolated measurements, including inter-
strip ones, that have no “ties” inside strip.

• Delete measurements for points with coordinates:

○ measurements only – used to delete only coordinates measurements of se-
lected points;

○ points completely – used to delete selected points completely along with their
measurements and records shown in the catalogue of the Triangulation points
window (for GCP, check, excluded GC points).

4. Click OK. The system shows warning with request for deletion, and with information
about number of points to be deleted. Click the Yes button to delete selected points,
and the No button to go back to the Delete points measurements window or the
Cancel button, to close the window and cancel points deleting. After operation
completion the system shows detailed information about deleted points.

6.7.2. Deleting points at image boundaries

Selective point deleting allows to delete points of selected types from near-boundary
areas of project images marked in the list.

For selective point deleting from near-boundary areas of images, perform the following
actions:

1. [optional] select the images on the near-boundary areas of which it is needed to
delete triangulation points;
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2. Choose Orientation › Delete border points. The Delete border points window
opens:

Fig. 121. Setting triangulation point deletion at the near-boundary areas of the selected images

3. Set the sizes of areas at the image boundaries where triangulation points are to be
deleted, in percent;

4. Set an appropriate checkboxes to delete points of followed types:

• Manual – to delete manually measured points;

• Automatical – to delete automatically measured tie points;

• Ground control;

• Check.

5. [optional] set the on selected images checkbox to delete points only within the
near-boundary areas of the selected images, otherwise points would be deleted
within the near-boundary areas of every project image.

6. Click OK. The system shows the warning with request for deletion, and with inform-
ation about the number of points to be deleted. Click the Yes button to delete selec-
ted points, and the No button to go back to the Delete border points window.
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Fig. 122. The window showing the number of points to be deleted

6.7.3. Removing point duplicates

The system provides for merging tie points having the same coordinates (user-specified
accuracy).

Tie point having the same coordinates (and different names) can appear during project processing
due to operator’s errors, for example, in the case of repeated import of triangulation points.

To check for tie point duplicated and further merge of duplicates, perform the following:

1. ChooseOrientation › Delete duplicated points. TheDelete tie-points duplicates
window window opens:

Fig. 123. The Delete tie-points duplicates window

2. In the pixel precision field, enter the accuracy that the identity of points will be
determined with;

3. Choose the method to merge points:

• Merge points with the same measurements in same-name images;

• Merge points having at least one coinciding measurement.

4. Click OK. When the operation is complete, an appropriate info message appears.
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7. Data import and export

7.1. Import of triangulation points

7.1.1. Import of triangulation points from PAT-B

The system provides possibility to import triangulation points coordinates (and meas-
urements) from files of PAT-B format.

Perform the following actions to import measurements:

1. Choose Orientation › Import › Import tie points from PAT-B... or click the arrow
to the right from the button of the Tie points tab toolbar in the Triangulation
pointswindow and choose Import from PAT-B. The Import measurements from
PAT-B window opens.

Fig. 124. Import measurements from PAT-B

2. Set the File with point coordinates checkbox to import geodetic coordinates of
GC points. Click the button to select file to be imported with *.xyz, *.txt, *.csv
extension (see format description in Section C.1.1).

Description of the files with *.pat extension (created in Trimble Inpho software) see in
Section 7.1.2.

If there is a coordinate system different from source one (left/right), set the Swap X Y
checkbox to swap X and Y coordinates.

If the Swap X Y checkbox is cleared, GC and tie points coordinates are imported in the
right coordinate system. Otherwise, in the left one.
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3. Set the File with measurements checkbox to import point coordinates measure-
ments. Click the button to select a file with *.mea, *.txt, *.csv extension (see
format description in Section C.1.2). Specify measurement units of points coordin-
ates, that used in image coordinate system – pix,mm ormcm. If the measurements
consider distortion correction and principal point shift, set the Refined camera co-
ordinates checkbox.

The file can contain measurements of both GCP and tie points.

Description of the files with *.pat extension (created in Trimble Inpho software) see in
Section 7.1.2.

4. [optional] In order to select file, which contains images names (numbers) from se-
lected files with geodetic coordinates and point coordinates measurements set the
File with list of correspondent PAT-B and PHOTOMOD image names checkbox
and click the button.

A filename of images names correspondence should be set in the form of
Name_in_PAT_B,Name_in_PHOTOMOD. At that both comma and space could be used
as a delimiter between PAT-B and PHOTOMOD names, but space between images names
should not be used.

Fig. 125. Example of file of images names correspondence

5. Select actions to be performed in case of coincidence of images/points names in
file with existing images/points names in a project: Replace, Skip, Rename.

6. Click OK. Imported points are added to triangulation points list.

7.1.2. Import of triangulation points from PAT-B (Trimble Inpho)

The system provides possibility to import triangulation points coordinates (and meas-
urements) from files of PAT-B format with *.pat extension (created in Trimble Inpho
software).

Perform the following actions to import measurements:

218

Aerial triangulation (Windows x64)PHOTOMOD 8.0



1. Choose Orientation › Import › Import tie points from PAT-B... or click the arrow
to the right from the button of the Tie points tab toolbar in the Triangulation
pointswindow and choose Import from PAT-B. The Import measurements from
PAT-B window opens.

Fig. 126. Import measurements from PAT-B

2. Set the File with point coordinates checkbox to import geodetic coordinates of
GC points. Click the button to select the cont.pat file (see format description
in Section C.2.1).

If there is a coordinate system different from source one (left/right), set the Swap X Y
checkbox to swap X and Y coordinates.

If the Swap X Y checkbox is cleared, GC and tie points coordinates are imported in the
right coordinate system. Otherwise, in the left one.

3. Set the File with measurements checkbox to import point coordinates measure-
ments. Click the button to select the images.pat file (see format description in
Section C.2.2). Specify measurement units of points coordinates, that used in image
coordinate system – pix, mm or mcm. If the measurements consider distortion
correction and principal point shift, set theRefined camera coordinates checkbox.

The file can contain measurements of both GCP and tie points.

4. [optional] In order to select file, which contains images names (numbers) from se-
lected files with geodetic coordinates and point coordinates measurements set the
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File with list of correspondent PAT-B and PHOTOMOD image names checkbox
and click the button.

A filename of images names correspondence should be set in the form of
Name_in_PAT_B,Name_in_PHOTOMOD. At that both comma and space could be used
as a delimiter between PAT-B and PHOTOMOD names, but space between images names
should not be used.

Fig. 127. Example of file of images names correspondence

5. Select actions to be performed in case of coincidence of images/points names in
file with existing images/points names in a project: Replace, Skip, Rename.

6. Click OK. Imported points are added to triangulation points list.

7.1.3. Import of triangulation points from X-Points

The system provides possibility of import of tie and GC points coordinates from X-Points
files.

To perform measurements import perform the following actions:

1. Choose Orientation › Import › Import tie points from X-Points... click the drop-
down arrow next to the button of the Triangulation points window toolbar (in
any of the both tabs) and select Import from X-Points.... The Input file window
opens.

2. Choose triangulation points file *.x-points and click the Open button. The Import
measurements from X-Points format window opens.
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Fig. 128. Import measurements from X-Points format

3. When using points import from another project specify the way of matching images
names in the X-Points file and images names in the project:

• By name;

• By code;

• Use correspondence file.

In order to use correspondence file click the button and select file with filenames.

4. Select actions to be performed in case of coincidence of images/points names in
file with existing images/points names in a project: Replace, Skip, Rename.

5. Click OK. Imported points are added to triangulation points list.

7.1.4. Import of tie points from PHOTOMOD 4.x XPT

The system provides possibility of import tie points catalogue from projects, created in
earlier versions the system likePHOTOMOD 4.x.

To perform import of triangulation points catalogue perform the following actions:

1. Choose Orientation › Import › Import tie points from PHOTOMOD 4.x XPT... or
click the drop-down arrow next to the button of the Tie points tab toolbar in the
Triangulation points window and choose Import from PHOTOMOD 4.x XPT....
The Input file window opens.

2. Choose triangulation points file *.xpt and click the Open button. The Import
measurements from XPT format window opens.
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Fig. 129. Import measurements from XPT

Choose points file and click OK. Imported points will be added to triangulation points
list.

3. Specify the way of matching images names in the *.xpt file and images names in
the project:

• By name;

• By code;

• Use correspondence file.

In order to use correspondence file click the button and select file with filenames.

4. Select actions to be performed in case of coincidence of images/points names in
file with existing images/points names in a project: Replace, Skip, Rename.

5. Click OK. Imported points are added to triangulation points list.

7.1.5. Import of GCP catalogue

The system provides import of GC points coordinates list from file with *.csv or *.txt
extension.

To perform import of GC points coordinates list from file perform the following actions:

1. Choose Orientation › GCP list or click the button of the main toolbar. The Tri-
angulation points window opens.

2. Click the button on the GCP list tab and choose Import from CSV. The Input
file window opens.

222

Aerial triangulation (Windows x64)PHOTOMOD 8.0



3. Select a file containing GCP catalogue and click OK. The Import GCP catalogue
window opens.

Fig. 130. Import of GCP catalogue

4. The Line template field displays a list of fields, contained in each line of the import
file:

• Name – object’s name;

If imported file does not contain a column with GCP names (numbers), then after import
operation the names like Point0001 are assigned to the points automatically.

• X Y Z – values of GC point coordinates by X, Y, Z;
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• STDDEVX, STDDEVY, STDDEVZ – accuracy of coordinates measurements by X, Y, Z
axes (RMS);

• * – missed field during import.

All objects are saved using the same template. Each line of a file contains the same
number of fields, that equals to number of fields in template. Lines which does not
correspond to the template, are skipped. To all vertexes two (for 2D objects import)
or three coordinates are specified.

In order to setup active template, perform one of the following actions:

• drag a field name from the Available fields list to the Preview file table column.
After that the template in the Line template field is changed. To cancel a field
selection, double click the Preview file table column;

• change a template manually in the Line template field. After that column types
in the Preview file table will be changed automatically.

The button is used to return to default template Name X Y Z.

The button is used to compare the Line template field with data shown in the
Preview file table.

Active template corresponds only lines shown in the Preview file table.

The button is used to replace specified fields names with fields names from the
first line of the Preview file table. It is possible to specify any names for vectors
import.

For import of laser scanning data the field names from the list of available names are
specified.
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Fig. 131. Setup of a template sample

For automatic selection of current template the Automatically validate template
checkbox is set by default. In order to setup a template for a file that contains lines
with different number of columns, clear the Automatically validate template
checkbox and setup the template manually in the Line template field.

In order to define a line from which to start data import, input the line number to the
Start import from line field.

In order to display necessary number of lines in the Preview file table, set the
Preview maximum parameter. 10 lines are displayed by default.

In the Available fields section select desired field name and drag it on a table
column. To cancel the selection of the field name double click the column header.

In the Field separators section set single or multiple checkboxes to specify field
separators in the file: comma, space, tab, semicolon or other. The comma and
space are set by default.

In the Decimal separator section set the following parameters:

• Point only – to use only a point as a decimal separator in coordinates;
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• Point or comma – to use both a point and a comma as a decimal separator in
coordinates.

If the Field separator is selected as a comma, it is not recommended to specify the
Decimal separator as a comma, since objects with incorrect coordinates will be created
after import operation.

In the Misc section set the following checkboxes:

• UTF-8 – is used to recognize text in Unicode coding;

• Parse degrees minutes seconds – is used to recognize records from the list
of projection centers or GCP.

When using this parameter it is highly recommended to check recognizing correctness
after import operation.

The Preview file table contains data of imported file. Fields type according to the
template, located in the Line template field, are automatically assigned to the table
columns.

The * symbols marks columns with data which is not imported.

5. In the Points with existing names section specify actions to perform when names
of imported GC points coincide with points names already existing on the GCP list
tab:

• Replace – allows to replace a point with the same name in the list, i.e. the point
data will be updated;

• Skip – allows to cancel import of GCP with the same name.

6. [optional] To prevent creating text attributes without value during import, set the Do
not create empty text attributes checkbox on.

When the Do not create empty text attributes checkbox is on, in some cases a data loss
may occur.

7. [optional] To convert coordinate system set the Convert coordinate system
checkbox and specify source and output coordinate systems.

8. Click OK. The Import ground control points window opens, which contains the
GCP table to be added. Points which names are the same as names of existing
GCP in the GCP list of the Triangulation points window are shown by red color,
new GCP – by black color.
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Fig. 132. Selecting GCP to be added to the list

9. Select points to be imported using checkboxes and/or standard selection tools.
Click OK. After that coordinates of GC points with set checkboxes will be loaded in
the end of the GCP list.

If in the Points with existing names section the Skip parameter is selected, then only
new GCP are selected for adding by default, if the Replace parameter is selected, all GCP
checkboxes are selected to be added.

If RMS of X, Y, Z coordinates was not imported or is absent in GCP file, then default value
of RMS for all coordinates is 0.2 meters.

7.2. Export of triangulation points

7.2.1. Export of tie points to PAT-B

The system provides possibility to export tie points from current project to a file of PAT-
B format.

If a project contains points with name in text format (the Name column contain letters), select
these points and click the button of the Triangulation points window toolbox. After that nu-
meric names will be assigned to selected points.

To export coordinates measurements of triangulation points to PAT-B format perform
the following actions:

1. Choose Orientation › Export › Export tie points to PAT-B... or click the drop-
down arrow next to the button of the Tie points tab toolbar in the Triangulation
points window and select Export to PAT-B. The Export measurements to PAT-
B window opens.
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Fig. 133. Export measurements to PAT-B

2. Set the File with point coordinates checkbox to export coordinates of measured
GCP to file with *.xyz extension and click the button, specify filename and its
location out of active profile resources (see also the description of the file format
which contains geodetic coordinates in Section C.1.1).

If there is a coordinate system different from source one (left/right), set the Swap X Y
checkbox to swap X and Y coordinates.

If the Swap X Y checkbox is cleared, GC and tie points coordinates are exported in the
right coordinate system. Otherwise, in the left one.

3. Set the File with measurements checkbox to export coordinates measurements
of all triangulation points to file with *.mea extension and click the button. Then
specify filename and its location out of active profile resources (by default, the
system suggests location at the same folder with file of geodetic coordinates). A
description of the file format see in the Section C.1.2. Specify measurement units
for point coordinates measurements, that are used in images coordinate system
and select pix, mm or mcm. If the measurements consider distortion correction
and principal point shift, set the Refined camera coordinates checkbox.

4. [optional] To change file names with *.xyz and *.mea extensions all at once set the
Synchronize file names checkbox. After that when one file name is changed, an-
other file name will automatically receive the same name.

5. [optional] In order to export just selected points from the Triangulation points
window, set the Export selected points only checkbox.

6. Click OK to complete the export operation.
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7.2.2. Export of triangulation points to X-Points

The system provides possibility to export triangulation points from current project to a
file of X-Points format. It is possible to export all or just selected points from triangulation
points catalogue, including points with unknown coordinates.

To export all triangulation points of the current project perform the following actions:

1. Choose Orientation › Export › Export tie points to X- Points.... The Export
measurements to X- Points format window opens.

2. Click the button, specify filename and its location out of active profile resources.

3. Click OK to export triangulation points to specified file.

To export only selected triangulation points perform the following actions:

1. Open the Triangulation points (any of the both tabs).

2. Select triangulation points in catalogue, using the Shift key to select multiple points
at once or the Ctrl key to add multiple points to already selected ones.

3. Click the drop-down arrow next to the button of the Triangulation points win-
dow toolbar and select Export to X-Points.... The Export measurements to X-
Points format window opens.

Fig. 134. Export selected triangulation points to X-Points file format

4. Click the button, specify filename and its location out of active profile resources.

5. Set the Export selected points only checkbox if it is not set automatically.

6. Click OK to perform export of selected points.

7.2.3. Export of tie points catalogue to CSV

The system provides possibility of tie points table export from the current project to a
file with *.csv or *.txt extension.
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To export tie points table of current project perform the following actions:

1. Click the drop-down arrow next to the button of the Tie points tab toolbar in the
Triangulation points window and select Save active view as CSV.... The Save
window opens.

2. Define a filename and its location out of active profile resources.

3. Click Save to export table to specified file.

7.2.4. Export of GCP catalogue to CSV

The system allows to perform export of GCP list from current project to file with *.csv
or *.txt extension.

To perform export of GCP list click the button on theGCP list tab of the Triangulation
points window and select Export to CSV.... . The Export GCP catalogue window
opens. Specify a name of text file and its placement out of active profile resources. Click
Save to export GC points to specified file.

GC points are exported to text file with the following list of fields:

NAME, X, Y, Z, CODE, TYPE, STDDEVX, STDDEVY, STDDEVZ, where:

• NAME – GC point name;

• X, Y, Z – coordinates values (the * symbol is used to mark absent coordinates values);

• CODE – a point’s code;

• TYPE – GC point type (control – GCP, check – check);

• STDDEVX, STDDEVY, STDDEVZ – RMS of GCP coordinates.

In the sample shown below the comma symbol is used as fields separator, and the full
stop is used as decimal point. The first row contains fields headers.
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Fig. 135. Sample of GCP catalogue exported to text file

7.3. Export triangulation points to PHOTOMOD Geomosaic

7.3.1. Export of project tie points to PHOTOMOD Geomosaic

The system provides possibility of quick export of project triangulation points to Geo-
Mosaic and to use them as tie points there.

To export coordinates measurements of project triangulation points to GeoMosaic,
perform the following actions:

1. Choose Orientation › Export › Load triangulation points as GeoMosaic tie
points. The Load triangulation points window opens.

Fig. 136. Load triangulation points as Geomosaic tie points

2. [optional] To export triangulation points from GCP list (see the Section 4.3) the
Ground control point catalogue checkbox is set by default.

3. [optional] To export triangulation points from the Block scheme layer in 2D-window,
the Block scheme checkbox is set by default.
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4. [optional] To export adjusted points coordinates fromGCP catalogue theAdjustment
results checkbox is set by default.

5. Click OK. The system displays information window containing information about
added or skipped points.

6. Click OK. The Triangulation points (Vectors) layer is created. Vector point objects
(triangulation points) are displayed on block scheme in 2D-window. When creating
a project in GeoMosaicusing project images there is a possibility to use the Trian-
gulation points (Vectors) layer as tie points.

7.4. Export of raster outlines of triangulation points

The system allows to create raster outline of triangulation points (as georeferenced
raster images and corresponding world files). Optionally, when outlines are created,
the corresponding triangulation points also are exported to PAT-B and / or CSV files
(see above).

World file is a text file used for georeferencing raster images (raster maps, orthophoto
maps) in geoinformation systems. The name of the world file must match the georefer-
enced image name. There are several ways to set the world files extension:

• The extension is set by the first and last letter of the georeferenced file with the letter
“w” (as in “world”) at the end:

○ image1.png corresponds to the world file image1.pgw;

○ image1.tif corresponds to the world file image1.tfw;

○ image1.rsw corresponds to the world file image1.rww;

○ image1.ntf corresponds to the world file image1.nfw;

○ image1.bmp corresponds to the world file image1.bpw.

This method is used by the system when exporting outlines.

• The extension is set by adding the letter “w” to the georeferenced file extension: image
“image2.jpg” corresponds to the world file “image2.jpgw“;

• The *.wld extension is assigned to the world file: the “image3.jpg” image corresponds
to the world file “image3.wld“;

To export the raster outlines of the triangulation points, take the following steps:

1. [Optional] Select the triangulation points in the directory using the Shift key to select
multiple points at the same time, orCtrl to add multiple points to the already selected
points;
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2. Click the button on the Tie points catalog tab in the Triangulation Points. The
Outlines export window opens;

Fig. 137. The outlines export window

3. Click the button to specify the names of the export files and their location outside
the active profile;

4. [Optional] To export triangulation points to a PAT-B file the Save as Pat-B (*.xyz)
checkbox is set by default;

5. [Optional] Set the Save As CSV (*.csv) checkbox to export triangulation points to
a CSV file (see Section 7.2.3 and Section 7.2.4);

6. [Optional] Set theUse image name as suffix checkbox to use of one of the images
names where the triangulation point is located as a suffix to the name of the corres-
ponding raster outline;
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7. Choose Outline format – BMP (by default), GeoTiFF, RSW, PNG or NITF;

8. Specify Pixel size in pixels;

9. Specify Outline size in pixels;

10. [Optional] Check the Export selected checkbox to create the outlines of the points
selected in the catalog only (see paragraph 1);

11. Set Points type to create a raster outline by checking the corresponding check-
boxes:

• Ground control point – to create raster outlines of all ground control points;

• Check point – to create raster outlines of all check points;

• Tie point – to create raster outlines of all tie points;

• Targeted point – to create raster outlines of all densification points (see the “Point
properties” chapter);

• Unused tie point – to create raster outlines of all triangulation points that are
not used in georeferencing (see the “Point properties” chapter);

• Coordinates not used – to create raster outlines of all triangulation points ex-
cluded from orientation (see the “Point properties” chapter);

• Measured automatically – to create raster outlines of all automatically measured
triangulation points (see the “Point properties” chapter);

To create outlines and / or export files, you must set at least one point type.

12. [Optional] Check the checkbox Labeling outline centers by symbols if labeling
outline centers is necessary. Specify the following parameters for labeling outline
centers:

• Symbol shape – Circle or Cross;

• Symbol color;

• Symbol size;
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Fig. 138. Different ways of labeling outline centers

13. Click OK. Separate raster outline files for all selected triangulation points are created
along with corresponding world files, corresponding csv-files (containing center
coordinates for the separate outline), as well as joint export files for triangulation
points in PAT-B and / or CSV formats (optionally).

The names of the raster outline files, depending on the export settings, can be different,
for example:

• “7777_3899_3900_0002_1834.bmp” or

• “7777_3899_3900_0002_1834_fly1_MIIGAiKDSC03900.bmp”

Where:

• “7777” is the specified name of the export files;

• “3899_3900_0002_1834” is the name of the triangulation point in the directory;

• “fly1_MIIGAiKDSC03900” is a suffix composed of one of the images names where the
triangulation point is located (if the corresponding checkbox was set).

7.5. Import and export of exterior orientation parameters

7.5.1. Import of exterior orientation parameters

When accurate enough exterior orientation parameters of block images are available,
it is possible to skip steps of GCP and tie coordinates measurement, as well as block
adjustment step from the workflow and proceed right away to steps of stereovectorization,
DEM and orthomosaic generation (see how to estimate accuracy of imported exterior
orientation parameters in Section 7.5.4). Otherwise, if there are inaccurate exterior ori-
entation parameters of block images, imported exterior orientation parameters are used
to block scheme refinement.

There are the following conditions of successful import of exterior orientation parameters:

• correct images exterior orientation;

• terrain elevation difference data (Zmin, Zmax in meters), which should be specified
either on project creation step (see the “Project creation” User Manual), or directly
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during import of exterior orientation data in the Import exterior orientation paramet-
ers window.

When terrain elevation difference on block images is more than 1/10 of flight altitude, it is
recommended to use GSD data to block layout creation using imported data (see the Sec-
tion 2).

In general case perform the following steps to import images exterior orientation para-
meters:

1. Choose Orientation › Direct georeferencing or click the button of the AT
toolbar. After that the information window opens, it contain information about number
of images adjusted using exterior orientation parameters.

If a project contains measured tie points, their relative orientation is performed automatically.

2. Perform accuracy control of imported exterior orientation parameters.

3. Depending on quality of imported exterior orientation parameters, perform one of
the following steps:

• if the exterior orientation parameters are precise enough, pass to project pro-
cessing (to stereovectorization, DEM generation and orthomosaic creation);

• otherwise, perform steps of tie and GC points measurement and then block ad-
justment, after that pass to project processing step.

To import exterior orientation parameters to a project perform the following actions:

1. Choose Orientation › Import exterior orientation or click the button in the
Exterior orientation parameters window. The Open window opens.

2. Select a file containing exterior orientation parameters and click OK. The Exterior
orientation import – Step 1 of 3: File window opens. The File name input field
displays selected file placement and name. To select another file which contains
exterior orientation parameters, click the button.

If the imported data contains information about time stamps, this information must be
presented in Unix time (POSIX time) format.

Unix time is represented by an integer that increments with each passing second. The in-
teger system used is convenient for comparing and storing dates.

If one needs to access date elements (day, month, year), seconds can be converted into
any suitable format (and vice versa). A signed integer type is used in programs to store
Unix time.
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Fig. 139. Exterior orientation import – Step 1

3. [optional] If images names in file and in project are not the same, perform one of
the following actions:

• set the Loose matching of image names in file against names in project
checkbox. The system performs search for common substrings and matches
images names. For example, it searches for common substring 018_02595 in
image name RGBI_018_02595 in file and image name 018_02595 in project.

If the Loose matching of image names in file against names in project checkbox is
set the image name with file extension is also imported.
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• set the Match by record number checkbox and click the Setup... button. The
Match images by numbers window opens.

Fig. 140. Images matching by numbers

1. In the Numbers in the file section set the following parameters:

○ Serial numbers of records matching the template – used to match a
list of records numbers in a file by order;

○ Read from the Name field – used to match a list of records numbers in
a file by the last number from the filename.

2. In the Numbers of images in the project section set the following paramet-
ers:

○ Serial numbers of images – used to match a list of records numbers in
a project by order;

○ Read from images names – used to match a list of records numbers in
a project by the last number from the filename.

3. Input necessary parameters to the File recordwith the number andmatches
project image with number input fields.

For convenient setup of necessary parameters it is recommended to place windows
in that way that allows to display on screen a name of the first image in the table
of the Exterior orientation parameters window, and also allows to display first
rows in the Preview file table of the Exterior orientation import window. It is re-
commended to place the Match images by numbers window in such a way that
allow to show both windows mentioned above.

4. Choose one of the following formats to specify a type of imported file:
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• PAT-B matrix – file containing coordinates of projection centers and rotation
matrices (see Section B.1).

[optional] If the PAT-B file contains exterior orientation parameters, calculated
for negative plane, set the Negative checkbox and pass to the step 10.

• CSV (projection centers, Omega/Phi/Kappa angles and GPS-time) – file
containing coordinates of projection centers in any coordinate system, as well
as exterior orientation parameters, and precise time from GPS-receiver.

CSV format is exchange text format with *.csv extension, which is supported by
major applications in different industries. It is used as exchange format when
special geospatial data formats are not applicable for some reason.

• CSV (navigation data: latitude/longitude/altitudeWGS-84, heading/pitch/roll
angles and time) – file containing navigation data (latitude/longitude set in de-
grees, altitude in meters, angles in degrees, radians or gons) and precise time
from GPS-receiver.

To perform import of exterior orientation parameters it is necessary that a project is in
coordinate system consistent with WGS-84 coordinate system.

• CSV (navigation data: projection centers in working c.s., heading/pitch/roll
angles and time) – file containing navigation data (coordinates of projection
centers in project coordinate system, angles in degrees, radians or gons) and
precise time from GPS-receiver.

5. [optional] If data is imported from *.csv format, it is necessary to setup a current
line template. The Line template field displays a list of fields, contained in each
line of the import file.

All objects are saved using the same template. Each line of a file contains the same
number of fields, that equals to number of fields in template. Lines which does not
correspond to the template, are skipped.

In order to setup active template, perform one of the following actions:

• drag a field name from the Available fields list to the Preview file table column.
After that the template in the Line template field is changed. To cancel a field
selection, double click the Preview file table column;

• change a template manually in the Line template field. After that column types
in the Preview file table will be changed automatically.

The button is used to return to default template.
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The button is used to compare the Line template field with data shown in the
Preview file table.

Active template corresponds only lines shown in the Preview file table.

The button is used to replace specified fields names with fields names from the
first line of the Preview file table.

For automatic selection of current template the Automatically validate template
checkbox is set by default. In order to setup a template for a file that contains lines
with different number of columns, clear the Automatically validate template
checkbox and setup the template manually in the Line template field.

In order to define a line from which to start data import, input the line number to the
Start import from line field.

In order to display necessary number of lines in the Preview file table, set the
Preview maximum parameter. 10 lines are displayed by default.

In the Available fields section select desired field name and drag it on a table
column. To cancel the selection of the field name double click the column header.

In the Field separators section set single or multiple checkboxes to specify field
separators in the file: comma, space, tab, semicolon or other. The comma and
space are set by default.

In the Decimal separator section set the following parameters:

• Point only – to use only a point as a decimal separator in coordinates;

• Point or comma – to use both a point and a comma as a decimal separator in
coordinates.

If the Field separator is selected as a comma, it is not recommended to specify the
Decimal separator as a comma, since objects with incorrect coordinates will be created
after import operation.

In the Misc section set the following checkboxes:

• UTF-8 – is used to recognize text in Unicode coding;

• Parse degrees minutes seconds – is used to recognize records from the list
of projection centers or GCP.

When using this parameter it is highly recommended to check recognizing correctness
after import operation.
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The Preview file table contains data of imported file. Fields type according to the
template, located in the Line template field, are automatically assigned to the table
columns.

The * symbols marks columns with data which is not imported.

6. Click the Next button. The Exterior orientation import – Step 2 of 3: Import
settings window opens.

Fig. 141. Exterior orientation import – Step 2

7. In the Angles section specify measurement units for angles coordinates according
to data of the file to be imported:

• radians;

• degrees;

• gons – plane angle measurement unit that equals to 1/100 of flat right angle
measurement unit, and full angle is 400 gons.

8. [optional] In order to make correction to kappa angle, set the Add to the kappa
angle checkbox and input correction value to the input field.
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9. [optional] In order to Invert sign for angles Omega, Phi and/or Kappa, set corres-
ponding checkboxes.

10. [optional] In the Precision (std.dev.) section set an appropriate checkboxes to
change precision of a priori RMS of measurements of projection centers coordin-
ates and exterior orientation angles.

If Projection centers and Exterior orientation angles checkboxes are cleared, the ap-
propriate data are imported from the file (if the data are available and the import parameters
are correctly configured in the Exterior orientation import – Step 1 of 3: File window).
Imported data may differ from image to image. If the checkboxes are set, the values
manually specified by a user are used during import (the same for all images).

11. If import of exterior orientation parameters is performed using the Exterior orient-
ation parameters window, then click the Execute button. After that the exterior
orientation parameters are imported to the list of exterior orientation parameters.

If import of exterior orientation parameters is performed using the Orientation ›
Exterior orientation import...menu item, then click the Next button. The Exterior
orientation import – Step 3 of 3: Additional actions window opens.

Fig. 142. Exterior orientation import – Step 3

12. Select and set the following checkboxes to perform automatic execution of these
actions just after import of exterior orientation parameters from file:

• Split block into strips by EO data – to split block images into strips using im-
ported exterior orientation parameters (if all images were loaded to a single strip
on a step of project creation);

• Create block layout by EO data – to create block layout considering imported
exterior orientation parameters;
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• Adjust block based on imported EO data – to perform block adjustment using
imported exterior orientation parameters;

• Rotate images in block scheme by block layout – to re-create a block scheme
in 2D-window using block layout (this checkbox is available if the Create block
layout by EO data is set).

13. Click the Execute button. After that the exterior orientation parameters are imported
to the list of exterior orientation parameters .

14. Estimate accuracy of imported exterior orientation parameters by block layout, by
measured GC points coordinates and/or by values of vertical parallax during
measurement of coordinates of multiple tie points.

7.5.2. Import of orientation parameters for data obtained by UltraCam
Osprey

During UltraCam Osprey data processing, import of exterior and interior orientation
parameters is carried out from a separate file with *.eo extension.

UltraCam cameras employ the syntopic exposure principle of imagery collection when the final
image is composed form several fragments obtained sequentially by the system of several lens
and panchromatic CCD-sensors as they pass over the same point of space.

TheUltraCamOspreymodel is used for simultaneous vertical and oblique imaging. The camera
allows for obtaining orthophotomaps and textured digital terrain models.

To import orientation from the *.eo file, it is necessary to check the structure of the file to be
imported and correlate the names of images uploaded to the project with the names of images
if the file.

The process of import of orientation for UltraCam Osprey imagery is described below. When
processing data collected by other cameras from the UltraCam family, the orientation can be
presented as metadata, e.g. contained in raster image files of the camera.

An *.eo file can be viewed using standard word processor.

To import orientation from an *.eo file, perform the following:

1. Choose Orientation › Import UltraCam Osprey orientation. Select the *.eo file
and click OK. ImportUltraCamorientation—Step 1 of 3: Data correlationwindow
opens:
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Fig. 143. The UltraCam orientation — Step 1 of 3: Data correlation window

The UltraCam orientation — Step 1 of 3: Data correlation window contains the
following elements:

• The Correlated image names table containing the list of names of images up-
loaded to the project (In project column) and the list of matching names of images
from the file (In file column). The names of images uploaded to the project for
which the relevant data in the file were not found are highlighted in yellow;

• The Unfound image names in file table containing the list of image names in
file except for those matched against the names of imagery uploaded to the
project (Correlated image names table, In file column).

• Buttons and used to match/clear matching image names in project against
image names in file;

• The Reset button is used for canceling all user actions undertaken during
manual matching of image names.

2. [optional] To match the name of the image uploaded to the project against the name
of the image in file, perform the following:

• Select a row in the Correlated image names table which contains wanted name
of the image uploaded to the project by left mouse button click;

For matching operation, both the rows of unmatched names highlighted in yellow and
the rows of matched names (e.g. in case of incorrect matching) are available.

The system provides possibility to perform matching of several pairs of image names
at once.
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• Select a row in the Unfound image names in file table which contains wanted
name of the image in file by left mouse button click;

• Click the button to match image names. Data in both tables will be updated.

3. [optional] To clear the matching between a pair of image names, in the Correlated
image names table select a row containing the appropriate pair of names (by left
mouse button click) and click the button. Data in both tables will be updated;

The system allows to clear matching of several pairs of image names at once.

4. [optional] To cancel all user actions undertaken during manual matching of image
names, click the Reset button;

5. Click theNext button. TheUltraCamorientation—Step 2 of 3: Import parameters
window opens;

Fig. 144. The UltraCam orientation — Step 2 of 3: Import parameters window

6. [optional] Set the Correct center values checkbox in the Camera position influ-
ence section, if needed;

7. [optional] Set theCorrect angle values checkbox in theCamera position influence
section, if needed;
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8. [optional] In the Precision (std.dev.) section change precision of a priori RMS of
measurements ofProjection centers coordinates andExterior orientation angles.

To cancel automatic setting of the same precision by all axes, clear the Uniform precision
by all axes checkbox.

9. Click theNext button. TheUltraCamorientation—Step 3 of 3: Additional actions
window opens;

Fig. 145. The UltraCam orientation — Step 3 of 3: Additional actions window

10. [optional] set the Split into strips checkbox to split block images into strips (if all
images were loaded to a single strip on a step of project creation). Strips recognition
could be made by the following methods:

• By image names – allows to split images into strips using images names;

• By exterior orientation – allows to split images into strips by imported exterior
orientation parameters;

○ EnterMax angle deviation in degrees to account for deviations due to survey-
ing aircraft evolution.

Too large values of maximum deviation angle may result in errors in the splitting of
imagery taken by vertical and oblique cameras into strips.

Unsorted images are to be added to strips having names of unsorted_X type, where
X is the number of a strip containing unsorted images.
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• Auto mode – allows to split images into strips using both images names and
imported exterior orientation parameters.

11. [optional] set theCreate block layout by EO data to create block layout considering
imported exterior orientation parameters;

12. [optional] set the Adjust block based on imported EO data to perform block ad-
justment using imported exterior orientation parameters;

13. [optional] set the Rotate images in block scheme by block layout to re-create a
block scheme in 2D-window using block layout.

This checkbox is available if the Create block layout by EO data is set) .

14. Click Execute.

7.5.3. Import orientation from metadata

Source project images (in TIF format or in system’s internal format MS-TIFF) might
contain metadata. The metadata may be contained in raster images acquired by Ul-
traCam camera, as well as in UAS images of EXIF format.

Metadata of digital maps – is data that allows to describe content, volume, position in space,
quality and other features of digital maps, as well as geodetic, gravimetric, photogrammetric
and cartographic data, which is used during creation (updating) and application of digital maps.

If images containing metadata are available in a project, it is possible to import from
the metadata to the project parameters of interior orientation (precise) and exterior ori-
entation (approximate, i.e. calculated by on-board devices). Metadata for project raster
images (file with *.md extension) are stored in the folder, which contains these images.

Exterior orientation parameters imported from images metadata allow to split a project
on strips using imported exterior orientation, rotate images by block layout using imported
data, adjust block scheme by imported exterior orientation parameters, and proceed to
block processing step, that also includes stereo vectorization.

Prior to orientation data import from images metadata it is recommended to specify height dif-
ference of terrain in the project in the Project properties window (see the “Project creation”
User Manual).

To perform import of orientation data from images metadata perform the following ac-
tions:

1. ChooseOrientation › Import orientation frommetadata. The Import orientation
from metadata window opens.

247

Aerial triangulation (Windows x64)PHOTOMOD 8.0

project.pdf


Fig. 146. Import orientation from metadata

2. [optional] To perform images interior orientation to a project, the Import interior
orientation checkbox is set by default. Set the Replace existing data checkbox
to replace interior orientation data that already exists in the project.

If the project already contains file with name containing camera serial number, then it is
recommended to create backup of this file if the Replace existing data checkbox is set.

3. [optional] To perform images exterior orientation to a project, the Import exterior
orientation checkbox is set by default. Set the Replace existing data checkbox
to replace exterior orientation data that already exists in the project.

If the project already contains file with name containing camera serial number, then it is
recommended to create backup of this file if the Replace existing data checkbox is set.

Set the Import EO angle values, if needed.

To perform import of exterior orientation parameters it is necessary that a project is in co-
ordinate system consistent with WGS-84 coordinate system.

4. Click OK. After that the exterior and interior orientation parameters are imported
from images metadata to the project. At that a camera file with name containing
camera serial number is created for each project camera.

After orientation import from images metadata it is recommended to specify once more
height difference of terrain in the Project properties window (see the “Project creation”
User Manual)

7.5.4. Imported data accuracy control

In order to perform aerial triangulation in some cases it is necessary to perform import
of images exterior orientation parameters. After data import it is recommended to perform
imported data accuracy control using methods listed below.
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Accuracy control of block layout creation by exterior orientation parameters

To reveal blunders occurred during block layout creation, it is recommended to visually
estimate the block scheme, created by exterior orientation parameters (see the Sec-
tion 2). At that it is necessary to keep in mind that beside errors occurred during data
import, errors of interior orientation step, as well as errors of defining of terrain height
difference are also influence on block layout creation.

If visual control of a block scheme using block layout is satisfactory, it is necessary to
perform accuracy control of measured GCP coordinates, and control of vertical parallax
residuals on tie points.

Accuracy control of measured GCP coordinates

To reveal errors in GCP coordinates, use one of the following ways:

First way:

1. Measure coordinates of 2-3 GC points on block images (see the Section 5.3).

2. ChooseOrientation › Direct georeferencing. After that the system displays inform-
ation window, which contains information about number of images adjusted using
exterior orientation parameters.

3. Choose Orientation › Block adjustment or click the button. The Adjustment
toolbar opens.

4. Estimate residuals vectors on GC points (see the Block adjustment User Manual).

Second way:

1. Place marker on GC point in a block image in 2D-window.

2. Choose Orientation › GCP list or click the button of the main toolbar or the AT
additional toolbar. The Triangulation points window opens.

3. Compare GCP coordinates shown in the Triangulation pointswindowwith marker
coordinates displayed in status bar.

Control of vertical parallax residuals in stereomode

To reveal vertical parallax residuals on tie points:

1. Measure coordinates of 6-10 tie points on block images (see the Section 4).

2. ChooseOrientation › Direct georeferencing. After that the system displays inform-
ation window, which contains information about number of images adjusted using
exterior orientation parameters.
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3. Choose Orientation › GCP list. The Triangulation points window opens.

4. Choose tie point and open images containing measurements of selected tie point
using the button. The Points measurement module is opened.

5. Choose the “left” and active image of stereopair and click the button of the main
module toolbar. Selected stereopair is opened in a stereo window (see the Sec-
tion 4.4.3).

6. Click the button of the stereo window toolbar.

7. Estimate value of vertical parallax calculated on tie points in stereomode, shown
in the top right corner of the stereo window.

In mono mode residuals control is performed using the and buttons of the main
toolbar of the Points measurement window.

7.5.5. Export of exterior orientation parameters

The system provides possibility to perform export of list of source exterior orientation
parameters and adjustment results to PAT-B and CSV formats.

In order to export exterior orientation parameters from a project perform the following
actions:

1. Choose Orientation › Import exterior orientation or click the button in the
Exterior orientation parameters window. The Exterior orientation parameters
export window opens.
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Fig. 147. Exterior orientation parameters export

2. In the Data to export section select data to be exported:

• ext. orientation catalogue – used to export source data (projection centers co-
ordinates, exterior orientation angles, etc.);

• adjustment results – used to export adjusted projection centers coordinates
and exterior orientation parameters.

3. In the Export format set checkbox or both checkboxes to export data into chosen
formats:

• PAT-B – is exchange text format with *.ori extension, which is supported by
major applications in different industries (see Section B.1);

• CSV – is exchange text format with *.csv extension, when the data is represented
by table with specified list of fields.

4. Click the button, specify a filename and its placement out of active profile re-
sources.
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5. [optional] In order to setup a list of fields to be exported to CSV file, set the following
checkboxes:

• Image code – stated name of image;

• Image name – a name of image;

• Time – precise time from GPS-receiver;

• XYZ – values of projection centers coordinates in meters;

• XYZ type – type of projection centers coordinates;

• XYZ std.dev. – RMS error of projection centers coordinates in meters;

• Omega, phi, kappa angles – values of exterior orientation angles in degrees;

• Angles type – type of exterior orientation angles;

• Angles std.dev. – RMS error of exterior orientation angles.

To perform export of all fields, click the Select all button.

To clear all checkboxes click the Unselect all button.

To perform export of just fields with images numbers, projection centers coordinates
and exterior orientation angles, click the Name, XYZ, angles button.

6. [optional] To change file names with *.ori and *.csv extensions all at once set the
Synchronize file names checkbox. After that when one file name is changed, with
*.ori extension, for instance, file with *.csv extension will be renamed automatically.

7. [optional] To swap X and Y coordinates, set the Swap X Y checkbox.

If the Swap X Y checkbox is cleared, the data is exported in the right coordinate system.
Otherwise, in the left coordinate system.

8. Click OK. After that exterior orientation data is exported from thelist of exterior
orientation parameters to selected file.

7.6. Export of refined RPC-coefficients

The system provides the possibility to export refined RPC-coefficients after adjusting
a scanner project. Due to using GCP/tie points during the adjustment, RPC-coefficients
are refined and can be used along with project images in third-party software packages.

To export refined RPC-coefficients, perform the following:
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The export of refined RPC-coefficients is possible only for a scanner project adjusted using
RPC-coefficients (see the “RPC method” section in the “Block adjustment” User Manual).

1. Choose Orientation › Export images orientation to RPC. The Export to RPC
window opens:

Fig. 148. The Export to RPC window

2. Select destination folder for RPC export and click the Select folder button to
start exporting refined RPC-coefficients.

3. Select the output format:

• *.txt (IKONOS) – RPC-coefficients may be exported for all project images to a
folder specified by a user. RPC-coefficients are exported for each image to a
separate text file of the IKONOS format (this format is the most widely used
among all existing formats of RPC-coefficient recording/transmitting).

• RPB.

4. If the export is successful, an appropriate information message will appear. If refined
RPC-coefficients export is not possible, the system also displays an appropriate
information message. In this specified folder a detailed report file rpc_export_re-
port.txt is also created.

Exported refined RPC-coefficients can be used along with the project images both in third-
party software packages or in PHOTOMOD program.

7.7. Export georeference data

The system provides possibility to perform export of source data to GIS without prelim-
inary processing inMosaic to files with *.tab or *tfw extension. At that georeference is
performed using projection of image corners on specified plane (with no height specified).
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To save georeference data file perform the following actions:

1. ChooseOrientation › Create images georeferencing files.... TheCreate images
georeferencing files window opens.

Fig. 149. Save of project images georeference data

2. In the Format section set one of the following formats:

• ArcInfo World File – for further export of saved file with *.tfw extension to
ArcInfo;

• MapInfo TAB – for further export of saved file with *.tab extension toMapInfo.

3. In the Source data section set a source of initial data:

• Adjustment results – adjusted (in third party software) projection centers co-
ordinates and exterior orientation parameters;

• Imported exterior orientation – exterior orientation parameters;

• Block layout – block layout results.

4. [optional] If it is necessary to perform georeference by projecting images corners
on a plane with specified altitude, input altitude value in meters to the Project on
constant altitude input field.

5. In the Coordinate system section set a coordinate system that is used for images
georeference saving Coordinate system of the project or Latitude-longitude
WGS-84.
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6. Click OK. After that the system displays information window which contains inform-
ation about saved images georeference data.

7. Click OK. After that georeferenced images are saved to active profile resources in
selected format.

8. Processing report
The system provides possibility for viewing the results of block processing after auto-
matic tie point measurement (UAS) and adjustment.

Processing report contains data on the project’s properties, parameters of automatic
tie point measurement and adjustment, lens calibration, and summary on block errors.

The system allows to create the processing report for projects of the “Central projection” type.
Creation of block processing reports for projects of “Satellite scanner imagery”, “Airborne Digital
Sensor ADS”, and “VisionMap A3” types is not provided (see the “Project types” section in the
“Creating project” User Manual).

It is necessary to perform automatic tie point measurement and adjustment before the processing
report creation.

In order to create the processing report chooseOrientation › Processing report. After
the operation is complete, the block processing report file opens in standard viewer.
The report file have *.pdf extension.
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Fig. 150. Processing report

Block processing report contains the following main elements and sections:
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• the Project properties and initial data section of a report used to view general
statistics (see also the “Project properties” chapter of the “Creating project” User
Manual) and contains the following information:

○ a project name;

○ report generating date;

○ camera data;

○ GSD (Ground Sample Distance) – a pixel size on ground for digital images;

○ project coordinate system;

○ project heights range in meters;

○ area of the in m2;

○ a total number of project strips/images;

○ a number of tie/check/groud control points;

○ a block scheme and visual display of project heights range.

• Tie-point statistics by number of measurements report section that contains inform-
ation on tie point distribution by the number of measurements performed;

Data on all triangulation points, including GCPs, are displayed in this section.

• Subblocks list report section that contains information on image distribution by
subblocks;
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Fig. 151. “Tie-point statistics” and “Subblocks” report sections

• the Processing parameters section of a report used to view the parameters of
automatic tie point measurement and block adjustment;

Fig. 152. The “Processing parameters” section

• Results of camera calibration.
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Fig. 153. The “Processing results” section

• the Exterior orientation parameters accuracy section of a report used to view re-
siduals on linear and angle exterior orientation parameters (see the “The “Report”
tab” chapter of the “Block adjustment” User Manual). Contains the following tables:

○ Control exterior orientation parameters;

○ Check exterior orientation parameters;

○ Systematic errors.
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Fig. 154. The “Exterior orientation parameters accuracy” section

• thePoints residuals section of a report used to view and analyse the block adjustment
results (see the “Brief residuals report” chapter of the “Block adjustment” User
Manual) and contains the following tables:

○ Stereopairs residuals – a table containing tie point measurement difference
between stereopairs (see “Brief residuals report” in the “Block adjustment” User
Manual);

○ Errors in images.
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Fig. 155. The “Points residuals” section

• the Ground control and check points accuracy section of a report used to view
and analyse the block adjustment results (see the “Brief residuals report” chapter of
the “Block adjustment” User Manual) and contains the following tables:

○ Ground control point residuals – adjustment residuals on GC points;

○ Check point residuals – adjustment residuals on check points.

Fig. 156. The “Ground control and check points accuracy” section
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Appendix A. Number of points recommended for adjustment
of scanner block
There are some recommendations about number of GCP and check points used for
different methods adjustment of images included to scanner mono/stereoblocks.

For space scanner images it is possible to use only XYZ GCP (with X, Y, Z coordinates).

Fig. A.1. Number of points recommended for adjustment of scanner block by rigorous method

If a monoblock contains images with triple or quadruple overlap area, it is recommended to
measure several points in this area.

Number of GCP could be decreased due to tie points measured in triple or quadruple overlap.
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Fig. A.2. Number of points recommended for adjustment of scanner block by RPC method

Number of GCP could be decreased due to tie points measured in quadruple overlap.
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Fig. A.3. Number of points recommended for adjustment of scanner block by generic method

Recommended number of check points on images is not absolute and in many cases is determ-
ined by the customer requirements to specific project. Nevertheless, it is necessary to have
check points available for objective estimation of adjustment accuracy.

Appendix B. Supported formats for import and export of ex-
terior orientation parameters

B.1. PAT-B

PAT-B – is exchange text format with *.ori extension, which is supported by major
applications in different industries.

File with exterior orientation parameters of images in PAT-B format contains adjusted
coordinates of projection centers and matrices of exterior orientation rotation angles.
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The first line of PAT-B format file has the following structure:

Image number, 0.0, X, Y, Z, where:

X, Y, Z – coordinates of projection centers.

Then there are two lines containing 9 values of matrices elements of exterior orientation
rotation angles, as follows:

a11, a21, a31, a12, a22

a32, a13, a23, a33

The matrix elements are calculated using the following formulas:

a11 = cos( ϕ ) cos( κ );

a21 = cos( κ ) sin( ϕ ) sin( ω ) + cos( ω ) sin( κ );

a31 = − cos( κ ) sin( ϕ ) cos( ω ) + sin( ϕ ) sin( κ );

a12 = − sin( κ ) cos( ϕ );

a22 = cos( κ ) cos( ω ) − sin( ω ) + sin( ϕ ) sin( κ );

a32 = sin( ϕ ) cos( κ ) + cos( ω ) + sin( ϕ ) sin( κ );

a13 = sin( ϕ );

a23 = − sin( ω ) cos( ω );

a33 = cos( ω ) cos( ϕ );
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Fig. B.1. Sample of PAT-B file

Appendix C. Supported formats for import and export of tri-
angulation points

C.1. PAT-B

C.1.1. Format of file containing points geodetic coordinates

File with *.xyz, *.txt or *.csv extension, containing points geodetic coordinates is a
table.

Each line of *.xyz, *.txt, *.csv file:

GCP number, X, Y, Z

where X, Y, Z – GC point coordinates.

Fields delimiter is space or multiple spaces.
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Fig. C.1. Sample of file with adjusted geodetic coordinates of points

C.1.2. Format of file containing measurements of points coordinates
on images

File with *.mea, *.txt or *.csv extension, containingmeasurements of points coordinates
on images is a table. The table includes sections of the same format, each of them
corresponds to individual image of a block.

The first line of each section has the following structure:

Image number, image focal length, 0

The second and successive lines contain a table of points:

Point number (name), X, Y

where X, Y – points coordinates relative to image principal point (in mm or mcm).

In some cases the file contains point coordinates relative to reference point of camera coordinate
system (in mm, mcm or pixels).

Fields delimiter is space or multiple spaces.

The end of each section is marked by a line with -99 number.
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Fig. C.2. Sample of file with measurements of points coordinates on images

C.2. PAT-B (Trimble Inpho)

C.2.1. Format of file containing points geodetic coordinates

File cont.pat, containing points geodetic coordinates, consists of two tables.

Each line of first table contains:

• Point name;

• X-coordinate;

• Y-coordinate;

• Numerical designation that determines whether a point belongs to GC points (1) or
to the check points (2);

• Number of measurements in Trimble Inpho project (do not imported to PHOTOMOD
project).
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Each line of second table contains:

• Point name;

• Z-coordinate;

• Numerical designation that determines whether a point belongs to GC points (1) or
to check points (2);

• Number of measurements in Trimble Inpho project (do not imported to PHOTOMOD
project).

Fields delimiter is space or multiple spaces. The end of each table is marked by a line
with -99 number.

Fig. C.3. Sample of file with adjusted geodetic coordinates of points
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C.2.2. Format of file containing measurements of points coordinates
on images

File images.pat, containing measurements of points coordinates on images is a table.
The table includes sections of the same format, each of them corresponds to individual
image of a block.

The first line of each section has the following structure:

Image number, image focal length (in mcm)

The second and successive lines contain a table of points:

Point number (name) X, Y

where X, Y – points coordinates relative to image principal point (in mm or mcm).

Fields delimiter is space or multiple spaces. The end of each section is marked by a
line with -99 number.

Fig. C.4. Sample of file with measurements of points coordinates on images
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